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Welcome to the JReport Server User's
Guide

This User's Guide describes JReport Server. JReport Server is a 100% Java report generation and
management tool that can be deployed to any Java EE application server. By leveraging its high
performance report generation engine, JReport scales to meet the most demanding requirements.
Using the report scheduling, distributing and alerting capabilities of JReport Server, reporting can be
integrated into the workflow of the application.

This guide is written for report administrators or system administrators of Java application that embed
JReport reports into their application.

Other JReport documentation

This guide is one in the complete JReport documentation set. The documentation set includes the
following:

. Getting Started with JReport

. JReport Tutorial

. JReport Server User's Guide

. JReport Designer User's Guide

. JReport Server Monitor User's Guide

. JReport APl Javadoc
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What's New In This Release

This document introduces the new features and significant enhancements of JReport in this release.

Embedding

Integration

. Embedding web reports, page reports and dashboards as a whole using JavaScript API for host
applications in web browsers.

. Embedding web controls in host applications to open, save, export, filter, sort, print and navigate.
. API for applying and modifying NLS at runtime.

Connectivity

. RESTful web services as a data source with JSON formatted data with support for authentication and
parameters.

. Unified semantic layer: Business View (BV) now integrates Report Cube (RC) and Business Cube
(BC) features.

. User authentication when setting up notification e-mails.
. Backdoor admin authentication when bypassing LDAP is required.

Internationalization and Customization

. Full NLS support on product Ul, data, metadata, contents, formulas, and resources.

. CSS enhancements with more objects and properties, as well as better category organization.
Other JReport Server Live Enhancements

. Custom aggregations using formulas.

. One-click sort and filter on table headers.

. Custom sort on table groups.

. Support for all built-in functions for crosstab.

. Exporting selected components from a report.

. Exporting multiple tabs of a page report into multiple sheets of an Excel file.

. Local parameter support on web reports and library components.

. Comparison function to compare crosstab values within reports and dashboards.

. External web controls via user defined dialogs.

. Configurable go-to-detail report window target (e.g., same window or new window).

. Default style group to Run, Advanced Run and Schedule reports.

. Setting a default report component when filtering using the Filter dialog.

. Dynamic Java home to start up/shut down Derby database when integrated in an application server.
. JRE only (without JDK) when integrated in an application server.

. Enable/disable CSRF (Cross-Site Request Forgery) checking for JReport Server Live.

. Support for synonyms when accessing Oracle databases.

. |IE Navigate2 option for linking reports to URL when viewing in IE.

. Enhanced logs with more details.

Ul and UX

Appearance

. Overall Ul improvements including new styles and icons.

. Enhanced catalog data source view.

. Auto scaling Y-axis when scrolling through a Scrollable Chart.

. Formatting individual lines or a group of lines.

. Option in line charts to skip null data values in order to draw continuous lines.

Ease of Use

. Property Inspector to manage object properties in Web Report Studio.
. Windows Edge browser support.

. Direct linking from charts to reports without manually setting a URL.

. Enable/disable items in Options menu in JDashboard.

. Operate (e.qg., sort, filter) on all fields of the dataset in a chart.

. New default for manually inputting filter values into Filter dialogs or optionally pulling filter values
from the database.

. Select and operate on multiple items at a time in Business View Editor.

. Quick search in Data Mapping Editor.
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Release Notes for Enhancements and Fixes

This document describes the feature enhancements, resolved issues and any known issues for JReport
in this release.

Resolved issues

Item  Case # Issue

1 66088 Resolved the XSS security issue when accessing a few JSP pages in JReport Sever.

2 66886 Resolved the ArraylndexOutOfBoundsException error when loading reports in
JDashboard.

3 67331 The parameter sessionid which is a given value in runReport.jsp can be displayed
normally in the report's parameter page when calling UDS for the first time.

4 67331 JReport Server now calls the database only once when loading the parameter value list
for bind column parameters which are bound to UDSs and retrieve data from the
database in a web main report.

5 67331 The value list for the bind column parameters in a web main report will no longer be
triggered when opening its linked report.

6 67914 Resolved the OutOfMemory issue when SSL is turned on with JReport Server.

7 68120 Resolved the jet.export.ExpException error when changing the width of an aggregation
field in a page crosstab report to 0.01 and then exporting the crosstab to an Excel .xlIsx
file with column format.

8 68223 JReport no longer requests data from the data source when user tries to view through
JReport Server the web report component whose Invisible property has been set to
true.

9 68254 Solved the empty Excel result file problem when exporting a page banded report to
Excel in JReport Server.

10 68255 Resolved the duplicated table and field names issue when merging two catalogs using
Catalog Doctor in JReport Designer.

11 68278  JReport Designer can now create the node of hierarchy to business view normally when
saving the catalog as XML.

12 68305 Resolved the lllegalArgumentException error when migrating JReport Server from
version 5 to 13 by using command MigrationBV52.bat.

13 68331 The API function cat.getHandle(mapNamesJi], CatalogAPI.COLUMN) now gets handled
successfully when creating aggregations for an imported SQL using JReport Designer
API.

14 68345 Resolved the java.lang.NumberFormatException error when adding a filter object to a
page report that is running on Internet Explorer.

15 68365 Resolved the java.lang.ArraylndexOutOfBoundsException error when scheduling a
report using a bursting schema.

16 68365 The security error message can pop up properly in linked page reports.

17 68373 Corrected the 'Data type unmatched error' when doing format filter on the design
mode of a web chart report and the field text field and the value text field of the
condition are both filled with ToDate() expressions.

18 68390 The word wrap function now works normally on a page crosstab report when setting
properties Suppress When Empty and Suppress When No Records to true.

19 68395 JReport Server no longer pops up the error page showing 'The report session has
expired." when user sets property server.session.timeout to 20 and performs
continuous filters using the Filter dialog in Page Report Studio.

20 68422 Solved the GenerateFormulasCodeException error when saving a catalog after JReport
Designer has been upgraded to V13. 1 Update 1.

21 68425 The resource permission on the Public Resource folder of JReport Server now gets
enabled normally when using customized Security API.

22 68448 Support exporting page reports in IE 11 browser when Page Report Studio is
embedded in a page via IFrame with HTTPS (SSL) URL.

23 68449 Corrected the error of a full user name in the Security > User panel of the JReport
Administration page.

24 68550 The filter panel now fully displays in the edit mode of a web report.

25 68461 The scheduled tasks can get triggered normally when user schedules to run a few tasks
at a specified time with option 'Run missed task upon server restart' checked, shuts
down JReport Server before the specified time and then restarts it.

26 68540 Resolved the security issue of data access race condition that caused by storing user
data in Servlet member fields.

27 68547 The page report formula on JReport Designer can now get correct value when calling
isnull(next(@column)).

28 68563 Resolved the java.lang.ArraylndexOutOfBoundsException: O >= O error when logging
onto JReport Server in an LDAP configured environment.

29 68596 The new line at the bottom of the table column no longer disappears in the exported
Excel workbook (.xIsx) of a page table report.

30 68597 Add a blank item to the From DB Catalog drop-down list in the Input SQL Name dialog
when adding a new SQL to a data source so that database and schema name defined
in the URL could be applied.

31 68601 The save as function can be performed normally in Page Report Studio when JReport
Server is run with a JDashboard disabled license key.

32 68601 The formatting changes of a page report no longer gets lost after saving it to a report
folder to overwrite the report with the same name.

33 68608 JReport Server now pops up with a clearer error message when someone exports a
web report with invalid file name characters in the Export dialog.

34 68667 Resolved the ClassCastException error when selecting Top N, specifying "other" group
and using category sort in Category Options dialog of a web report.

35 68679 The node icons on the legend of a page chart report now display normally.

36 68684 Labels in web reports can be edited successfully now when their width extends beyond
the page in JReport Server.

37 68688 The field items available for the Conditional Formatting dialog in a web crosstab report
are staying the same after JReport Server is upgraded to a higher version.

38 68696 Solved the payment_type name field value missing issue on Page Report Studio when
Group By Transaction Type option of parameter p_GroupByTransactionType gets
unchecked in the Enter Parameter Values dialog.

39 68726 Solved the ClassCastException and ConcurrentModificationException errors when
initializing multiple threads concurrently to call the method runReport.

40 68728 Resolved the NullPointerException error when creating cached query result for several
queries in JReport Designer.

41 68746 The Edit Business View Security dialog appears normal when right-clicking Business
View Security for a catalog and then select Edit Business View Security from the
shortcut menu.

42 68748 Resolved the script error when opening a report folder and its subfolders in the server
resource tree in Icons or Thumbnails view.

43 68798 Resolved the data type unmatched error when choosing to use a dynamic formula in a
web report format filter.

44 68816 Resolved the java.lang.NullPointerException error when running a page report in
JReport Server with trace level logs set to TRIVIAL.

45 68835 Lines in page reports are now displayed normally when viewing the reports in JReport
Server.

46 68842 Resolved the jave.lang.NullPointerException error when doing a drill down action in a
library component running in JDashboard.

47 68842 Web Report Studio now shows the field's new dynamic display name if a user modifies
the dynamic display name of a field and adds the field to an existing ad hoc web
report.

48 68863 JReport Server now shows a loading icon when a new filter is inserted in the Filter
panel of Web Report Studio.

49 68880 User can now successfully insert new imported SQL files to a catalog using JReport
Catalog API.

50 68880 The column elements under the SQL element now get updated successfully after an
SQL file is updated via JReport Catalog API.

51 68925 Enhanced JReport Server performance when flex key CPU licensing is used.
52 68940 Fixed the unknown exception error when linking to a report in Page Report Studio.

53 68964 The summary result is displayed correctly in JReport Designer when creating a library
crosstab component that uses a dynamic formula as aggregate field.

54 68964 The dynamic formula which is being used as an aggregate field in a library component
of a crosstab now works normally with conditional format when the library component
is being viewed on JReport Designer or run in JDashboard.

55 68969 Resolved the 100% CPU utilization problem when there is some typo on the keystore
file name that user provides to enable SSL on JReport Server.

56 69054 The page crosstab report which uses table style and has two or more repeated fields
no longer is displayed with a part of the field values or additional columns when
previewed in JReport Designer.

57 69065 The page header panel which is set to be repeated on each page of a page report can
now be displayed correctly on each sheet of the report's exported Excel result.

58 69078 Updated the file welcome.jsp of JReport Server for a typo error.

59 69082 The label of the field added to a web report is now displayed with its dynamic display
name by default in Web Report Studio if user has configured a dynamic display name
for the field.

60 69082 Resolved the java.lang.reflect.InvocationTargetException error when adding parameter
control to a web report in JReport Designer.

61 69082 The standalone JReport Server running on Windows 7 on Internet Explorer 11 no
longer gets two headers after the submission of a schedule task.

62 69090 The connection name of an imported SQL file can now get changed accordingly on
JReport Designer after changing the name of the same catalog's JDBC connection via
Catalog Doctor.

63 69106 Setting property Keep Group Together of a table group in a page report no longer
results in a blank report page when running the report in Page Report Studio.

64 69131  Allow users to add new categories or hierarchies to their business views in any catalog
on JReport Designer.

65 69133 Resolved the scrollbar and chart tooltips displaying issue when running JDashboard
with multiple dashboard tabs via URL.

66 69160 The Query Filter dialog in a web report no longer shows an empty value list if a user
has added a filter to this query on JReport Designer and the filter condition is on
parameter.

67 69219 Enhanced JReport Server performance when running web reports with conditional
formatting.

68 69219 Resolved the NullPointerException error when opening a linked report in another linked
report in Web Report Studio.

69 69219 Improved JReport Server performance when opening linked reports in a web report
created using user data source (UDS).

70 69219 Improved JReport Server performance when running a web report created with user
data source (UDS) and the cached report data in the report is expired.

71 69219 Web report charts can be loaded normally in Web Report Studio which is running in
Internet Explorer in case filters has been applied or removed in this report.

72 69219 Proper working of undo actions when two or more sorts have been applied to a web
table report in JReport Server.

73 69221 The access privileges error message now pops up normally for web reports running in
Google Chrome.

74 69249 Resolved the java.lang.ClassCastException error when calling method catalog.delete
(sglHandle) of Catalog API instance to delete an imported SQL object from a catalog.

75 69273 Dynamic formulas that are created as aggregation can now be used to create summary
tables on JReport Designer plus crosstabs which use these dynamic formulas can show
aggregation values normally in Web Report Studio.

76 69288 The error pages in JReport Server can now be closed with the Close button.
77 69300 The new line character "\r\n' added in the formula now works normally in the web table
report running in Web Report Studio.

78 69365 Table alias no longer gets changed in the where condition of the SQL statement when
adding a table in the catalog using JReport Catalog API.

79 69367 Resolved the java.lang.NullPointerException error when visiting JReport Administration
page with a JReport Server running on Tomcat 8.

80 69411 Resolved the NullPointerException error when running a page report on a JReport
production server.

81 69417 Resolved the NullPointerException error when creating a web crosstab report with the
property Push Down Group Query of the JDBC connection being set to true in JReport
Designer.

82 69461 The last row (i.e. total/aggregation) of a page crosstab report now gets displayed
properly when it shows up in the next page.

83 69467 The schedule task of publishing a report to e-mail now can be submitted successfully
using Internet Explorer 11.

84 69472 The content of the error message in the unknown exception for Query Optimizer can be
displayed normally in linked reports.

85 69493 Resolved the OutOfMemory issue when sorting fields and group by fields in a page
report that has a large amount of data.

86 69513 The filter control of a web report no longer is exported to Excel after user sets the
Export to Excel property of the web report filter control to false on JReport Designer.

87 69556 Web reports with dynamic formulas running in Web Report Studio now show consistent
result with the same reports in JReport Designer.

88 69593 The error message now shows consistent date format with the user defined one when
user enters an invalid date format in JReport User's Enter Parameter Values dialog.

89 69621  The description of binded column in the page header of a page banded report now
stays as it is when JReport Designer is upgraded from V12 to V13.

90 69650 Enables user to insert tables to a catalog using method insert(java.lang.String
dataSourceName, java.lang.String tableName, java.lang.String catalogName, java.lang.
String schemaPattern, java.lang.String tablePattern, int type, java.lang.String
character) when the method is simultaneously used on database catalogs and
schemas.

91 69678 The suppress property now works normally in a page report in which a formula with
function IsNoRecord() is used to control this property.

92 69684 The web report label whose width extends beyond the report page in JReport Server no
longer disappears when it is no selected.

93 69705 Creating web reports using the wizard that has been embedded into an IFrame is now
smoother.

94 69708 User can no longer run an inactive report via URL or JReport Server API.
95 69729 Rebuilds the installation file of JReport Server 13.1 Update 2 to ensure its successful
installation in the console interface.

96 69735 Users now have no problem connecting to MongoDB 3.0 and loading tables on JReport
Designer once they have a user role with the privilege of Read.

97 69737 The search function can now work normally in a parameter control in Page Report
Studio.

98 69739 JReport Server now displays the business view tree correctly in the Group screen when
creating an ad hoc page report with a business view and the first category in this
business view has no sub node.

99 69755 Resolved the CSS parsing javascript error in Web Report Studio by preventing business
view elements' names from starting with numbers.

100 69769 The parameter value's drop-down control no longer persists when user tries to enter a
parameter value manually in the Enter Parameter Values dialog and press the Tab key
to move onto the next parameter.

101 69807 Keep the Web Report Wizard window sizable when adding a table component to a web
report.

102 69869 Support logarithmic scaling on the Y-axis of all chart objects running in Page Report
Studio, Web Report Studio and JDashboard.

103 69892 The security setting for non-admin users now works normally in JReport Server when
method getFolderinPath is called in the resource manager.

104 69892 Upgrading JReport Server from V11 Update 1 to V13.1 Update 2 now makes the
horizontally aligned icons in Page Report Studio consistent.

105 69892 Fixed the error information getting lost in the Error.log of JReport Server 13.1 Update
2.

106 69894 Resolved the merged cells and extra columns in the Excel result of a page crosstab
report when the report is exported to Excel with column format and the width of a
certain column in the crosstab has been changed.

107 69938 The web controls are now kept in right position in Page Report Studio when JReport
Server is upgraded from V11 Update 1 to V13.

108 69941 Resolved the access denied error when hitting OK button in a web report Save As
dialog or hitting Save button in the Bind Data screen of the Web Report Wizard before
the contents in both dialogs are loaded.

109 69958 The Reset button in the Enter Parameter Values dialog can now function normally after
JReport Server is upgraded from V11 to V13.

110 69997 Solved the OutOfMemory issue caused by the heavy load on a specific JReport cluster
node.

111 69999 Support default display sequence of parameters in the parameter form control for
cascading parameters in a web report.

112 70037 The date values in a web report now get displayed correctly when the report is
previewed or exported in Excel format.

113 70112 Support running JReport Designer and JReport Server using Sun's Java Runtime
Environment (JRE) in user's production environment.

114 70127 JReport Server 10 Update 1 now works normally when running on JDK 1.8.
115 70141 The filter control now works successfully for a table which locates in the page header
panel of a page report.

116 70156 Resolved the IndexOutOfBoundsException error when running a dashboard component
with cached cube.

117 70237 Resolved the NullPointerException error when passing a parameter to a linked report in
Web Report Studio.

118 70262 Removed the invalid object name error when adding a table to a catalog in the JDBC
connection without specifying a table schema.

119 70312 User now has no problem selecting a folder in the New Schedule dialog with Internet
Explorer 11 when accessing JReport Server with a domain name.

120 70335 Recovered the word wrap function for label texts in page crosstab reports.
121 70353 Table detail rows in a library component are displayed correctly when running
JDashboard against cube.

122 70369 Improved JReport logging so additional errors and exceptions can be logged when
issues occur.

123 70421 Removes the vulnerability in JReport products with updated lib files containing
serializer-2.7.2 in makewar.xml file.

124 70441 Removes the java.lang.NullPointerException error when running a bursting report on
JReport Server.

125 70451 The version date sorting now works properly in the Download from JReport Server
dialog.

126 70492 The query that contains the special field "UserName" can no longer be used to create
in-memory cube.

127 70531 Fixed the reports hanging issue when running reports on JReport Server.

128 70552 Removes the javascript error when browsing the JReport Server resource tree or
selecting a folder via Internet Explorer with its compatibility version being set to 7.

129 70565 Labels of the scrollbar no longer are overlapped when running a library component of a
scrollbar chart on JDashboard.

Known issues

Summary field disappears from design view when deleting table column

If a summary is inserted in the GroupFooterPanel of a table, when you delete a column from the table,
or unmerge the cell of the group footer row, sometimes you may find the summary field disappears
from design view, however, from the report structure tree in the Report Inspector, you can still find the
object. You can reset its coordinate related properties so as to make the summary field display again.

Compiling formulas in JReport under JDK 6 or higher gets warnings

Since generic type is introduced to JDK 6 or higher version, when compiling formulas in JReport under
JDK 6 or higher, you may come across warning messages as follows:

. Note: Test.java uses unchecked or unsafe operations.
. Note: Recompile with -Xlint:unchecked for details.

You may see that the situations are logged as Javac errors. However, the warning messages do not
prevent Javac from creating .class files and reports can still run correctly.

In this case, you can simply ignore the messages and logged errors.
TOC Browser tree doesn't work well for reports with cached report bursting

When end user runs a report which has been defined with some cached report bursting policy in Page
Report Studio, and then opens the TOC Browser, he will see all the groups of the report instead of just
the ones he is supposed to view. In addition, no matter if he has access to a group, he cannot click the
group name from the TOC tree to get corresponding details. JReport will further enhance the cached
report bursting feature in a future release to resolve this issue.

Report data gets cut off in PDF result

When you export a report to PDF format, if the report contains a large amount of data but its page
mode was specified to be continuous page mode, or its page size was set to be larger than 200 inches,
you will find that in the PDF result some data of the report are cut off. This is because in one PDF page,
the data displayed can be no larger than 200 inches.

Starting JReport with 64-bit JDK 1.7

To use 64-bit JDK 1.7 to start JReport on 64-bit Sun Solaris System, you need to modify the launch
script JReport.sh (for JReport Designer) or JRServer.sh (for JReport Server) in $REPORTHOVE/ bi n by

changing the value $JAVAHOME/bin/java to $JAVAHOME/bin/amd64/java.
Deploying monitor.war (serviet.war) and jreport.war in the same domain gets exception

When integrating JReport Server and JReport Server Monitor into one application server, you need to
make sure that they are deployed to different domains. JReport Server Monitor is supposed to be just
an application for the administrator which doesn't need to come along with a JReport Server as the
report system. So it is recommended that JReport Server Monitor be installed on a separate system or
on systems for system administrators.

Limitation of going to another group on chart

When you perform the go-to action on a chart which uses a dynamic formula as its shown value, and
the formula contains group information, you will get exceptions. This is a limitation in current version.
We will resolve the issue in future release.

The zooming in or out of JReport browsers is not supported

All JReport browsers such as Page Report Studio, Web Report Studio, JDashboard and so on do not
support being zoomed in or out by the way of scrolling the mouse while holding the Ctrl key. This may
result in that the JReport Ul cannot display well.

APl change

jet.formula.ParambDesc.value has been set to private now. You can use getDisplayValue(DbValue
paramvalue, java.util.Locale locale) instead.

For example:

Par anDesc desc = new ParanDesc();

desc. get Di spl ayVal ue(desc. get Val ue(), Locale.getDefault());
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JReport Product Overview

JReport delivers operational business intelligence to enterprise applications through powerful embedded reporting.

JReport is a complete Java reporting solution that provides sophisticated enterprise reporting, ad hoc reporting, and
data analysis. A 100% Java EE architecture and a rich set of APIs allow JReport to be seamlessly embedded into any
application, providing end users with a transparent interface to easily generate reports, share information, and
analyze data. With JReport, any report can be made interactive, extending the "life” of a report by allowing users to
easily sort, group, navigate, and filter via the Web. This wide range of functionality, including the ability to drill down
on data, enables users to quickly derive value from their business intelligence.

JReport product architecture

JReport's Java architecture takes advantage of the portability, scalability, and ease of integration associated with J2EE
technology to provide a powerful, flexible reporting solution that fits perfectly within any architecture.
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JReport Designer is a Swing-based Integrated Development Environment (IDE) that enables sophisticated report
design and presentation of critical business data. It provides an intuitive interface, reusable report components,
flexible layout, and a toolset for designing and testing reports. With JReport Designer, you can build reports using
simple drag and drop techniques or by using the Report Wizard. Data can be accessed from any data source to design
and preview reports in order to deliver information to end users in the most relevant and intuitive manner. Rapid
creation and modification of reports is accomplished by toggling between design mode and view mode where the
report will be displayed with the actual dataset. Once report design is complete, the report is published to JReport
Server for generation, delivery, and management.

JReport Server is a 100% Java report generation and management tool. It enables efficient management, sharing,
scheduling, versioning, and delivery of reports and enables reporting to be integrated into the workflow of any Java
application. The high-performance engine can scale to any workload. Report results can be saved to a versioning
system, sent to enterprise/workgroup printers, or e-mailed. With JReport, reports can be viewed in any modern
enterprise format including Page Report, Web Report, HTML and standard business documents, such as PDF, Excel,
and RTF.

JDashboard delivers information using a user portal user interface rather than a report. Users can freely choose the
objects they want to display in the dashboard, without having to know how these objects were created, what data
sources to use, what styles to set, and so on. A dashboard can hold multiple data components so that when browsing
the dashboard users are able to see multiple data aspects. Within a dashboard, data components are able to
communicate with each other via the message mechanism. This allows actions such as common filters to be applied to
all the components of a dashboard even when coming from different data sources.

Page Report Studio and Web Report Studio enable reports to be accessed through a web browser via Dynamic

HTML, or AJAX. With Page Report Studio and Web Report Studio, reports can be modified using dynamic filter, sort,
and drill capabilities. Using Page Report Studio and Web Report Studio's advanced capabilities, users can drag and

drop columns to and from an existing report, dynamically change chart types, pivot crosstabs, add groups, convert
report components or create an entirely new report.

Visual Analysis is a WYSIWYG product to visualize the result of every work step. Simply by dragging and dropping
data fields onto a layout module, users are able to visually create crosstabs and charts step by step. The use of
colors, sizes, shapes, and pie slices demonstrates the data in rich aspects.

Reporting a problem or requesting a feature

If you are having trouble running JReport Server or encounter any problems during reporting, take the following steps.

1. Check whether the system on which JReport Server is running meets the system requirements.

2. Check the JReport FAQ pages for frequently-asked gquestions and their solutions.

If the problem persists, report it to Jinfonet Support (support@jinfonet.com) with the following information:

1. Describe the precise steps leading to the problem.

2. Run the batch file jrenv.bat in the <i nst al | _r oot >\ bi n subdirectory. Running this batch file will generate a file

called report.env in the current directory. Send this file to Jinfonet Support. Also, describe the operating
environment, including machine type, CPU, memory, OS, and Java version.

3. If you are running JReport in an integrated Java application server, click the Server Information button on
the JReport Administration page to list the environment.

4. Send Jinfonet Support the log file with the recorded JReport Server problems.

o For a standalone server
Start JReport with the batch file DJRServer.bat (.sh on Unix). Running this batch file will record the most
detailed logging information and write them to the log files in the <i nstal | _root >\ | ogs directory. Try to

reproduce the problem, and send the log files along with the other information.

o For an integrated JReport Server
If your JReport Server runs as a servlet inside a Java application server, send the log files generated by the
JReport Engine in the application server. When the JReport Servlet is installed, a property file is generated
which is used to define the class and arguments of the JRServlet. For example, if you integrated JReport
Server into WebLogic, find the WebLogic properties file located in the installation path of WebLogic. Edit the file
to use the option -vDebug -VError. Your file should then contain the following content:

VError=true
vDebug=true

In addition, you can also directly add the java option -Dlogall=true (or -DvError=true, -DvDebug=true) to the
java command line within the launch file of the application server.

After restarting your application server, reproduce the problem and send the log files to Support.

5. Send Support the log files recording all of the logging information of engine and server (including event, error,
debugging, access, management, and performance).

o Change the configuration to record all logging events by starting the server and accessing the JReport
Administration page through http://1 ocal host: 8889.

a. Go to the Configuration > Log panel.
b. Set the trace level of all logs to TRIVIAL, and set the error level of all logs to WARN.

c. After that, reproduce your problem and send Support the log files in <i nstal | _root >\ | ogs. In addition,
you can also directly modify the logging configuration file LogConfig.properties in <i nstal | _r oot >\ bi n. If
you set the server property log.config.update to true (all server properties are managed within the file
server.properties in <i nstal | _root >\ bi n), any changes to the configuration file will automatically take
effect at runtime after the specified update interval (set by the server property log.config.update.interval).

o If your JReport Server runs as a servlet within a Java application server, in the address bar of a web browser,
type in htt p: // <host name>/j r eport/adm n, where jreport is the servlet context path.

6. To reproduce your problem of running reports with JReport Server, we will often need your report, catalog and
data information.

a. Send Support the catalog file (*.cat and *.fml) and the report file *.cls that you are having problems with.

b. In order to resolve technical issues that you have reported, we will need to access your report data so that
we can recreate and analyze the problem. Your database may be very large. However, we will only require
access to the data returned by the query of the troublesome report, and if necessary we will sign a
confidentiality agreement with you. To extract the report data, in the Catalog Browser of JReport Designer,
right-click the query that your report is using, select the menu item Create Cached Query Result. Then,
input the data file name and click the Save button. The query result will then be saved in this file. Send
Support all of the files generated (including the description file).

Visiting web pages for more information

. Products information
http://www.jinfonet.com/products

. News center
http://www.jinfonet.com/company/news

. Demo center
http://www.jinfonet.com/resources/jreport-demo

. Products download center
http://www.jinfonet.com/product/download-jreport

. White papers
http://www.jinfonet.com/resources/white-papers

. JReport product documentation
http://www.jinfonet.com/jreport-documentation

. JReport Javadoc
http://www.jinfonet.com/jreport-documentation

. JReport Technical Support center
http://www.jinfonet.com/services/technical-support
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Installing and Uninstalling JReport Server

This chapter presents how to install JReport Server using a variety of different methods. It covers
issues associated with installing, removing and solving problems encountered during installation.

. System requirements

. JReport licenses

. Supported report databases

. Installing using the Installation Wizard

. Installing silently

. Installing using the console interface

. Installing on Unix manually

. Installing by building a war file on Windows to deploy to Linux/Unix

. Uninstalling JReport Server

. Solving installation problems

. JReport Server reporthome directory overview
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System requirements

The following table displays the basic system requirements for installing JReport Server. Check your
system to make sure that all the requirements are met before installation.

JReport Server System Requirements

Recommended Requirements Minimum Requirements

osS: Windows x64, Unix x64, Linux x64, Windows, Unix, Linux, z/Linux
z/Linux64

CPU: Quad Core processor Dual Core processor

Free Memory: 8 GB 2 GB

Free Disk: 10 GB 1GB

JDK: 6 or above 6 or above

Browser: Latest releases of Chrome, Firefox, Chrome 23, Firefox 20, IE 9, Edge
IE, Edge

Reference: Download a JDK version at http://www.oracle.com/technetwork/java/javase/downloads/
index.html.

Notes:

. Jinfonet supports Java VMs released by Sun and IBM to run with JReport Server. You can try using
other Java VMs, but their compatibility cannot be guaranteed. Reports of any problems you find with
other Java VMs are welcome.

. If you want to use JReport Server on a z/Linux system, you must download the JDK specially used
for IBM from http://www-03.ibm.com/servers/eserver/zseries/software/java/ and the version should
be at least V6.

. You are not recommended to run JReport in the Internet Explorer Compatibility View mode.
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JReport licenses

JReport has several add-on licenses which enable specific features:

. JReport Live license

. JReport Server Cluster license

. JDashboard license

. Visual Analysis license

. Organization license

Contact your Jinfonet Software account manager to obtain your required license.

JReport Live license

The JReport Live license enables the use of web reports and ad hoc page reports and all their related
functions. JReport Designer and JReport Server have separate live licenses.

Live license for JReport Designer

A JReport Live license for JReport Designer controls the data sources for ad hoc page reports and web
reports and the creation of web reports from those data sources on JReport Designer. The Live license
allows you to utilize the following features on JReport Designer:

. Create and edit business views. They are meta-data descriptions created in JReport Designer to be
used as data sources for ad hoc page reports and web reports. They can be created on any type of
data source such as JDBC, ODBC, XML and Web Services.

. Create reports from business views.
. Export and print web reports.

. The following functions also require that JReport Server has a Live license:

o Preview web reports in Web Report Studio.
o Publish web reports to JReport Server.
- Download reports which use business views as the data source from JReport Server.

Live license for JReport Server

A JReport Live license for JReport Server controls the real time ad hoc and analysis reporting on
JReport Server. The Live license allows you to utilize all of the following features and functions on
JReport Server:

. Create, view, run, edit, export, print, and publish ad hoc page reports and web reports. The data
sources for these reports are created in JReport Designer, which requires JReport Designer has a Live
license.

. All actions in Page Report Studio involving business view or changes of report template:

o Create new page reports or page report tabs
» Delete report tabs from a page report

o Add components and data fields into reports
o Remove components from reports

o Move and resize components

s Edit component properties

o Drill

» Change chart type

o Rotate tables and crosstabs

» Convert between crosstab and chart

o Create query filters

» Display the Resource View panel which shows the data resources for the current open report tab

JReport Server Cluster license

JReport Server Cluster license enables a group of JReport Servers to work together with shared
resources, load balancing, and failover in a distributed cluster.

JDashboard license

A JDashboard license enables the use of JDashboard and all related functions. JReport Designer and
JReport Server have separate JDashboard licenses.

Since JDashboard requires using business views as data sources, the JReport Live license is also
required. JReport Designer and Server have separate Live licenses too.

JDashboard license for JReport Designer

A JDashboard license for JReport Designer allows for creation of library components which are used to
build dashboards and publishing of library components to JReport Server.

JDashboard license for JReport Server

A JDashboard license for JReport Server enables the management of library components in the
component library, the creation of dashboards using library components, and the use of dashboards.

Visual Analysis license

A Visual Analysis license enables the use of Visual Analysis and all related functions. Since Visual

Analysis requires using business view as the data source, the JReport Live license is also needed in
order to perform visual analysis.

Organization license

An organization license enables organizing users into different groups with their own administrators.
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Supported report databases

JReport supports all of the current mainstream databases as well as most databases which support
ODBC or JDBC drivers. Except for traditional databases, databases on the cloud are also supported,

such as Vertica, Amazon RDS, and RedShift.

The following table lists the databases and JDBC drivers that have been tested with JReport. If you are
using any of the databases listed below, you are recommended to use the corresponding driver version
with JReport although any driver which the DBMS supplier recommends is also fine. If you encounter

problems when using a database or driver version that is not listed here, you can contact Jinfonet

Support (support@jinfonet.com) for help.

You can also refer to the page http://wiki.netbeans.org/DatabasesAndDrivers for additional information
on database and driver.

Database
MS SQL
Server

MS SQL
Server

MS SQL
Server

MS SQL
Server
MS SQL

Server

MS SQL
Server

MS SQL
Server

MS SQL
Server

MS SQL
Server

MemSQL

ScaleDB

MySQL

MySql

MySql

MySql

MySal

MySql

Oracle

Oracle

Oracle

Oracle

Oracle

Oracle

Oracle

DB2

DB2

DB2

DB2

DB2

DB2

DB2

DB2

DB2

RedBrick
warehouse

Informix

Informix

Informix

Informix

HSQL

Sybase

Sybase

Sybase

Sybase

Sybase 1Q

PostGre SQL

PostGre SQL

PostGre SQL

Cache

Derby

Derby

Derby

MongoDB

HIVE

PSQL

Vertica

Amazon RDS

RedsShift

Hortonworks

Notes:

. If you want to use the DB2 app connection, you need to install the client and configure the net

Version
2014
(12.00.2000)

2012
(11.00.2100)

2008R2
(10.50.4000)

2008R2

(10.50.4000)
2008

2005

2000

2000

2000

55.8

0.2.3

5.5.24 (64bit)

mysql via SSL

mysql 5
mysql-5.0.2-

alpha-win

mysql-5.0.18-
win32

mysql-4.1.12-
win32

mysql 4

11.2.0.1.0
(64bit)

11.1.0.6.0
(119)

11.1.0.6.0
(119)

11.1.0.6.0
(119)

10.1.0.2.0
(109)
9i

8.1.7.0.0

9.7.200.358

9.7.0.4

9.1.0.356

8.2

8.2

8.1.9.917

8.1.7.380

8.1

8.1

11.70.TC7DE

11.50.TC7DE

9.40.TC1E1

9.30

12.5.2

12.5

12.5

11.5

15.4.0.3019

8.3.0

8.2.13

8.0

Cache 4

10.8.1.2

10.5.3.0

10.5.1.1

2.2.2

0.10.0

V11 SP3

0.14.0

address first.

. The database MySqgl with the example URL j dbc: nysqgl : // db06: 3306/t est ?p?useSSL=t r ue?

Driver File Name

sqljdbc4.jar

sqljdbc4.jar

sqljdbc4.jar

Merlia.jar;

sqljdbc4.jar

sqljdbc.jar

msbase.jar; msutil.
jar; mssqlserver.jar

Opta2000.jar
tds-1.0.3.jar

mysqgl-connector-java-
5.1.25-bin.jar; mysql-
connector-java-5.1.7-
bin.jar
mysqgl-connector-java-
5.1.25-bin.jar; mysql-
connector-java-5.1.7-
bin.jar
mysqgl-connector-java-
5.1.25-bin.jar; mysql-
connector-java-5.1.7-
bin.jar
mysql-connector-java-
5.1.6-bin.jar

mysql-connector-java-
5.0.4-bin.jar
mysgl-connector-java-
3.1.5-gamma-bin.jar
mysqgl-connector-java-
5.0.3-bin.jar
mysql-connector-java-
3.1.10-bin.jar
mysql-connector-java-
3.0.14-production-bin.
jar

classesl2.jar;
ojdbc14.jar; ojdbc5s.
jar; ojdbc6.jar
JDK1.5: ojdbc5.jar;
JDK1.6: ojdbc6.jar;
classes12.jar

JDK1.5: ojdbc5h.jar;
JDK1.6: ojdbc6.jar;
classes12.jar

JDK1.5: ojdbch.jar;
JDK1.6: ojdbc6.jar;
classes12.jar

JDK1.2&1.3:
classes12.zip;
JDK1.4: ojdbc14.jar
JDK1.2&1.3:

classesl12.zip;
JDK1.4: ojdbcl4.jar

classes12.zip
db2jcc4.jar

db2java.zip; db2jcc.
jar; db2jcc_license_cu.
jar; db2jcc4.jar; sqlj.
zip; sqlj4.zip
db2java.zip; db2jcc.
jar; db2jcc_javax.jar;
db2jcc_license_cu.jar;
db2policy.jar

Db2jcc.jar;
db2jcc_license_cu.jar
(Linux, Unix and
Windows);
db2jcc_license_cisuz.
jar (Linux, Unixand
Windows, z/0S,
0S/390,z/0S, iSeries,
and so on)

Db2java.zip

db2java.zip; db2jcc.
jar; db2jcc_javax.jar;
db2jcc_license_cisuz.
jar; db2jcc_license_cu.
jar

db2java.zip; db2jcc.
jar; db2jcc_javax.jar;
db2jcc_license_cisuz.
jar; db2jcc_license_cu.
jar

Db2java.zip; db2jcc.
jar

Db2java.zip

redbrick.jar
ifxjdbc.jar

ifxjdbc-g.jar; jdbc.jar

ifxjdbc.jar
ifxjdbc.jar
hsqldb.jar

jeonn2._jar

jeconn2._jar

jconn3d.jar

jeonn2.jar

jconn3.jar; jconn4.jar

postgresql-8.3-607.
jdbc2.jar
postgresql-8.2-506.
jdbc3.jar
postgresql-8.0-310.
jdbc3.jar

JDBC Driver

com.microsoft.
sqlserver.jdbc.

SQLServerDriver

com.microsoft.
sglserver.jdbc.

SQLServerDriver

com.microsoft.
sglserver.jdbc.

SQLServerDriver

com.inet.tds.
TdsDriver

com.microsoft.
sqlserver.jdbc.

SQLServerDriver

com.microsoft.
sqlserver.jdbc.

SQLServerDriver

com.microsoft.
jdbc.sqlserver.

SQLServerDriver

com.inet.tds.
TdsDriver

net.sourceforge.

jtds.jdbc.Driver

com.mysql.jdbc.

Driver

com.mysql.jdbc.

Driver

com.mysql.jdbc.

Driver

com.mysql.jdbc.

Driver

com.mysql.jdbc.

Driver

com.mysql.jdbc.

Driver

com.mysql.jdbc.

Driver

com.mysql.jdbc.

Driver

com.mysql.jdbc.

Driver

oracle.jdbc.driver.

OracleDriver

oracle.jdbc.
OracleDriver

oracle.jdbc.
OracleDriver

oracle.jdbc.
OracleDriver

oracle.jdbc.driver.

OracleDriver

oracle.jdbc.driver.

OracleDriver

oracle.jdbc.driver.

OracleDriver

com.ibm.db2.jcc.

DB2Driver

com.ibm.db2.jcc.

DB2Driver

com.ibm.db2.jcc.

DB2Driver

com.ibm.db2.jcc.

DB2Driver

com.ibm.db2.
jdbc.app.
DB2Driver

com.ibm.db2.jcc.

DB2Driver

com.ibm.db2.jcc.

DB2Driver

com.ibm.db2.
jdbc.net.
DB2Driver

com.ibm.db2.
jdbc.app.
DB2Driver

redbrick.jdbc.
RBWDriver

com.informix.
jdbc.IfxDriver

com.informix.
jdbc.IfxDriver

com.informix.
jdbc.IfxDriver

com.informix.
jdbc.IfxDriver

org.hsqldb.
jdbcDriver

com.sybase.
jdbc2.jdbc.
SybDriver

com.sybase.
jdbc2.jdbc.
SybDriver

com.sybase.
jdbc3.jdbc.
SybDriver

com.sybase.
jdbc2.jdbc.
SybDriver

com.sybase.
jdbc3.jdbc.
SybDriver
org.postgresql.
Driver
org.postgresql.
Driver
org.postgresql.
Driver

CacheDB.jar

derby.jar; derbyclient.

jar

derby.jar; derbyclient.

jar
derby.jar

com.intersys.jdbc.

CacheDriver

org.apache.derby.
jdbc.ClientDriver

org.apache.derby.
jdbc.ClientDriver

org.apache.derby.

already within JReport

hadoop-common-
2.0.0-cdh4.1.1 jar;
hadoop-core-2.0.0-
mrl-cdh4.1.1.jar;
hive-exec-0.9.0-
cdh4.1.1.jar; hive-
jdbc-0.9.0-cdh4.1.1.
jar; hive-metastore-
0.9.0-cdh4.1.1.jar;
hive-service-0.9.0-
cdh4.1.1.jar; libfb303-
0.7.0.jar; libthrift-
0.7.0.jar; slf4j-api-
1.6.1.jar; slf4j-simple-
1.6.1.jar

jpscs.jar; pvjdbc2.dll;
pvjdbc2.jar; pvjdbc2x.
jar
vertica-jdk5-6.1.2-0.
jar

mysql-connector-java-
5.0.4-bin.jar

postgresql-8.4-703.
jdbc4.jar

hive-jdbc-0.14.0-
standalone.jar;
hadoop-common-
2.6.0.jar

jdbc.

EmbeddedDriver
toolkit.db.mongo.

MongoDriver
org.apache.

hadoop.hive.jdbc.

HiveDriver

com.pervasive.
jdbc.v2.Driver

com.vertica.jdbc.

Driver

com.mysql.jdbc.

Driver

org.postgresql.
Driver

org.apache.hive.

jdbc.HiveDriver

Example URL
jdbc:sqlserver://<host>:1433;
DatabaseName=test

jdbc:sqlserver://<host>:1433;
DatabaseName=test

jdbc:sqlserver://<host>:1433;
DatabaseName=test

jdbc:inetdae7:<host>:1433?
database=test
jdbc:sqlserver://<host>:1433;
DatabaseName=test

jdbc:sqlserver://<host>:1433;user=sa;
password=1234;database=test

jdbc:microsoft:sqlserver://<host>:1433

jdbc:inetdae7:<host>:1433?
database=test
jdbc:jtds:sqglserver://<host>:1433/test

jdbc:mysql://<host>:3306/test

jdbc:mysql://<host>:3306/test

jdbc:mysql://<host>:3306/test

jdbc:mysql://db06:3306/test?p?
useSSL=true?
clientCertificateKeyStoreUrl= D:\test
\SSL_Client\ca-cert.pem?
clientCertificateKeyStorePassword=1234
jdbc:mysql://<host>:3306/test
jdbc:mysql://<host>:3306/test
jdbc:mysqgl://<host>:3306/test
jdbc:mysql://<host>:3306/test

jdbc:mysql://<host>:3306/test

jdbc:oracle:thin:@<host>:1521:orcl
(Oracle JDBC Thin using an SID)

jdbc:oracle:thin:@<host>:1521:0rallg

jdbc:oracle:thin: @//<host>:1521/
orallgsn (Oracle JDBC Thin using a
ServiceName)

jdbc:oracle:thin:@orallgtn (Oracle JDBC
Thin using a TNSName)

jdbc:oracle:thin:@<host>:1521:0ra9i

jdbc:oracle:thin:@<host>:1521:0ra9i

jdbc:oracle:thin:@<host>:1521:userdb

jdbc:db2://<host>:50000/test

jdbc:db2://<host>:50000/test

jdbc:db2://<host>:50000/test

jdbc:db2://<host>:50000/test

jdbc:db2:test

jdbc:db2://<host>:50000/test

jdbc:db2://<host>:50000/test

jdbc:db2://<host>/test

jdbc:db2:test

jdbc:rbw:protocol:<host>:5050/test/

jdbc:informix-sqli://<host>:9088/demo:
INFORMIXSERVER=o0I_informix1170

jdbc:informix-sqli://<host>:9090/
informixdatatype:
INFORMIXSERVER=o0Il_informix

jdbc:informix-sqli://<host>:1527/Demo:
INFORMIXSERVER=o0Il_informix

jdbc:informix-sqli://<host>:1526/
stores_demo:informixserver=DBSC

jdbc:hsqldb:D:\JReport\Demo\db
\SampleDB

jdbc:sybase:Tds:<host>:5000/master

jdbc:sybase:Tds:<host>:5000/master

jdbc:sybase:Tds:<host>:5000/master

jdbc:sybase:Tds:<host>:5000/master

jdbc:sybase:Tds:<host>:2638/igdemo

jdbc:postgresql://<host>:5432/postgres

jdbc:postgresql://<host>:5432/postgres

jdbc:postgresql://<host>:5432/test

jdbc:Cache://<host>:1972/samples

jdbc:derby://<host>:1528/test

jdbc:derby://<host>:1527/test

jdbc:derby:D:\derby\demo\databases
\toursdb

host, port, databaseName:demo

jdbc:hive://<host>:10000

jdbc:pervasive://<host>:1583/test

jdbc:vertica://<host>:5433/vmartdb

jdbc:mysql://jrdbtest.c4fb8hiicidz.us-
west-2.rds.amazonaws.com:3306/
sampledb1110 (The URL is dynamically
generated when you apply an instance.)

jdbc:postgresql://jinfonet-rsdw-demo.
cfcn5o0gcl4yr.us-east-1.redshift.
amazonaws.com:5439/sampledb (The
URL is dynamically generated when you
apply an instance.)

jdbc:hive2://<host>:10000/default;
auth=noSasl

clientCertificateKeyStoreUrl=D:\test\SSL_Cient\ca-cert. penf
clientCertificat eKeyStorePassword=1234 is connected by SSL. For how to install SSL, refer to
http://www.openssl.org. For how to configure MySql for SSL, refer to http://dev.mysql.com/doc/

refman/5.1/en/ssl-connections.html. For more information about JDBC driver, refer to http://dev.

mysgl.com/doc/connector-j/en/connector-j-reference-configuration-properties.html.

. For Oracle JDBC Thin using a TNSName, you need to configure the tnsname first, then add the

parameter - Dor acl e. net .t ns_adm n=<desi gner _instal |l _root>\1i b into the file JReport.bat which
is located in <desi gner _i nstal | _r oot >\ bi n, assuming you have copied the file thsnames.ora from
your Oracle server to <desi gner _install _root>\1ib.
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Installing using the Installation Wizard

Installing JReport Server with the Installation Wizard is intuitive. You only need to follow the screens
and enter the required information. The Installation Wizard provides two installation types:

. Typical Installation for Standalone Server
Installs JReport Server with the default configuration settings.

. Custom Installation for Standalone Server
Installs JReport Server in a standalone environment. If you choose this installation type, you can
configure the server system environment in the Installation Wizard.

This document shows you how to install the server to different systems with the Installation Wizard and
configure the server according to your requirements.

Installing on Windows

To install JReport Server on a Windows platform, take the following steps:

1. Download the JReport Server installation file for Windows from the Jinfonet download center:
http://www.jinfonet.com/downloadjreport/.

2. Run the installation file and follow the prompts to install.

During installation, pay attention to the following:

. The installer requires that you choose a Java JDK to complete the installation. You can download the
appropriate JDK from http://java.sun.com or your computer vendor's website.

. The Installation Wizard will first find a JVM to get started. If no JVM is found, the JReport installer
will fail to launch. To solve this issue, you can try either way:

» Set JAVA_HOME variable and append %JAVA_HOVE% bi n to Path variable in system environment.

o Install JReport Server from a DOS command by specifying the LAX_VMoption for the Installation
Wizard as follows:

jrserver-xxx-w ndows. exe LAX VM "C:\jdkl.6.0_17\bi n\java. exe" (change jrserver-xxx-
windows.exe to the real file name of the installation file)

The JDK path should use absolute path and be quoted by "".

. The installer provides a chance for you to add additional class paths. You can also choose to add
them manually into the setenv.bat in <i nst al | _r oot >\ bi n after installation.

Installing on Unix

JReport Server supports Solaris, Linux, HP-Unix, and AlX. In the following process, an X server is
running and Java 1.6 or above is available, otherwise ask your administrator for help. Installing and
running JReport Server requires that an X server has been configured.

1. Download the JReport Server installation file for Unix from the Jinfonet download center: http://
www.jinfonet.com/downloadjreport/.

If you need to transfer the installation file from your download machine to your Unix box, you
should transfer it using FTP in binary mode.

2. Click the installation file to launch the Installation Wizard. Alternatively, you can open a console
window, and change the directory to the location of the file. Following are examples of the
commands that can be used:

$ cd /opt/JReport/ Server (or your preferred install location)

To make the installation file executable, type the command:

$ chnmod +x jrserver-xxx-linux.bin (change jrserver-xxx-linux.bin to the real file name of the
installation file)

To run the installation file:

$ ./jrserver-xxx-1inux.bin (change jrserver-xxx-linux.bin to the real file name of the
installation file)

The Installation Wizard will first locate a JVM to get started. If no JVM is found, the installer will
fail to launch. To solve this issue, you can try either way:

o Set JAVA_HOME variable and append $JAVA HOVE/ bi n to PATH variable in system environment.

o Specify a JVM for Installation Wizard with the option LAX VMas follows:

$ ./jrserver-xxx-linux.bin LAX_ VM "/opt/jdkl.6.0_17/bin/java" (change jrserver-xxx-
linux.bin to the real file name of the installation file)

The JDK path should use absolute path and be quoted by "".

3. Once the Installation Wizard has successfully loaded, you can follow the standard prompts to
install JReport Server.

Installing on z/Linux

JReport Server supports Linux on IBM system z. In the following process, an X server is running and a
JDK specially used for IBM is available, otherwise ask your administrator for help. Installing and
running JReport Server requires that an X server has been configured.

1. Download the JReport Server installation file for z/Linux from the Jinfonet download center: http://
www.jinfonet.com/downloadjreport/.

If you need to transfer the installation file from your download machine to your z/Linux box, you
should transfer it using FTP in binary mode.

2. Click the installation file to launch the Installation Wizard. Alternatively, you can open a console
window, and change the directory to the location of the file. Following are examples of the
commands that can be used:

$ cd /opt/JIReport/ Server (or your preferred install location)

To make the installation file executable, type the command:

$ chnod +x jrserver-xxx-1linux.bin (change jrserver-xxx-linux.bin to the real file name of the
installation file)

To run the installation file:

$ ./jrserver-xxx-1inux.bin (change jrserver-xxx-linux.bin to the real file name of the
installation file)

The Installation Wizard will first locate a JVM to get started. If no JVM is found, the installer will
fail to launch. To solve this issue, you can try either way:

o Set JAVA_HOME variable and append $JAVA HOVE/ bi n to PATH variable in system environment.

o Specify a JVM for Installation Wizard with the option LAX VMas follows:

$ ./jrserver-xxx-linux.bin LAX_VM "/opt/ibmjava2-sdk-6.0/bin/java" (change
jrserver-xxx-linux.bin to the real file name of the installation file)

The JDK path should use absolute path and be quoted by "".

3. Once the Installation Wizard has successfully loaded, you can follow the standard prompts to
install JReport Server.

Installing to an existing JReport Server directory

If you select to install JReport Server in a folder that already contains an existing JReport Server, you
can choose to continue the installation in either the upgrading way or overwriting way. If you choose
the upgrading way, the installer will replace the packages and create new batch/script files. Meanwhile,
a copy of the old batch/script files will be kept for your reference. You should use the batch/script files
that come with the installer in order to make sure that all new packages are added to the class path
and manually merge any changes you made into the new version. However, your configuration files
and server runtime data of the existing copy will be kept, and you can choose to recover the previous
version during the uninstallation of the newly installed JReport Server.

Configuring system database

Configuring the system database is a step on the server installation wizard available to a production
key or a temporary key.

By default the trial database Derby is used. The port is configurable in case it is being used.

However in a production environment, you'd better configure your own production DBMS instead of
using the default Derby which is provided for testing and evaluation purposes only and which should
not be used in a production system. To do this, select Production Database and then set the correct
database connection information. If the connection failed after clicking Next, a message will pop up,
you can choose to reset the connection. Or if you choose to continue with the failure, after the
installation, you need to configure the database still. For details, see Configuring the server database.

These databases have been tested workable as the production database: HSQLDB, MySQL, Microsoft
SQL Server, IBM DB2, Oracle, Sybase, and Informix.

Notes:
. ODBC is not supported as the server database.

. When setting SQL 2000 as the server database, the driver should use jtds.jar, otherwise the
scheduling feature cannot work.

Configuring system environment

When installing JReport Server using the Installation Wizard, if you choose Custom Installation for
Standalone Server, you can configure the server system environment according to your requirements
during the installation. You can configure the following items:

. Service

. Cluster

. Cache

o Cache Loaded Catalogs
Specifies whether to keep a catalog in memory, or to remove it from memory after a report is
completed.

Normally, after a report has been generated, the catalog that is used to generate the report will be
removed from memory. However, if you specify this option, the catalog will be cached rather than
removed.

Cache Loaded Page Reports
Specifies whether to keep the page reports in memory or remove them from memory after they
have been generated.

. Performance
Pre-loading the Java classes and fonts which are used by catalogs, reports and JReport Engine at
startup time will improve performance when these classes are needed at runtime.

o Preload Catalog Referred Classes
Pre-loads the Java classes that are used for a catalog.

o Preload Page Report Referred Classes
Pre-loads the Java classes that are used for a report.

o Preload Engine Referred Classes
Pre-loads the Java classes that are used by JReport Engine to generate reports.

o Preload Fonts
Specifies to load the fonts when JReport Server is started rather than when they are first used.

- Maximum Number of Concurrent Reports in the Queue
Specifies the maximum number of concurrent reports in the queue, which must be less than or
equal to the number that the license permits. For details, see Appendix 1: Properties in the server.

properties file.

. Advanced
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Installing silently

JReport provides two files for installing JReport Server silently without user participation in the
installation process, which are Serverlnstall_typical.properties for the Typical Installation for
Standalone Server type and Serverlnstall_custom.properties for the Custom Installation for Standalone
Server type.

Follow the steps below to install JReport Server silently:

1. Copy the appropriate file from <i nstal | _root >\ hel p\ sanpl es\ Si |l ent | nstal | to the directory
where the JReport Server installation file is saved and edit it to suit your requirements.

2. Some built-in demo reports (\*.cls) with Derby as the data source (install_root\db\SampleDB.
script) have been provided. At the end of the installation, the installer will configure the reports
and catalog to the correct data path. This calls some AWT classes that require GUI support.

So, if you have an X server installed, you should set the Display variable so that this step can be
performed successfully.

$ DI SPLAY=host nane(or | P address):0.0
$ export DI SPLAY

Note: If you do not have X server or a pure text environment, this step can be ignored.
However, you may find that the demo reports will not be able to run after you start the
JReport Server due to having the wrong default data source path. In this case, you can use
JReport Designer to publish some working reports for testing purposes.

3. Run the following command, and JReport Server will be installed in the designated path:

$ ./jrserver-xxx-linux.bin -i silent -f Serverlnstall _typical.properties (change
jrserver-xxx-linux.bin to the real file name of the installation file)

Notes:

. When installing JReport Server silently, make sure you do not use upgrade installation, it is not
supported for now.

. When you install the Update or Service Pack silently, edit the file update.properties in
<install _root>\hel p\sanpl es\Silentlnstall to your own requirements. This file is used to

create an option file (that is, response file) for the Installation Wizard. It predefines all the
information that is required for the installation.

You can also create a property file and save it as follows:

USER | NSTALL_DI R=/ usr /| ocal / JReport/ Server
USER_KEY=UI D
USER_PASSWORD=Passwor d

Modify the above lines according to your own environment and configurations.
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Installing using the console interface

JReport enables you to perform an interactive installation from a command prompt on platforms that
do not have GUI. In this way, you are able to see the installation status and follow the installation
process.

Take the following steps to perform console installation:

1. Download the appropriate installation file according to your system reugirement from the Jinfonet
download center: http://www.jinfonet.com/downloadjreport/.

2. Run the following command:
For Unix and z/Linux:

$ chnod +x jrserver-xxx-linux.bin

$ ./jrserver-xxx-linux.bin -i consol e (change jrserver-xxx-linux.bin to the real file name of
the installation file)

For Windows:

jrserver-xxx-w ndows. exe -i consol e (change jrserver-xxx-windows.exe to the real file name
of the installation file)

3. Make decisions following the installation process.
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Installing on Unix manually

In some rare cases, JReport Server may fail to install on Unix directly. In this case, follow the steps
below to install it manually:

1.

2.

10.

Install JReport Server on Windows following the steps in Installing on Windows, but don't start it.

Prepare a directory on Unix where you will copy the installation, for example / opt / JReport/
Server.

Modify javahome and reporthome in the following files in <i nstal | _r oot >\ bi n to the Unix

directories where the Java JDK is located and the directory you are going to copy the release to,
using absolute path. Be sure to modify them carefully. Any mistake will cause problems starting
JReport.

report.ini
servlet.properties
setenv.sh

Modify javahome in the file env.sh in <i nstal | _root >\ der by\ bi n to the Unix directory where the
Java JDK is located, using absolute path.

Delete the file server.properties from <i nstal | _root >\ bi n if it exists and remember to reset the

required configuration settings on the JReport Administration page (8889 as the default port) after
launching JReport Server on Unix. The server.properties file is created if you use the custom
format to install.

Make a zip or jar archive of the above folders, and then copy it to your Unix system (use binary
format if using FTP).

Extract the folder in the destination directory in accordance with the path defined in the property
files.

Use the dos2uni x command to convert all the .sh files under <i nstal | _r oot >/ bi n to the format
that can be recognized by Unix. You can execute the command like this:

$ dos2uni x *.sh

Use the chnbod command to set the converted files under <i nstal | _r oot >/ bi n to have read, write
and execute permission. You can execute the command like this:

$ chnod 777 *.sh

Start a shell (Console) and login as root or become the root user by running the su command.
Make JRServer.sh executable and then start JReport Server by running . / JRSer ver. sh.

Note: If you fail to intall JReport Server on your z/Linux system directly, you can also follow the above
steps to install the server manually.
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Installing by building a war file on Windows to deploy
to Linux/Unix

There are user cases when they need to install JReport Server into application servers in the cloud and
may not even own a machine of the type they are installing to. For example you use Tomcat on Linux
in a cloud environment but only have Windows machines available locally. You can then install JReport
server on Windows, make a war file and then deploy it to the Tomcat on Linux.

1. Install JReport Server on the local Windows machine.

2. Create a WAR via the following command line while specifying a report home. The report home
uses the path on Linux on the target machine.

makewar . bat - Dreport hone=/opt/reporthone
3. Add any JDBC drivers that are required into the j report. war/VWEB- | NF/ | i b directory.

4. Visit Tomcat from the local machine by the URL htt p:// <host >: 8080/, deploy the WAR. 8080 is
the default port of Tomcat and suppose it works.

5. Log onto JReport Server Administration console by the URL htt p: // <host >: 8080/ j r eport/admi n,
go to the Data tab on the system toolbar, configure the server database for System DB/realm DB/
Profiling DB. It shouldn't be Derby.

6. Restart JReport Server and access http://<host>: 8080/ report to see if you can run reports.
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Uninstalling JReport Server

Use either of the following methods to remove JReport Server:

. From the Control Panel, open Add or Remove Programs, and then select JReport Server 13.5
Update 2 to uninstall it.

« Run uninstaller.exe (uninstaller on Unix) in <i nstal | _root >\ _uni nst.

Note: The uninstaller will remove all the files generated by the installer, while the files that are created
later by the program will be retained. They should be removed manually.
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Solving installation problems

This section is trying to help you solve the problems you encounter during the installation.

Where to find log information

If error occurs during the installation, you can check the log information recorded to find out what the
problem is. Where logs are generated depends on when the installation process get stuck:

If the installation is cancelled before you click the Install button on the installation wizard, logs are
created on the desktop for Windows and in the userhome directory for Unix/Linux.

If the installation is cancelled after you click the Install button on the installation wizard, logs are
created in the logs folder in the installation root directory.

Besides, on a Windows platform, you can choose to specify the log destination that should use absolute
path and log file name when launching the installation wizard by running the following command:

jrserver-xxx-w ndows. exe - D$I NSTALL_LOG NAME$="Instal | .| og" -D$I NSTALL_LOG DESTI NATI ON
$="D:\tenmp"

or

$ ./jrserver-xxx-linux.bin -D$I NSTALL_LOG NAME$="Instal |l .| og" -D$I NSTALL_LOG DESTI NATI ON
$="/opt/tenmp"

Change jrserver-xxx-windows.exe or jrserver-xxx-linux.bin to the real file name of the installation file.

Feel free to send your questions to support@jinfonet.com.

An issue on Windows Vista

Problem

When running JReport Server's installer on Windows Vista, the installer cannot find the installed JDKs.
Reason

By default Vista's security settings are stricter than Windows 2000, XP, and 2003. The children
processes do not inherit the execution right from their parent process.

Solution
Make the compatibility property of the installer file (.exe) available:

1. Right-click the installer file, and select Properties from the shortcut menu.

2. In the Compatibility mode panel of the Compatibility tab, check the Run this program in
compatibility mode for option, and then select Windows 2000 from the drop-down list.

3. Click OK.

4. Run the installer.
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JReport Server reporthome directory overview

This section provides a general view of the directories in the JReport Server installation root, including
what they contain, what they are used for, and how to set their location if possible.

The following is a list of the server reporthome directories:

Directory

_uninst

bin

db
Demo

derby

dynamicclasses

font

gisinfo

help

history

images
jreports

lib

logs

ntservice

portlet
prestart

profiling
properties

public_html
realm
resources

scratchdir

script_files

style

temp

templates
txtdriver

Contents

Files used for uninstalling the JReport
Server.

Command, configuration, and
properties files.

Demo reports' database.

Demo reports used in the tutorial
lessons.

The Derby program and database
resources.

UDS jar/zip files.

TTF font.

Report related Geographic Information
files.

Help documents introducing the
function, features and usage of
JReport Server and JReport Designer
together with Tutorial manual.

Version files.

Public images for Page Report Studio.
Demo reports.

When scheduling a task to disk, the
directory refers to the destination root
of the server resource tree.

Library files required by JReport
runtime.

Log files.

Files for C program and for writing a
Windows NT-service to run JReport
Server.

Resources for building portlet wars.

Reads customized configuration for
launching JReport Console and
Administration pages from the Start
menu.

Profiling related files.

Default location for JReport Server
realm database.

Standalone web app folder.
Realm files.

Language packages for specifying
JReport Server Ul language.

Output files of compiled JSPs.

Script files for creating and deleting
system database tables.

CSS style files and style group files.

Engine temp files and Server temp
result files.

Templates for web reports.
Demo reports’ flat data files.

Directory location Configurability
Fixed.

Fixed.

Fixed.
Fixed.

Fixed.

The directory location can be specified by
the server.dynamic.class.dir property in
the server.properties file in

<install _root>\bin.

The directory location can be specified by
-Djreport.server.font.path or by the
server.font.path property in the server.
properties file in <i nstal | _r oot >\ bi n.

Fixed.

Fixed.

The directory location can be specified by
the servlet.jrserver.initArgs property in
the servlet.properties file in

<install _root>\bin.

Fixed.
Fixed.

Fixed.

The directory is the default location for
log files.

Fixed.

Fixed.
Fixed.

Fixed.

The directory location can be specified
using the URL option on the JReport
Administration page > Data > Realm DB
> Configuration tab.

Fixed.
Fixed.
Fixed.

The directory location can be specified by
the servlet.jspservlet.initArgs property in
the servlet.properties file in

<install _root>\bin.

Fixed.

The directory location can be specified by
stylePath in the report.ini file in
<install _root>\bin.

For Engine temp files, the directory
location can be specified by tempPath in
the report.ini file in <i nstal | _r oot >\ bi n.

Fixed for Server temp result files.

Fixed.
Optional.
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Upgrading JReport Server

Upgrading a standalone JReport Server and an integrated JReport Server involves different processes
while sharing some common steps. Both updated JReport Servers require converting the report
resources in the old version in order to comply with the new server version.

Before upgrading, the old version JReport Server should be shut down.

Upgrading in a standalone environment

JReport Server 13.5 provides two migration tools in <i nst al | _r oot >\ bi n folder, which can help you to

convert all the resources on the previous version of JReport Server before version 6.0. Resources the
migration tools cover include the security information (realm, user, group, protection, and ACL), report
resources (catalog and reports), scheduled tables, completed tables, version and version tables, and
other relevant information (such as fonts, NLS, and style groups).

Note: When installing the JReport Server 13.5 into the same directory as the old version, the report
level resources in the old version will be maintained and not be replaced by the report resources of
V13.5. For example, if you installed JReport Server 13.5 to C. \ JReport\ Server 13GA, the backed up

files of V13 GA will be maintained in C. \ JReport\ Ser ver V13GA\ bak\ pr evi ous_ver si on, the removed
patches and jar files will be maintained in C.\ JRepor t\ Server V13GA\ bak\ xxx\ | i b, and the whole
folder bin will be maintained in C:\ JRepor t\ Ser ver V13GA\ bak\ xxx\ bi n.

Upgrading a version later than V13 GA (included) to V13.5

To upgrade a version later than V13 GA (included) to V13.5, take the steps below. Here is a case
showing you how to upgrade V13 GA to V13.5, provided that the old JReport Server is located in C
\ JReport\ Server 13GA.

1. Install JReport Server 13.5 to C. \ JReport\ Server 13GA. In the Choose Installation Set screen,
choose Typical Installation for Standalone Server and click Next.

2. In the prompted Installation Warning message window, choose Upgrading.

3. The installation turns to the List screen which shows the details of the upgrading, including the
removed patches, the modified config files and the backup files.

4. Click Install in the Installation Summary screen. After the installation is complete, start JReport
Server to check the upgraded version.

Upgrading a version later than V6.0 (included) to V13.5

To upgrade a version later than V6.0 (included) to V13.5, take the steps below. Here is a case showing
you how to upgrade V11.1 to V13.5, provided that the old JReport Server is located in C. \ JReport
\ Server11. 1.

1. Check the value of properties in dbconfig.xml which locates in C.\ JReport\ Server 11. 1\ bi n or
back up the file firstly.

2. Install JReport Server 13.5 to C:\ JReport\ Server 11. 1. In the Choose Installation Set screen,
choose Typical Installation for Standalone Server and click Next.

3. In the prompted Installation Warning message window, choose Yes.

4. In the System Database screen, input the property values according to the backed up dbconfig.
xml file. Or check the Trial Database radio button, and replace dbconfig.xml file with the one you
backed up.

5. In the List screen you can see the details of the upgrading, including the removed patches, the
modified config files and the backup files.

6. Click Install in the Installation Summary screen. After the installation is complete, start JReport
Server to check the upgraded version.

Upgrading a version between V5.2 Build 590 (included) and V6
(excluded) to V13.5

You can make the upgrade using the migration tool MigrationV52.bat (MigrationV52.sh for Unix) that is
available in the <i nstal | _root >\ bi n folder. This tool is used to convert all the resources of the

versions between V5.2 Build 590 (included) and V6 (excluded) to the resources of JReport Server 13.5.
If you install the new version to the same folder as the old one, the parameter can be omitted.

. Usage
MigrationV52 [orgReportHome]

. Options

n orgReporthome
The reporthome of the original JReport Server. If this parameter is not provided, the reporthome of
JReport Server 13.5 will be used as its value.

Case 1: Installing JReport Server 13.5 to a new folder (recommended)

1. Provided that the old JReport Server is located in C: \ JREnt Ser ver 595. Install JReport Server 13.5
to a new folder C. \ JReport\ Server V13. 5. DO NOT start the newly installed JReport Server.

2. In the DOS window, switch to <i nstal | _root >\ bi n, and run M grati onV52 C:\ JREnt Server 595.

Case 2: Installing JReport Server 13.5 to the folder where the old version resides

1. Provided that the old JReport Server is located in C. \ JREnt Ser ver 595. Install JReport Server 13.5
to the same location. DO NOT start the newly installed JReport Server.

2. In the DOS window, switch to <i nstal | _root >\ bi n, and run M grati onV52. bat .

Upgrading a version earlier than V5.2 Build 590 (excluded) to
V13.5

You can do the upgrade using the migration tool MigrationBV52.bat (MigrationBV52.sh for Unix) that is
available in the <i nstal | _root >\ bi n folder. This tool is used to convert all the resources of versions

lower than V5.2 Build 590 to the resources of JReport Server 13.5. If you install the new version to the
same folder as the old one, the parameter can be omitted.

. Usage
MigrationBV52 [orgReportHome]

. Options

n orgReporthome
The reporthome of the original JReport Server. If the parameter is not provided, the reporthome of
JReport Server 13.5 will be used as its value.

Case 1: Installing JReport Server 13.5 to a new folder (recommended)

1. Provided that the old JReport Server is located in C. \ JREnt Ser ver 580. Install JReport Server 13.5
to a new folder C:\ JReport\ Server V13. 5. DO NOT start the newly installed JReport Server.

2. In the DOS window, switch to <i nstal | _root >\ bi n, and run M grati onBV52 C:\ JREnt Ser ver 580.

Case 2: Installing JReport Server 13.5 to the folder where the old version resides

1. Provided that the old JReport Server is located in C. \ JREnt Ser ver 580. Install JReport Server 13.5
to the same location. DO NOT start the newly installed JReport Server.

2. In the DOS window, switch to <i nstal | _root >\ bi n, and run M gr ati onBV52. bat .

Upgrading in an integration environment

1. Suppose that you already have a standalone JReport Server 13.5, whether it is installed directly or
upgraded from a previous version. In this step you need not convert the old version reports.

2. Use the JReport Server 13.5 to create a self-contained WAR/EAR file. For information on how to
create the WAR/EAR, see Building a WAR/EAR file to include a self-contained JReport Server.
Remember that when building the jreport.war file in a standalone JReport Server 13.5, the
ReportHome of jreport.war must be the same as that of the jreport.war in the previous version.

3. Use the Java application server that integrates the previous version of JReport Server to deploy
the new self-contained WAR/EAR and update the old WAR/EAR with the new one.

By now, if the previous version of JReport Server is later than V6.0 (included), the integrated
JReport Server has already been upgraded to V13.5. But if the previous version is earlier than
V6.0, go to step 4 and you need do further upgrade.

4. For a previous version between V5.2 Build 590 (included) and V6 (excluded): in the DOS window,
switch to <r eport hone>\ bi n, and run M gr ati onV52. bat .

For a previous version earlier than V5.2 Build 590 (excluded): in the DOS window, switch to
<r eport home>\ bi n, and run M gr ati onBV52. bat .

5. Clear the temporary files or cached files on the application server. Take Tomcat as an example,
remove the temp and work directories in D: \ Tontat .
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Launching JReport Server

After you have installed JReport Server, you must set up the reporting environment and start it before
you can access it via a web browser. This chapter provides you with detailed information of how to run
JReport Server in different running modes.

The following topics are discussed in this chapter:

. Setting up the reporting environment

. Running as a standalone server

. Running as an OS service

. Running within an application server
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Setting up the reporting environment

Now that you have installed JReport Server, you can start it. However, it is better to first check the
reporting environment to see whether you have published the reports including the catalog files, added
the necessary class paths, and set up the data sources.

Report publishment & creation

The separation of the report file and the data is powerful. It facilitates easy re-use of the report's
layout. Report files built with JReport Designer can then be published to JReport Server for running in
the thin-client/server mode. Today, computing is a service-based model in which web based
applications are rapidly replacing monolithic fat-client hosted and maintained software applications.
JReport Server is a high performance server for running reports on demand or unattended on a
scheduled basis. In this environment, thousands of clients may view, print and generate new reports.

JReport Server has its own resource tree with each node mapping to a folder or file in your physical
drive. So when publishing report files to the server, it is recommended that you check:

Whether the report files reside somewhere in the server machine.
Whether the files are mapped in the resource tree.

That not only the report files, but also the catalog files (including the .fml file) exist and are in the
same directory. In addition, one directory can only contain one catalog. However, it can contain
many report files which use that catalog.

Data sources

You may have your own catalogs and reports that you developed, and want them to be run and be
distributed by JReport Server. In order to do this, the data sources used by your catalogs must be
correctly set to the runtime environment of JReport Server.

User data source

Append the class path of your user class files to the first item of the classpath set in your batch file or
command line that starts JReport Server. If you are using JReport Server embedded in an application
server, add your user class files to the WAR file used to deploy JReport Server.

Additional class paths

If your reports reference any external classes, you will need to add them to the classpath option in the
batch file and command line that starts JReport Server. For example, if your reports contain user
defined objects (UDO) or user defined formula functions, do not forget to add them to the class path or
to the WAR file.
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Running as a standalone server

JReport Server can be started from the web application server contained in the JReport Server
package. This section explains how to start JReport Server as a standalone report server, how to send
commands to the server and how to use the batch files in the <i nstal | _r oot >\ bi n directory.

. Starting using launch files

. Starting using Java

. Sending commands to JReport Server from Java
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Starting using launch files

After you have installed JReport Server, many batch files are automatically generated in
<install _root>\Dbin. They are for assisting you with using and maintaining JReport Server. All of

these batch files can be edited to suit different circumstances. However, make sure that you
understand their functions when you want to edit them.

The following are the JReport Server launch files.

browser.bat

This tool detects the default client browser and installation path. It is invoked by launchpad.bat.

CmdSender.bat/CmdSender.sh

This tool is for sending commands to JReport Server. If the option "-s" or "-p" is not used, the JVM
system property "reporthome" must be defined so that CmdSender.bat/CmdSender.sh will use it to get
data from the local machine.

Usage
cmdsender [-s:<server> -p:<port> -u:<user>] -w:<password> shutdown|localshutdown|(local:on]off)
Options

. _S
The server host name.

B &
The administration port.

. -u
The admin user name.

3 _W
The admin password.

. shutdown
Shuts down the server.

. localshutdown
Shuts down the local server.

. local
The administration tasks are available to local host only.

L] gC
Run the Java garbage collector.

DBMaintain.bat/DBMaintain.sh

This tool is for administrators to back up and restore JReport Server data. It is invoked by the following
command line:

Usage

DBMaintain -[?|cleanup|B<[systemtables|realmtables|profiling]:<filename>>|R<[systemtables|
realmtables|profiling]: <filename>>]

Options

-?
Displays the usage information and then exits.

. -cleanup
Checks integrality of the server data and cleans up the invalid data.

. -Bsystemtables:<filename>/-Brealmtables:<filename>/-Bprofiling:<filename>
Backs up the data in the database with the related data to a specified file.

For example, for backing up the server data realmtables to file c: \j sback. dat, you can type:

DBMai nt ai n - Breal nt abl es: c:\j sback. dat

. -BOrealmtables:<filename>
Only backs up the data in the realm database.

. -Rsystemtables:<filename>/-Rrealmtables:<filename>/-Rprofiling:<filename>
Restores the data including the related data outside the database from a specified file.

For example, for restoring server data realmtables from the file c: \ j sback. dat , you can type:

DBMai nt ai n - Rreal nt abl es: c:\j sback. dat

. -ROrealmtables:<filename>
Only restores the data in the realm database.

DJRServer.bat/DJRServer.sh

This tool is used to launch JReport Server with debug and log information. The output log files are in
the <i nstal | _root >\ | ogs directory. In case of problems, you may run this batch to reproduce the
problem. Open the files to see the detail information and find out the problem. Send the log files to
support@jinfonet.com if you are unable to resolve the problem.

Usage

DJRServer [-?]|-p <port>]|-ap <adminport>|-realm <realmname=>|-l backlog|-m <max=>
|-t <timeout>]|-s <filename=>|-web <directory>|-env|-silent|
|-local|-vDebug|-VvError]|-jrs.admin.server <host:port>|-cleanup]

Options

-?
Prints this help message.

.« -p <port=
The port number to listen on.

. -ap <adminport>
The port number which is used by the administration tools.

. -realm <realmname=>
Specifies the active realm.

. -l <backlog>
The maximum queue length for incoming connections.

. -Mm <max>
The maximum number of connection handlers.

. -t <timeout>
The connection timeout in milliseconds.

. -s <filename=>
The servlet property file name. If this option is not used, the file servlet.properties in <i nstal | _r oot >
\ bi n will be used as the servlet property file when launching JReport Server.

. -web <directory>=
The root directory when accessing the server via the web. Its default value is <i ntal | _r oot >

\public_htm.

. -env
Prints the environment.

. -silent
No output is sent to the console.

. -local
The administration tasks are available on local host only.

. -vDebug
Enables JReport Engine to output messages to a file and sets all log files' trace levels to INFO and
error levels to WARN.

. -VError
Enables JReport Engine to output messages to a file and sets all log files' trace levels to OFF and
error levels to ERROR.

. -Jjrs.admin.server <host:port>
The admin server host and RMI port.

. -cleanup
Checks integrality of the server data and cleans up the invalid data.

JRServer.bat/JRServer.sh
This tool is used to launch JReport Server in standalone mode without any predefined options.

On Windows, you can start server by double-clicking on JRServer.bat. If you cannot start the server
successfully in this way, the reason will be displayed in the MS-DOS command prompt.

Usage

JRServer [-?]|-p <port>|-ap <adminport>|-realm <realmname=>|-l backlog|-m <max>
|-t <timeout>]-s <filename>|-web <directory>|-env|-silent|
|-local]-vDebug]|-VvError|-logall]-jrs.admin.server <host:port>|-cleanup]

Options

-?
Prints this help message.

. -p <port=
The port number to listen on.

. -ap <adminport>
The port number which is used by the administration tools.

. -realm <realmname=
Specifies the active realm.

. -l <backlog>=
The maximum queue length for incoming connections.

. -M <max>
The maximum number of connection handlers.

. -t <timeout>
The connection timeout in milliseconds.

. -s <filename=>
The servlet property file name. If this option is not used, the file servlet.properties in <i nstal | _r oot >

\ bi n will be used as the servlet property file when launching JReport Server.

. -web <directory>
The root directory when accessing the server via the web. Its default value is <i ntal | _r oot >

\public_htm .

. —enV
Prints the environment.

. -silent
No output to the console.

. -local
The administration tasks are available on local host only.

. -vDebug
Enables JReport Engine to output messages to a file and sets all log files' trace levels to INFO and
error levels to WARN.

. -VError
Enables JReport Engine to output messages to a file and sets all log files' trace levels to OFF and
error levels to ERROR.

. -log][:file Name] (deprecated)
Outputs JReport Engine messages to the log file as specified and uses the -vDebug level.

. -logall
Sets all loggers’ trace level to INFO and error level to WARN.

. -jrs.admin.server <host:port>
The admin server host and RMI port.

. -cleanup
Checks integrality of the server data and cleans up the invalid data.

Notes:

. You may need to set an appropriate -Dfile.encoding option in the file to start JReport Server in order
to view characters correctly.

. You may also need to set an appropriate -Dresolution option in the file to start JReport Server in
order to set the system resolution in DPI.

jrenv.bat/jrenv.sh

This tool is for generating the report environment file report.env in the current directory. This file can
help the Jinfonet support staff assist you when you run into problems.

launchpad.bat

This tool is used to launch JReport Server in the standalone mode and open the JReport Server Launch
Pad page.

makewar.bat/makewar.sh

See here.

MigrationBV52.bat/MigrationBV52.sh

This tool is used to convert all the resources from JReport versions which are lower than V5.2 Build 590
to the resources of JReport Server V8. If you install the new version to the same folder as the old one,
the parameter can be omitted.

Usage
MigrationBV52 [orgReportHome]
Options

. orgReporthome
The reporthome of the original JReport Server. If this parameter is not provided, the value of
"reporthome" of new JReport Server will be used as its value.

MigrationV52.bat/MigrationV52.sh

This tool is used to convert all the resources of which the versions are between V5.2 Build 590
(included) and V6 (not included) to the resources of JReport Server V8. If you install the new version to
the same folder as the old one, the parameter can be omitted.

Usage
MigrationV52 [orgReportHome]
Options

. orgReporthome
The reporthome of the original JReport Server. If this parameter is not provided, the value of
"reporthome" of new JReport Server will be used as its value.

NJRServer.bat/NJRServer.sh

This tool is used to launch JReport Server without JIT option. If your server often crashes with JIT
option, try this batch file instead of JRServer.bat.

Usage

NJRServer [-?]-p <port>]-ap <adminport>|-realm <realmname=>|-I backlog]-m <max>
|-t <timeout>]-s <filename>|-web <directory>|-env|-silent|
|-local]-vDebug]|-VvError|-logall]-jrs.admin.server <host:port>|-cleanup]

Options

-?
Prints this help message.

. -p <port=
The port number to listen on.

. -ap <adminport=>
The port number which is used by the administration tools.

. -realm <realmname=>
Specifies the active realm.

. -l <backlog=>
The maximum queue length for incoming connections.

. -M <max>
The maximum number of connection handlers.

. -t <timeout>
The connection timeout in milliseconds.

. -s <filename=>
The servlet property file name. If this option is not used, the file servlet.properties in <i nstal |l _root >
\ bi n will be used as the servlet property file when launching JReport Server.

. -web <directory>
The root directory when accessing the server via the web. Its default value is <intal | _r oot >

\public_htm.

[ -enV
Prints the environment.

. -silent
No output to the console.

. -local
The administration tasks are available on local host only.

. -vDebug
Enables JReport Engine to output messages to a file and sets all log files' trace levels to INFO and
error levels to WARN.

. -VError
Enables JReport Engine to output messages to a file and sets all log files' trace levels to OFF and
error levels to ERROR.

. -log][:file Name] (deprecated)
Outputs JReport Engine messages to the log file as specified and uses the -vDebug level.

. -logall
Sets all loggers' trace level to INFO and error level to WARN.

. -jrs.admin.server <host:port=>
The admin server host and RMI port.

. -cleanup
Checks integrality of the server data and cleans up the invalid data.

register.bat

It is invoked by browser.bat.

RMIAuthFileCreator.bat/RMIAuthFileCreator.sh

This tool is used to generate the rmi authentication file. JReport Server uses the authentication file to
secure remote objects. If no argument was provided, an authentication file named "rmi.auth” will be
created in <i nstal | _root >\ bi n, using the user ID and install key of JReport Server.

Usage
RMIAuthFileCreator [authFileName [userid key]]
Options

?
Shows the usage message.

. authFileName
The RMI authentication file name. If only input this argument, the user ID and install key of JReport
Server will be used to create the authentication file.

. userid
The user ID, which will be used to generate the contents of the authentication file.

. key
The key which will be used to generate contents of the authentication file.

rp.bat/rp.sh
This tool is for replacing user ID and license key.

Usage
rp U D Key

rptconv.bat/rptconv.sh

This tool is for converting old resources such as reports, visual analysis, library components,
dashboards, catalogs etc. to be current version.

Usage

rptconv "-source=source_path" ["-target=destination_path"] [-r] [-s]

Options

. -source
Specify the source path of the resources that are to be converted.

. -target
Specify the destination path for the converted resources.

[ _r
Replace the source resource with the converted version.

If this option is set, ["-target=destination_path"] is ignored.

If both "-r" and "-target" are not specified, the converted resources are saved in the same directory
as the source resources and named as "converted SourceResourceName".

. _S
Convert all the resources in the specified directory, including the resources in all subdirectories.

Examples

. To convert a single resource:

rptconv "-source=C:\ JReport\Server\jreports\lnvoi ceReport.cls" "—target=C \tenp"

This will convert C:\JReport\Server\jreports\InvoiceReport.cls to C:\temp\InvoiceReport.cls.

rptconv "-source=C: \ JReport\Server\jreports\lnvoi ceReport.cls" "—target=C.\tenp\l.cls.
xm "

This will convert C:\JReport\Server\jreports\lnvoiceReport.cls, save the converted report to C. \ t enp,
and name it as "1l.cls.xml" (if license allows).

rptconv "-source=C \JReport\Server\jreports\Invoi ceReport.cls"

This will convert C:\JReport\Server\jreports\lnvoiceReport.cls, save the converted report in the same
directory, and name it as "converted_InvoiceReport.cls".

rptconv "-source=C \JReport\Server\jreports\Invoi ceReport.cls" -r
This will overwrite C:\JReport\Server\jreports\InvoiceReport.cls.

. To convert all resources (reports, visual analysis, library components, dashboards,
catalogs etc.) in a directory:

rptconv "-source=C \JReport\Server\jreports" "—target=C \tenp"

This will convert all the resources in C:\JReport\Server\jreports and save the converted resources to
C.\t enp. The converted resources use the same file names as source resources.

rptconv "-source=C.\JReport\Server\jreports" "—target=C. \tenp" -s

This will convert all the resources in C:\JReport\Server\jreports and in the subdirectories and save
the converted resources to C: \t enp. The converted resources take the same file names and directory

structure as source resources.

rptconv "-source=C: \JReport\Server\jreports" "—target=C:\temp\*.cls" -s

This will convert all the resources in C:\JReport\Server\jreports and in the subdirectories and save
the converted resources to C. \'t enp. The converted resources take the same directory structure as

source resources and the suffixes of their file names are all changed to ".cls".

rptconv "-source=C. \JReport\Server\jreports" -r -s

This will convert all the resources in C:\JReport\Server\jreports and in the subdirectories. The
converted resources overwrite the source resources.

rptconv "-source=C: \ JReport\Server\jreports"

This will convert all the resources in C:\JReport\Server\jreports. All the converted resources are
saved in the same directory and named as "converted_SourceResourceName™.

. To convert a type of resources with same suffixes in a directory:

The usage is similar to converting a directory. You can specify the wildcard to filter resources, for
example:

rptconv "-source=C.\JReport\Server\jreports\*.cls" "—target=C \tenp"

This will convert all the reports with the suffix ".cls" in C:\ JReport\ Server\jreports and save the
converted reports to C. \ t enp.

Notes:

. There must be one and only one catalog file in the directory where the resources to be converted
reside.

. If the resources to be converted contain UDO or UDF, make sure the corresponding classes or jars
are included in the class path of rptconv.bat/rptconv.sh.

startAdministration.bat

This tool is used to launch the JReport Administration page from the Start menu after the server is
started.

startConsole.bat

This tool is used to launch the JReport Console page from the Start menu after the server is started.

stopServer.bat

This tool is used to exit JReport Server from the Start menu.

stopServer.sh

This tool is used to exit JReport Server.
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Starting using Java

The class of the standalone server is jet.server.JREntServer. You can start JReport Server with the
following command instead of using the generated batch files:

JAVA -cl asspath <cl asspat h> -Dj ava. conpi | er =NONE - Dreport honme=<install _root> jet.server.
JRENnt Server [options]

. -classpath
The classpath must include the following packages originally in your <install _root>\1ib:

JRESServlets.jar; JREntServer.jar; JREngine.jar; servlet.jar; log4j-1.2.8.jar;

. -Djava.compiler=NONE
This is without JIT. This is not a required option. However, if you encounter problems running the
server and you think that they relate to the Java VM, you can try turning off the JIT compiler and
then running again.

. -Djreport.url.encoding
Specifies the encoding to encode/decode escape characters in URL strings. If not specified, the
system default encoding will be used. For example: java ... -Djreport.url.encoding=8859-1...

. -Dreporthome
This is where JReport Server is installed. It is the Destination Location you specified when you
installed it. This option is required. When you set the reporthome, upon launching, JReport will try to
find the jslc.dat and report.ini files in <i nstal | _r oot >\ bi n and check whether they are valid. Jslc.dat

is the License control file. Open report.ini, and you will find the configuration information, including
the temp, template and the help path. JReport will use the temp path to export the temporary files
so you should make sure that the temp folder specified in report.ini exists and has space available.

. -Dfile.encoding
Specifies the encoding to encode/decode escape characters in the server data. If not specified, the
system default encoding will be used. For example: java ... -Dfile.encoding=8859-1...

. -Dresolution
Sets the system resolution in DPI. If not specified, the system default resolution will be used, which
is the resolution of your monitor, for example, -Dresolution=96.

-realm realmname

-web directory

. [options]
Option Description
-? Print brief help message.
-p port The port that this server listens on, default is 8888.
-ap adminport The port number that the remote administration uses, default is 8889.
-1 backlog Maximum length of queue for incoming connection indications.
-m max Maximum number of connection handlers.
-t timeout Connection timeout in milliseconds.
-s filename Servlet property file name.

Active realm when the server starts up.

The specified realm should exist, otherwise the server will use an existing
realm as the active realm. The server will then record a warning message in
the log file, and set the selected active realm by the server.realm.active
property in the server.properties file.

Web application server root directory, default is <i ntal | _r oot >
\public_htn.

-local Administration on local host only.

-vDebug Enables JReport Engine to output messages to a file and sets engine log file's
trace level to INFO and error level to WARN.

-vError Enables JReport Engine to output messages to a file and sets engine log file's
trace level to OFF and error level to ERROR.

-env Print environment settings when the server starts up.

-silent Outputs nothing, not even the server start information.

-log[:file Name] Outputs JReport Engine messages to the log file as specified and uses the -

(deprecated) vDebug level.

-logall Sets all loggers' trace level to INFO and error level to WARN.

-jrs.admin.server The admin server host and RMI port.

host:port

-cleanup Checks integrality of the server data and cleans up the invalid data.

Notes:

. For detailed information on how to configure the logging and debugging information, read the
LogConfig.properties file in <i nstal | _r oot >\ bi n.

. Some of the common options will be used in later chapters. In addition, JReport has automatically
generated some batch files for you so that you do not have to write a complicated command line.
You can find these in the <i nstal | _root >\ bi n directory.
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Sending commands to JReport Server from Java

After JReport Server has been started as a standalone server, you can send commands to the server to
either shut it down or pop up the user interactive interface for administration. All of these can be done
through the class jet.server.CommandSender. The full command is as follows:

JAVA -cl asspath <cl asspat h> -Djava. conpi | er =NONE [ - Dr eport hone=<i nstall _root>] jet.
server. CommandSender [-s:server -p:port] -w password [-7?]|adm n|shutdown| gc| (| ocal: on|
of f)

. -?
Prints brief help message.

. -Djava.compiler=NONE
This is without JIT. This is not a required option. However, if you encounter problems running the
server and you think that they relate to the Java VM, you can try turning off the JIT compiler and
running again.

. -Dreporthome
This is where JReport Server is installed. It is the destination location you specified when you
installed it. It is required only if you do not execute the command from the local host on which
JReport Server is running.

. -Dpoperror=true
This property is used to control whether to pop up a message to show error information. The default
value is false which indicates that the error message will not be displayed.

. -Classpath
The classpath must include the following packages originally in your <i nstal | _root>\11i b:

JRESServlets.jar; JREntServer.jar.

. -siserver
Host name on which JReport Server is running.

. -p:port
The port JReport Server used for administration. The default value is 8889.

. -w:password
Password of the admin user. Example: -w:admin.

. admin
A command sent to the server asking to pop up the user interactive interface for administering
JReport Server.

. shutdown
A command sent to the server asking it to shut down.

. local:on
A command sent to the server asking to only allow the administration commands sent by the local
machine.

. local:off
A command sent to the server asking to accept administration commands from anywhere.

L] gC
A command sent to the server asking the JVM to schedule the Java Garbage Collector.

Note: Some of the common options will be used in the later chapters. In addition, JReport has
automatically generated the batch file CmdSender.bat for you so that you do not have to write a
complicated command line.
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Running as an OS service

JReport Server can be configured as an OS service. This section shows you how to run JReport Server
as a service of Windows, Unix and Linux.

Running as a Windows service

The tool JRservice.exe saved in <i nstal | _root >\ bi n is provided to assist you in installing JReport
Server as a Windows service.

You can get the following information if you run JRservice.exe without any options:

Usage:

JRService -install [-interactive] to install the service
JRServi ce -renove to renove the service

-interactive to enable JReport Server service
to interact with the desktop

Start Servi ceCtrl Di spat cher being call ed.
This may take several seconds. Please wait.

. JRService -install
Running JRservice.exe with the -i nst al | option will install JReport Server as a Windows service. If
you open the Services item in the Control Panel, you will find a service named JReport Server in the
list.

. JRService -install -interactive
If you use the -i nteracti ve option together with -i nst al | , the service installed will be run in
interactive mode. That is, when you start the service, a Command Prompt window will pop up.
However, if you don't specify this option when you install the service, the Command Prompt window
will not be displayed when you start the service. After you have installed JReport Server as a service,
you will then be prompted to restart your computer for the service installation to take effect.

. JRService -remove
Running JRservice.exe with the - r enbve option removes the Windows service of JReport Server from

Windows. However, before you run this, you should stop the service.

Configuring the service

The parameters for the Windows service of JReport Server are read from the file NTService.ini in
<install _root>\bin. In this file, you can find three parameters specified, as shown in the following

example:

JavaVME"C:\jdk1l. 6.0 _17\jre\bin\java. exe"

StartArg= "-Dinstall.root=C \JReport\ Server"

-classpath "C:\JReport\Server\Ilib\JREnt Server.jar;

C.\JReport\ Server\lib\JREngi ne.jar; C\JReport\Server\lib\servlet.jar; C\TEMP". ..
- Dj ava. conpi | er=NONE - Dr eport honme=C. \ JReport\ Server jet.server.JREnt Server

Shut downArg= "-Dinstall.root=C.\JReport\ Server"

-classpath "C:\JReport\Server\Ilib\JREnt Server.jar;

C.\JReport\ Server\lib\JREngi ne.jar; C\JReport\Server\lib\servlet.jar; C\TEM"

- Dj ava. conpi | er =NONE

- Dreporthome=C:. \ JReport\ Server jet.server.CommandSender | ocal shut down

. JavaVM
The path of the Java VM.

. StartArg
The Java command line for launching JReport Server as an independent web application server. This
will be called when the service is started.

. ShutdownArg
The Java command line for shutting down JReport Server. This is called when the service is stopped.

Starting the service
There are two ways to start the JReport Server service.

. After the server has been installed as a service, it is by default configured to start automatically each
time. In other words, without otherwise modifying the Control Panel, the service will start
automatically each time Windows is started.

. You can directly start the service through the Services item in the Control Panel. Open the Services
list, find JReport Server on the list, select it and click the Start button.

You can change the options in the file NTService.ini in <i nst al | _r oot >\ bi n before you start the
service (for more information on the options available, see Starting JReport Server using Java). In the

example above, there are no options specified in StartArg. If you would like to set all error log levels to
WARN and trace log levels to INFO, you will need to append -logall at the end, as in the following
example:

Start Arg= "-Dinstall.root=C \JReport\Server"

-classpath "C \JReport\Server\Ilib\JREnt Server.jar;

C.\JReport\ Server\lib\JREngi ne.jar; C.\JReport\Server\lib\servlet.jar;
C.\JReport\Server\lib\log4j-1.2.8.jar; C\TEMP" -D ava.conpi | er=NONE
- Dreport hone=C: \ JReport\ Server jet.server.JREntServer -1|ogall

Stopping the service
There are three ways for you to stop the JReport Server service:

. Open the Control Panel, go to Administrative Tools, double-click the Services item, select
JReport Server, and then click the Stop button if it is not disabled.

. Run the batch file CmdSender.bat in <i nstal | _r oot >\ bi n with the localshutdown argument, for
example: <i nstal | _root >\ bi n\ ChdSender . bat | ocal shut down.

. Use the Shut Down the Server button on the JReport Administration page.
Notes:

. All ODBC data sources used by the JReport Server Service belong to the System DSN. System data
sources can be used by all users on a computer, and are visible to all users on the computer and
system-wide services, such as Microsoft Windows services. User data sources can only be used by
the current user and are visible only to that user. To establish JReport Server as a service, you
should choose System Data Source. That is, define the data source in the System DSN. To do this,
open Data Source (ODBC) in Control Panel, and add the data source used by JReport Server to the
System DSN panel. Also, remove any old ones from the User DSN.

. When using NT service to start JReport Server, the mapped disk in path cannot be accessed due to
JVM limitation. You should use UNC path (for example, \\ 127. 0. 0. 1\ publ i c_wr it e) instead of the

mapped disk it is mapped to (for example, Z).

. When using the Local System account to run JReport Server as a Windows service, under some
circumstances writing to a UNC path (for example, \\ 127. 0. 0. 1\ publ i c_wri t e) is not allowed. To

solve this problem, you need to start the service by using a normal Windows user.

Running as a service on Unix
Assume that JReport Server has been installed to / user/report/jns,

1. Write a script/etc/init.d/jrserver as follows, and make it executable.

#!/ bin/ sh

node=$1

if [ ! -d /user/report/jns ]
then # JReport not installed
exit 1

fi

case "$node" in

"start')

if [ -d /fuser/report/jns ]

t hen

echo "Starting JReport Server”
{user/report/jns/bin/ NJRServer.sh &
fi

"stop')
if [ -d /user/report/jns ]
t hen

echo " Stoppi ng JReport Server”
{user/report/jns/bin/ChdSender.sh | ocal shutdown &
fi

3

echo Usage:
echo " $0 start (start JReport Server)"

echo " $0 stop (stop JReport Server)"
exit 1

esac
exit O

2. Create a softlink to /etc/rc2.d/ S99j rserver.

In-s /etc/init.d/jrserver /etc/rc2.d/ S99jrserver
3. Create a soft link to / et c/ rc0. d/ K99j rserver.

In-s /etc/init.d/jrserver /[etc/rc0.d/ KO9jrserver

Running as a service on Linux

Running JReport Server as an OS service on Linux is more or less the same as with running on Unix.
Here it is assumed that your default start up rc is rc5.

Setting up XVFB
1. Install XVFB.

2. Write a script/etc/init.d/xvfb as follows, and make it executable.

#!/ bi n/ sh

node=$1

case "$node" in

"start')

echo "start xvfb "

if [ -f /usr/X11R6/bin/ Xvfb ]

t hen

/usr/ X11R6/ bi n/ Xvfb :1 -screen 0 1152x900x8 &
fi

*)

echo Usage:
echo " $0 start (start XVFB)"

echo " $0 stop (stop XVFB not support)”
exit 1

esac

exit O

3. Create a soft link to /etc/rc5.d/S97xvfb.
In -s /etc/init.d/ xvfb /etc/rch.d/ S97xvfb

Using rc to run JReport Server as a service
Assume that JReport Server has been installed to / JReport/ Server .

1. Write a script / JReport/ Server/ bi n/ JRSer ver as shown below, and make it executable. Here it is
assumed that JReport Server is running on a machine with IP address 127.0.0.1.
#!/ bin/ sh
DI SPLAY=127.0.0.1:1.0
export DI SPLAY
/[ JReport/ Server/bin/JRServer -silent "$@

2. Write ascript/etc/init.d/jrserver as follows, and make it executable.

#!/ bin/ sh

node=$1

if [ ! -d/JReport/ Server ]
then # JReport not installed
exit 1

fi

case "$node" in

"start')

if [ -d /JReport/Server ]

t hen

echo "Starting JReport Server"
cd /JReport/ Server/bin/;
JRServer -silent &

fi

‘stop')
if [ -d /JReport/Server ]
t hen

echo " Stoppi ng JReport Server"

/ JReport/ Server/ bi n/ CdSender | ocal shut down &
fi

:

echo Usage:
echo " $0 start (start JReport Server)"

echo " $0 stop (stop JReport Server)"
exit 1

esac
exit O

3. Create a soft link to /etc/rc5.d/S98jrserver.

In -s fetc/init.d/jrserver /etc/rch.d/ S98jrserver

4. Create a soft link to /etc/rc5.d/K98jrserver.

In -s /etc/init.d/jrserver /etc/rcb.d/ K98jrserver

If all has been carried out successfully, the installation of the service will now have finished. JReport
Server is now ready to run as a daemon process.
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Running within an application server

In addition to running as a standalone server and as a service, JReport Server can also run as a servlet
inside a Java application server. Since JReport Server is implemented using servlets and JSPs, it can
work with any servlet-enabled web application server by assembling and deploying JReport Server as a
Web Application Archive (WAR) or Enterprise Application Archive (EAR).

There is a separate chapter about integration with different application servers - Integrating JReport
Server with a Java Application Server. It provides a general method for creating the deployable archive
and detailed procedures for deploying the archive into some popular application servers.
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Basic Concepts

This chapter gives you some basic JReport Server concepts. You can first go through this chapter to
gain a general understanding about JReport Server before you use it. Also, while you are using JReport
Server, if you do not understand any of the basic concepts, you can refer to this chapter to get help.

This chapter discusses the following JReport Server main concepts:

Background tasks

Scheduling

Resource

Version

Security

Integration

JReport Server Cluster
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Background tasks

JReport Server provides a background running system, which shows the status information of tasks
submitted using the Run, Advanced Run, or Background Run mode. Status information includes: report
name, report path and name, catalog path and name, running format, time when the task is started/
completed, time elapsed since the task is performed, and the status of the task. It allows you to view
detailed information in a timely fashion.

The records saved in the background running system are cleared under the following conditions:
. JReport Server is restarted.

. The maximum time limit specified for the report result life has been reached. By default it is 86400
seconds (24 hours).

. The maximum time limit specified for the interval between a user logout and login has been reached.
By default it is 300 seconds.

. If the number of records exceeds the number specified for the background task list (by default it is
100 records), the latest 100 records will be retained.
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Scheduling

JReport Server provides a scheduling system which you can customize to suit your requirements. You
can submit a scheduled task from web page and URL or by calling the Server APl methods. However,
before you can do this, you must first specify the report, catalog, task type and its launch type. In
addition, you can also customize notification messages to notify others of whether or not the task is
executed successfully.

User Task

In order to provide the means to run tasks defined outside of JReport on JReport Server, and to just
use JReport Server's schedule function, JReport provides a task named User Task. With this task, you
can implement a customized task with the schedule properties. Also, you can submit the user task from
a web page, or by calling JReport Server APl methods.

After creating a class that implements the UserTask interface in the jet.server.api package and adding
the class to the class path, you can then submit the task either from a server web page or by calling
Server APl methods. The task can then be run by the server at the scheduled times just as if it were a
report.

Trigger

The scheduling mechanism supports trigger conditions in addition to time conditions. Triggers are
managed by name in JReport Server, so each trigger must have a unique name. After creating a
trigger, you can submit a task that is bound with the trigger, and then fire the trigger to activate the
task at anytime.

Trigger conditions are based on event driven modes. The server does not care whether a customized
condition is ready. It only waits there for trigger firing events. Therefore, you determine whether the
condition is ready before firing a trigger.

Triggers can also work together with time conditions for activating a scheduled task.

Related topics:

. Scheduling reports
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Resource

JReport Server provides a resource system for managing a group of archive versions that can be processed or organized.

What is a resource

Generally, a resource refers to report or dashboard related material. To be exact, a resource in the JReport Server
reporting system is a conceptual node. There are different types of resources, such as catalogs, reports, dashboards,
library components, and their results. A resource can only hold versions of the same type.

Resource tree

All the resources are organized in a folder-tree structure. JReport Server defines an XML file called admin.xml, and the
resource tree conforms to this file. This file is maintained automatically by JReport Server.

For example, your company has two departments - Support and Marketing. Each department has its reports on their own
machine. There are some report documents that are submitted by the departments located on the machine where JReport
Server runs. Now, suppose you are the administrator, and you would like to organize these files and folders into the
Resource Tree. The following diagram may help you to figure out the framework on which you should build the resource
tree.

Resource Tree Root

| M}rCnm:pnnents I | Public Cu:mpunents I | Public :Repurh I | My RE:pDI'tS I
¥ ¥™ ¥ ¥

| Sales Dept. I | Marketing Dept. I | Support Dept. I

| Yersions h | Yersions h | ¥Yersions H Yersions H Yersions h| Yersions h| Yersions i

Resource Tree Structure

O] Folder O rResource [ Archive

The resource tree consists of the following three layers:

. Folder layer: Basic resource tree element that builds the main framework for the resource tree. There are four built-in
folders in the root of the resource tree - My Components, Public Components, My Reports, and Public Reports. A folder
can be mapped to a real file path.

. Resource layer: An abstract layer, based on the Folder layer that hosts various types of archive versions and provides
user access to the versions.

. Archive layer: A concrete layer, where the archive versions reside for executable resources, which function as the
leaves of the resource tree.

Public Reports and My Reports

Public Reports and My Report are two built-in folders in the resource tree root for storing resources such as reports,
dashboards and Visual Analysis templates. You can create your own folders in either of them. The Public Reports folder
and the My Reports folder cannot be deleted.

The Public Reports folder contains public resources, and can be accessed by everyone.

The My Reports folder is a personal folder. It contains personal resources. Each user has one personal folder, specified by
the administrator when the user account is created. The My Reports folder can only be accessed by its owner, and the
user has full control over his/her personal folder. This folder is the default output location for resources run by the user.

Reports

There are two types of reports in JReport: page reports and web reports. A page report is a collection of report tabs and
each report tab can have multiple pages, while a web report has no report tabs and is always displayed as a web layout
report with just one page.

JReport Server supports viewing, advanced running and scheduling of reports. The background run/scheduled/active/
completed record are based on report level.

On JReport Server, you can also create page reports with Page Report Studio and web reports with Web Report Studio.

Dashboards

Dashboards, created using JDashboard, allow you to see the big picture by comparing charts, tables, and other
components side-by-side.

Visual Analysis templates

Visual Analysis templates are the data status saved via Visual Analysis.

Public Components and My Components

Public Components and My Components are two built-in folders in the resource tree root for storing library components.
Their behaviors resemble the Public Reports and My Reports folders.

The Public Components folder contains public components and can be accessed by everyone. The My Components folder is
a personal folder that contains personal components for each dashboard user.

Library components

Library components are used to build dashboards. They are able to present data via intuitive components such as charts,
crosstabs, tables, and geographic maps. Library components are created and edited using JReport Designer, and then are
published to the component library on JReport Server for use in dashboards.

Related topics:

. Managing resources
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Version

JReport Server provides a versioning system for controlling the resources contained in the resource
tree. To understand what the versioning system is, first you have to understand the resource
mechanism in JReport Server. A resource in the JReport reporting system is a conceptual node, which
holds a group of archive versions that can be processed or organized in JReport Server. Information of
these versions is stored in the System DB database that JReport Server uses, while version files are
saved in the directory - <report honme>\ hi story.

What is a version

All the server resources in the resource tree are controlled by versions. A version is the fundamental
unit of the resource tree, and your resources might change over time. JReport Server uses a versioning
system to create and manage resources that have changed in content and properties owing to updates
issued upon them.

All the resources in the resource tree have versions. A large portion of resource management tasks are
done by managing resource versions.

Different version types
The versions in JReport Server fall into the following major categories:

. Catalog Version
The version of a catalog file.

. Report Version
The version of a report file.

. Report Result Version
The version of a report result file.

The report result can be generated and maintained in two places - the resource tree and the built-in
version folder.

When you advanced run or schedule a report to publish to the versioning system, you can choose an
archive location to generate the report result. You can generate the report result in the built-in
version folder, the My Reports folder or the Public Reports folder in the resource tree.

The report results generated in the resource tree are standalone results and can have their own
versions, while those generated in the built-in version folder can only be bound with their respective
reports.

. Dashboard Version
The version of a dashboard file.

. Library Component Version
The version of a library component file.

Real path of versions

If you check the property of a version, you will find its real path. Remember that version information is
stored to a database, and version files are stored in the directory <r eport honme>\ hi st ory. For the

report InvoiceReport.cls, the report version's real path is <r eport home>\ hi story\ 1
\ JReport _Syst em User 894485281\ | nvoi ceReport . cl s, which is the actual report result path on disk

and stored in the server database. That is, when you click the InvoiceReport.cls report result resource
on the server interface, you are accessing it on the disk, only the path to it is stored in the database.
And this works the same for the other types of versions.

Archive policy

JReport Server uses an archive policy to control the resource versions. You can control whether or not
to use multiple versions for a specific resource. Also, you can define the maximum number of versions
that can be listed in the version table.

The archive policy can be applied to a single resource individually, or to many resources in a folder as a
whole.

Related topics:

. Managing versions
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Security

JReport Server provides a security system for setting up and maintaining security on it, allowing you to
protect your resources from inappropriate access by other users.

To help you understand security in detail, the following security features with their concepts are
described below:

Realm

A realm is an abstract security concept, which hosts the resources and authentication entities on
JReport Server. There can be more than one realm on the server and each realm is independent from
others. The resources and authentication entities that reside in different realms are different.

At runtime, only one realm can be active and only the users and resources in the active realm are
accessible. A realm is identified by a unique name, which can contain any characters other than
forward slash (/) and backward slash (\).

The authentication entities consist of user accounts, group accounts and role accounts.

User

To use JReport Server, you must have a user account, which consists of a unique user name and
password. JReport Server verifies your identity when you type your user name and password and then
logs you on. If your user account has been disabled or deleted, JReport Server prevents you from
accessing the services that JReport Server provides, in order to ensure that only valid users have
access.

JReport Server comes with two built-in user accounts, which are admin and guest. The built-in user
accounts cannot be deleted. The admin user account can neither be deleted nor disabled.

Group

The principal group, which represents an organization of user accounts, is available for managing
users. Users or groups can then be added into a group as its child members, and therefore inherit the
resource and folder permissions from the group.

Role

Users must have certain user rights and permissions in order to perform tasks on resources. Roles,
which represent an aggregate of permissions, help you to efficiently assign the appropriate user rights
and permissions to users. Assigning roles to users gives them the user rights and permissions that they
require to perform their jobs with. A role can also be assigned to other groups or roles, and thus
groups or roles can inherit the permissions of other roles.

JReport Server comes with two built-in role accounts, which are administrators and everyone. The built-
in role accounts cannot be deleted. The administrator role account can neither be deleted nor disabled.

Permission

Permissions, associated with resources and folders which locate in the Public Reports or Public
Components folder, are the rules that are granted to users to control their access to resources and
folders.

Permissions in JReport Server include:

Permission Description

Visible Allows or denies viewing object names in the resource tree or version table, such as
folders, resources, and archive versions.

Read Allows or denies viewing object properties, versions, and, if it is a folder, folder
contents.

Write Allows or denies publishing folders and resources, changing the properties (not

including permission settings) of the objects in the resource tree or version table, such
as folders, resources, and archive versions, and modifying version table settings.

Execute Allows or denies running reports in normal and Advanced mode (for report type
resources only) or running dashboards in the view mode (for dashboard type resources
only) or opening Visual Analysis templates in Visual Analysis (for analysis type
resources only).

Edit Allows or denies running dashboards in the edit mode (for dashboard type resources
only).

Schedule Allows or denies submitting resources to schedules (for report type resources only).

Delete Allows or denies deleting objects in the resource tree or version table, such as folders,

resources, and archive versions.

Grant Allows or denies granting permissions to other users, groups or roles. Users, groups or
roles that have obtained the Grant permission are also endowed with the other
permissions, and can grant these permissions except the Grant permission itself.

Update Allows or denies updating report status, and if it is a folder, the status of reports in the
Status folder.
Privilege

Privilege is a mode which manages permissions. It can be used to manage different access permissions
unrelated with nodes. Privilege of JReport Server manages the following access permissions for users:

. Publish
The privilege of publishing resources to JReport Server.

. Advanced properties
The privilege of viewing advanced information of version properties such as catalog connections and
report related resources.

Alias

JReport Server organizes files and directories into a Resource Tree. Aliases are used to provide different
"views" of the tree for different users. For example, you may set an alias resource tree (based on the
resource tree) for Tanya, so that she can only see the marketing resource node and can directly enter
into the report folder she is interested in. An alias is a combination of users and resource nodes.

Organization

JReport Server administrator can organize users into different organizations. An organization is a group
of users, groups, and roles that has its own administrator. The organization administrator can define
which users can use which dynamic connections within the organization.

Related topics:

. JReport Security System

. Managing security
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Integration

JReport Server can be seamlessly integrated with any other Java application server to meet the
information delivery needs of a single department or an entire enterprise. It contains a rich set of APIs
that allow for seamless integration and is implemented using Java Servlet technology and Java Server
Page (JSP). These servlets and JSP pages enable the user to work with any Java EE compliant

application server that supports a Servlet Container and administer the JReport Server remotely
through a web browser.

Related topics:

. Integrating JReport Server with a Java Application Server
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JReport Server Cluster

A JReport Server Cluster is a distributed cluster in which a group of servers work together to provide
cluster-wide shared resources, security, schedules and version services. In a JReport Server Cluster, all
clustered servers play exactly the same role and any one can exit from the cluster any time.

The JReport Server Cluster provides the following major benefits:
. Manageability: All users and resources can be controlled from a clustered server, remotely.

. High-Availability: When one server fails to perform, the tasks running on it will be re-allocated to
other servers. If a server has already been fully utilized, the tasks sent to it will be allocated to the
other servers.

. Scaleable: You can add or remove servers dynamically according to your needs.

There are many nodes (clustered servers) in a JReport Server Cluster. Every clustered server has the
same responsibility. You can set a clustered server to perform a specific role in a JReport Server Cluster
by configuring its properties.

Related topics:

. JReport Server Cluster
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Accessing JReport Server

You can access JReport Server through a web browser such as Internet Explorer, Firefox, or Google
Chrome.

Starting and logging onto JReport Server

To log onto JReport Server, first start the server via one of the following ways:

. Double-click the JReport Server 13.5 Update 2 shortcut on your desktop.
. Click Start > All Programs > JReport 13.5 Update 2 > Start Server.

. Run the JRServer.bat/JRServer.sh file located in <i nstal | _r oot >\ bi n.

. Run the startup file from a command prompt or shell. For example, assume that JReport Server has
been installed in C.\ JReport\ Server on Windows or / opt/ JReport/ Server on Linux, you can type

the following commands:

C.\>cd JReport\Server\bin
C.\ JReport\ Server\ bi n>JRSer ver . bat

$cd /opt/JReport/ Server/bin
$./ JRServer. sh

Then,
. To access the JReport Console page:

1. Open a web browser and set the URL to http://i p_or_host nane: port (by default, the port for
accessing the JReport Console page is 8888).

2. On the welcome page, type your user name and password as assigned by your administrator.
For first time users, the default user name and password are admin.

3. Click Login and the JReport Console page will be displayed.

. To access the JReport Administration page:

1. Click Start > All Programs > JReport 13.5 Update 2 > System Admin, or open a web
browser and set the URL to http://i p_or_host nane: port (by default, the port for accessing

the JReport Administration page is 8889).

2. In the Sign in dialog, type your user name and password as assigned by the administrator. For
first time users, the default user name and password are admin.

3. Click Login and the JReport Administration page will be displayed.

Tip: If you don't know the IP address of the machine on which the server runs, and if it is the same
machine where you run JReport Server, you can use localhost instead of the IP address. You can also
open a console window such as telnet on the server machine and type hostname, then the name of
the host will be displayed.

Fast launch pad for local users

Local users can also access JReport Server in a fast way with the launch pad, which is a convenient
entry to access the server without having to start it. The launch pad provides some key functions of
JReport Server by setting up the connections to corresponding JReport Server JSPs, which are:

. Creating dashboards, reports and Visual Analysis

. Viewing the JReport sample reports

. Scheduling to run reports by time or event

. Managing security principals

. Configuring server profiles to customize the server interface and functionality
. Viewing the product demos

To access the launch pad, click Start > All Programs > JReport 13.5 Update 2 > Launch Pad.

Additional login channel for admin users

JReport Server provides a special channel that automatically creates an extra user session for
management purposes if the license limit of the maximum number of concurrent users has been
reached. The extra user session cannot be used to run reports or submit schedules. It can only be used
by admin users for performing management operations. If your JReport Server license has a bounded
limit to the maximum number of concurrent users, this feature will take effect.

Only one extra valid user session can be created and used within this special channel at any time. If an
extra user session has already been created and it is still valid, your request for login will be prompted
with a confirmation page asking you whether or not to close the existing extra user session. If you
select Yes, a new extra user session will be created for you to perform management operations.
Otherwise, you will not be allowed to log onto JReport Server.

Note: If all normal user sessions have been used up, a request from a client viewer will be denied
permission to log onto JReport Server. Only a normal user session can use a client viewer to log onto
JReport Server, not the extra user session.

Logging off and shutting down JReport Server

To log off JReport Server, click the Logout link on the upper right corner of the JReport Administration/
Console page.

To shut down JReport Server normally:

. In a standalone environment, click the Shut Down the Server button on the JReport
Administration page, or click Start > All Programs > JReport 13.5 Update 2 > Stop Server.

. In an integrated environment, shut down the application server according to the vendor's
instructions.

Also, JReport provides a feature for handling an abnormal system exit that enables the program to
close itself gracefully when the Java virtual machine (JVM) is terminated in response to a user
interrupt, such as typing ™C, or a system-wide event such as user logoff or system shutdown.

SSL in standalone JReport Server

JReport Server supports HTTPS requests in standalone mode. Secure ports for HTTPS requests should
use different ports from non-secure ports for HTTP requests. By default, port 6888 and 6889 are set as
the secure ports separately for accessing JReport Console Ul and JReport Administration Ul. The URL
for visiting JReport Server via HTTPS schema is like this:

https://1P_address or |ocal host: 6888

SSL support is disabled by default. You need to enable it and configure corresponding settings in order
to use HTTPS schema to visit JReport Server Ul. This can be done either on the JReport Administration
page or in the server.properties file located in the <i nstal | _r oot >\ bi n directory.

To enable SSL function via the administration Ul:

1. Log onto the JReport Administration page. The default port is 8889.

2. Click Configuration on the system toolbar, and then select Service from the drop-down menu.
3. Check the Enable Secure Socket Layer Connection option.
4

Make sure that Secure Port and Secure Administration Port use different port numbers from Port
and Administration Port.

5. Specify the other settings about Keystore.

6. Click Save.
7. Restart JReport Server in order for the settings to take effect.
To enable SSL function in the server.properties file:
1. Open the server.properties file located in the <i nstal | _r oot >\ bi n directory.
2. Set httpserver.ssl.enable to true.
3. Set the other properties starting with httpserver.ssl to meet your requirements.
4. Save the server.properties file.
5. Restart JReport Server in order for the settings to take effect.

Notes:

. JReport does not provide a keystore file since Jinfonet is not a trusted certificate authority and just
provides a Keystore File Path option for you to configure the location of your trusted keystore file.
There are many trusted authorities that can provide keystore files. Here is an example of creating a
keystore file: http://docs.oracle.com/cd/E19509-01/820-3503/ggsxx/index.html.

. JReport Server Monitor does not support SSL.
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Working with Reports

After successfully logging onto the JReport Console page using the user name and password assigned

by your administrator via a web browser, you can then perform tasks according to your requirements.
For example, you can view reports in different formats and schedule tasks for the reports.

Pick a task from the following:

. Running reports

. Scheduling reports

. Specifying parameter values

. Using JSPs to print page reports

Related topics:

. Managing resources

. Managing versions

. Managing tasks

Tip: You can customize the JReport Console > Resources page to suit your requirements by setting
your own preferences. To do this, click Tools > Preferences on the task bar of the Resources page,
then specify the settings in the Preferences dialog as required. For example, you can specify the default
viewing format when directly run a report from this page, set which columns will be shown in the
resource information table, and predefine the properties for each export format which will be applied

when you run or schedule a report on this page.
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Running reports

If you know the default format for viewing reports and this format is what you expect, use direct
running. If you would like a different view format or to customize some other information such as

parameter values, the running priority, how to save the result, the expiration time, and so on, use
advanced running.

Direct running

Direct running reports is to use the default format setting to view the report result. For page reports
(for example, .cls) the default format is Page Report and they will run in Page Report Studio. For web
reports (.wls) they will be opened in Web Report Studio by default.

If the reports are created on JReport Server, the default format is controlled by the Default Format for
Viewing Report option in the Profile > Customize Server Preferences > General tab. When this option is
set to Page Report or Applet, web reports will run in Web Report Studio by default.

If the reports are created using JReport Designer, the default format is controlled by the Default
Format for Viewing Report property in the Report Inspector. If this property is set to <Server Setting>,
the viewing format will be determined by the above setting on server. For page reports this property is
available to each report tab in the reports, while for web reports it is available to each report.

Since a page report can contain multiple report tabs and these report tabs may have different default
format settings, for example, report tab 1 is Page Report, tab 2 HTML and tab 3 Excel. In this case,
there will be different direct running results according to which report tab is the last-time focused tab in
the page report when the page report is saved at report design time. If it is report tab 1, all the tabs in
the page report will be opened in Page Report Studio. If it is report tab 2 or 3, only tab 2 or 3 will be
displayed in the specified format, and this applies to all the other formats except Page Report.

To directly run a report, on the JReport Console > Resources page, browse to the report, then do one
of the following:

. Click the name of the report in the Name column of the Resources page.
. Select the report row and click Run > Run on the task bar of the Resources page.

. Select the report row, right-click in the row and select Run from the shortcut menu.
b

Then, if the report contains parameters, the Enter Parameter Values dialog will be displayed. Specify
the parameter values according to your requirements.

. Put the mouse pointer over the report row and click the Run button on the floating toolbar.

Advanced running

1. On the JReport Console > Resources page, browse to the report you want to run.

2. Do either of the following to open the Advanced Run dialog.

o Select the report row, then on the task bar of the Resources page, click Run > Advanced Run.

o Select the report row, right-click in the row and select Advanced Run from the shortcut menu.

1

o Put the mouse pointer over the report row and click the Advanced Run button ™ on the
floating toolbar.

3. In the General tab, for a page report, select the report tabs in the page report you want to run. If
there are multiple dynamic connections available, expand the Select Dynamic Connection
section and select a connection from the drop-down list. Click Connection Properties to view the
connection information if needed. Then, specify the other options as required.

4. In the Parameter tab, specify the parameter values if the report has parameters.

5. In the Format tab, choose a format to view the report result, and set the other settings.

6. In the Archive tab, archive the report result version according to your requirements.

7. If you want to limit the amount of time that the report is allowed to run, in the Duration tab,
specify a time duration for the task, and ask JReport Server to cancel the task or to notify you or
someone else of the task status via e-mail if the task has not yet finished running when the task
duration is up. For detailed information, see Task-level timeout for advanced run and schedule

tasks.

8. Click Finish to view the report in the format you specified.

When running a page report in Page Report Studio, the report processing page will appear, on
which you can choose to cancel the running of the report, or to make the report run in background
mode. Click Cancel on this page if you decide to cancel, Background if you want the report to
run in background mode, or just wait for processing to complete. If you cancel the report from
running, you can choose whether to cancel the running query used by the report in the database
at the same time by configuring the JdbcDriversConfig.properties file. For details, refer to
Canceling running query.

Notes:

. If you choose to view a page report in Page Report format, besides the selected report tab, all the
other tabs in the report will also be run.

. When you run a report in Advanced mode in HTML format, the names of page navigation links in the
report, such as First, Previous, Next, and Last, can be localized according to your requirements. For
details, refer to Localizing page navigation links in HTML report outputs.

. When you run a report in Advanced mode in Applet format or in HTML format with Applet Chart is
checked for it using Google Chrome, the report can run correctly only when NPAPI is enabled for the
web browser. To do this, you need to type chrome://flags/ in the address bar of the web browser,
then scroll down and set Enable NPAPI Mac, Windows to Enable.

. By default, the Duration tab is not displayed in the Advanced Run dialog. To make it available, the
Enable Task Duration option on the JReport Administration page > Configuration > Advanced panel
must be checked.

Running a page report in background mode

When you run a report in Page Report Studio, if the report contains a large amount of data, you need
to wait several minutes before the report result is displayed, and during this period, you have to remain
on the report processing page, or choose to cancel the run. Now JReport enables you to switch running
page reports to background mode.

To make a report running in Page Report Studio to run in background mode, on the report processing
page, click the Background button.

You can also specify to run page reports automatically in background mode after a specified time
period by setting preferences. To do this:

1. On the JReport Administration page, click Profile on the system toolbar and then select
Customize Profile from the drop-down menu. Or on the JReport Console page, click Profile on
the system toolbar, then click Customize Profile on the task bar of the Profile page.

2. Click the Page Report Studio > Properties > Advanced tab.

3. Check Background Mode Timeout and specify the time allowed for a page report to run in
foreground mode.

4. Save the settings, then when a report runs in Page Report Studio and the results have not yet
been generated after the specified time, it will be automatically switched to run in background
mode.

Reports running in background mode are listed in the Background Tasks table of the My Tasks page,
which shows detailed running information of the reports, such as report path and name, catalog path
and name, running format, time when the task is started/completed, and so on. Also, you can control
the status of the reports running in background mode according to your requirements. For example,
you can choose to delete, stop, or restart tasks (for details, see Managing tasks in the task tables).

When a report completes running in background, you can open it from the Background Tasks table, and
once the report is opened, the task will automatically be removed from the table.
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Scheduling reports

JReport Server can run reports at a specified time or periodically by scheduling tasks for reports. The
scheduled tasks will be recorded by the server according to their different executing status.

Pick a topic from the following for details about how to schedule tasks in JReport Server:

. Scheduling reports with dialog

. Scheduling a task containing a bursting report

. Scheduling a customized task using User Task

. Recording scheduled tasks

. Viewing scheduled report result

. Importing and exporting scheduled tasks

. Adding TaskListener

Notes:

. When you schedule to publish a report to Page Report Result format, if the report is linked to
another report, in the Page Report Result file, the link will no longer be supported, and if you
schedule to publish the report to several formats and Page Report Result format is included at the
same time, the link will not be available in the other format outputs either.

. When you schedule to publish a report to HTML format, the names of page navigation links in the
report, such as First, Previous, Next, and Last, can be localized according to your requirements. For
details, refer to Localizing the page navigation links in HTML report outputs.
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Scheduling reports with dialog

You can schedule tasks for a specified report with dialog as follows:

1.

Do either of the following to open the Schedule dialog.

o On the JReport Console > Resources page, browse to the report you want to schedule to run,
then:

« Select the report row, then on the task bar of the Resources page, click Run > Schedule.

« Select the report row, right-click in the row and select Schedule from the shortcut menu.

.-'_L'H.
« Put the mouse pointer over the report row and click the Schedule button ~ on the floating
toolbar.

o On the JReport Console page, click My Tasks on the system toolbar, then select the Scheduled
tab. Click New Schedule on the task bar of the My Tasks page, then in the New Schedule
dialog, check the Select Report to Create Schedule radio button, specify the folder and then
the catalog in which the report you want to schedule to run is saved, then select the report and
click OK.

In the General tab, specify the name for the task in the Schedule Name text box. For a page
report, you need to select the report tabs you want to run from the page report. You can choose
multiple normal report tabs or one bursting report at a time (for scheduling a bursting report, see
Scheduling a task containing a bursting report). When multiple normal report tabs are selected,

check Export to One File if you want to export them to just one result file. If there are multiple
dynamic connections available, expand the Select Dynamic Connection section and select a
connection from the drop-down list. Click Connection Properties to view the connection
information if needed. Then, specify the other options as required.

In the Parameter tab, specify the parameter values if the report has parameters.

In the Publish tab, specify the type of the task.

Six task types are provided by JReport Server: To Version, To Disk, To E-mail, To Printer, To Fax
and To FTP. Choose the type you want to publish, and then set the settings for the specified type.

In the Conditions tab, specify the time for when the task is to be performed in the Time sub tab,
and select or create a trigger to bind with the task in the Trigger sub tab.

In the Notification tab, specify to notify someone via e-mail of when the task is finished and
whether it is successful or unsuccessful.

7. In the Duration tab, specify a time duration for the task, and ask JReport Server to cancel the task
or to notify you or someone else of the task status via e-mail if the task has not yet finished
running when the task duration is up. For detailed information, see Task-level timeout for
advanced run and schedule tasks.

8. Click Finish, and JReport Server will then perform the task.

Notes:

By default, the Duration tab is not displayed in the Schedule dialog. To make it available, the Enable
Task Duration option on the JReport Administration page > Configuration > Advanced panel must be
checked.

When scheduling to publish a page report to the versioning system or to disk, the Page Report Result
and JReport Result formats are based on the report level, that is, the report with all selected report
tabs will be output to a single file. As for the other formats, each selected report tab will be output to
a separate file.

The following are some specific scheduling examples:

Example 1: Publishing a report to the versioning system

Example 2: Publishing a report to disk

Example 3: Publishing a report to e-mail

Example 4: Publishing a report to printer

Example 5: Publishing a report to fax

Example 6: Publishing a report to an FTP site
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Example 1: Publishing a report to the versioning system

In this example, a task is set up and will be performed immediately. The generated result is asked to
be kept for 30 days.

1. On the JReport Console > Resources page, select the report row, right-click in the row and select
Schedule from the shortcut menu to display the Schedule dialog.

2. In the General tab,

a.

b.

m.

Specify a name for the task in the Schedule Name text box.

For a page report that contains multiple report tabs, you need to select the report tabs you
want to run from the page report in the Select Report Tabs section. Change the reports tabs
order using the Move Up or Move Down button. Check the Export to One File option if
you want to export the selected report tabs to one result file.

If there are multiple dynamic connections available, expand the Select Dynamic

Connection section and select a connection from the drop-down list. Click Connection
Properties to view the connection information if needed.

Expand the Report Information section, click Select Another Catalog to specify another
catalog for the report if required.

. Select the report version and catalog version from the corresponding drop-down lists.

Assign a priority to the task from the Priority drop-down list.

Expand the Advanced section, if the report has a style group, check the Enable Style
Group checkbox and choose the style group.

. Check the Enable Converting Encoding option if required and specify the encoding before

and after converting from the corresponding drop-down lists.

If Enable NLS is available, you can select it and then specify a language to display the report
contents with.

Define the encoding for the report by selecting from the drop-down list.

Check Use the default DB user and password defined in catalog.

. Check the Add TaskListener to be Invoked option, and input the class name (for details,

see Adding TaskListener).

Check the Enable Auto Recover Task option to specify auto recovering settings.

3. In the Parameter tab, specify the parameter values as required if the report has parameters.

4. In the Publish tab,

a.
b.

C.

d.

e.

Click the To Version sub tab, then check Publish to Versioning System.
Select the required formats and set the format settings.

Check the Built-in Version Folder option in Archive Location to save the report result
version in the built-in version folder.

Set O for the Maximum Number of Versions.

Check the Result Auto-delete option and define the result to expire in 30 days.

5. In the Conditions tab, select the Time sub tab, define the time zone from the Time Zone drop-
down list, then from the Time Type drop-down list, choose Run this task immediately.

6. If you want to notify someone of when the task is finished by sending an e-mail, go to the
Notification tab and then set the settings.

7. If you want to specify a timeout for the task, specify the settings in the Duration tab as required.

8. Click Finish to have the task performed.

Then, click My Tasks on the system toolbar. While the task is being performed, you can see a record
of it in the Running tab. On completion it will be put into the Completed tab.

Notes:

. When publishing a report to XML format, if you want to use the URL to get the .xsd file, follow the
steps below:

1. Put the existing XML schema file in <intal | _root >\ public_htm .

2. Input http://1P address: 8888/ nane of the existing XML schema file.

. There is another way to publish the report result to version. If you have set the property server.
version.from.temp to true in the server.properties file in <i nst al | _r oot >\ bi n, or selected the option
Enable "Publish to Versioning System" for Background Tasks View on the JReport Administration page
> Configuration > Advanced panel, you will get the link Publish to Version System on the system
toolbar of the JReport Console page. Click the link to publish the result to version.
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Example 2: Publishing a report to disk

In this example, you will learn how to set up a task to publish the report result in various file formats to
the file system repeatedly at the start of each month.

1. Take steps 1, 2, 3 as in Example 1.

2. In the Publish tab of the Schedule dialog, click the To Disk sub tab, select the required format,
specify the result location, and set the format settings according to your requirements.

3. In the Conditions tab,

a. In the Time sub tab, define the time zone from the Time Zone drop-down list, then from the
Time Type drop-down list, choose Run this task periodically.

b. In the Duration box, specify a time period for when the task will be performed.

c. Select Monthly from the Date drop-down list and keep the default to run the first day of
every 1 month.

d. Keep the Time settings as default.

e. If you also want to set an event which needs to occur before running the report, select a
trigger to bind with the task from the Select a trigger to bind drop-down list in the Trigger
sub tab, then specify the trigger logic with time condition.

For detailed information about the logic between the trigger condition and the time condition,
see Trigger tab.

4. If you want to notify someone of when the task is finished by sending an e-mail, go to the
Notification tab and set the settings.

5. If you want to specify a timeout for when the scheduled report will be allowed to run, specify the
settings in the Duration tab as required.

6. Click Finish to have the task performed.

Then, click My Tasks on the system toolbar, you will see that the scheduled task has been recorded in
the Scheduled tab. Since you have not specified the duration Run until a time for this task, it will not
stop being performed until you delete or disable it from the Scheduled tab.

Notes:

. When you specify to publish the report result to the server resource tree, if the specified folder has a
real path, the result will be put to the real path. Otherwise it will be put to the default disk location

where server resources are.

. If you specify to publish the report result to a non-existent folder on disk, JReport Server will
automatically create it.

. If you use a fixed name to perform the task periodically, only the most recently generated report
result will be kept. In order to keep the report result generated every time, you should use the
dynamic result file name. Similarly, you are able to input the dynamic directory path to avoid report
management difficulties, since when a fixed directory path is specified, too many results may be
generated in one directory. For more information, see Appendix 5: Dynamic names.

G



G

Example 3: Publishing a report to e-mail

In this example, you will learn how to set up a task to publish the report result to e-mail.

1.

2.

5.
6.

Take steps 1, 2, 3 as in Example 1.

In the Publish tab of the Schedule dialog, click the To E-mail sub tab, then from the Mail To list,

select to whom the report result will be sent. If required, click the Edit button to edit the specified
e-mail.

If you want to create another e-mail, click the New button, then fill in every field, select the
format in which you want to export the report result and set the settings according to your
requirements. When you choose to specify a report result as an attachment to e-mail, you need to
specify a file name for the attachment. For details about settings of creating a new e-mail, refer to
Schedule dialog - To E-mail.

In the Conditions tab, select the Time sub tab, define the time zone from the Time Zone drop-
down list, then from the Time Type drop-down list, choose Run this task immediately.

If you want to notify someone of when the task is finished by sending an e-mail, go to the
Notification tab and set the settings.

If you want to specify a timeout for the task, specify the settings in the Duration tab as required.

Click Finish to have the task performed.

Then, click My Tasks on the system toolbar. When the task is being performed, you can see a record
of it in the Running tab and on completion it will be put into the Completed tab.
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Example 4: Publishing a report to printer
In this example, you will learn how to set up a task to publish the report result to a printer.
1. Take steps 1, 2, 3 as in Example 1.
2. In the Publish tab of the Schedule dialog,
a. Select the To Printer sub tab and then check Publish to Printer.
b. Select a JDK print method for the report result in the Select Print Method field.
c. Type a name with the path of the printer in the Printer field.

3. In the Conditions tab, select the Time sub tab, define the time zone from the Time Zone drop-
down list, then from the Time Type drop-down list of the Time tab, choose Run this task
immediately.

4. If you want to notify someone of when the task is finished by sending an e-mail, go to the
Notification tab and set the settings.

5. If you want to specify a timeout for the task, specify the settings in the Duration tab as required.
6. Click Finish to have the task performed.

Then, click My Tasks on the system toolbar. When the task is being performed, you can see a record
of it in the Running tab and on completion it will be put into the Completed tab.

Note: When there is no printer connected with JReport Server, and you schedule to publish a report to
a printer, the server may crash or throw an exception.
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Example 5: Publishing a report to fax

In this example, you will learn how to set up a task to publish the report result to fax. Before you can
fax the report result, you must first have your modem configured. Otherwise a warning message will be
displayed when you try to export to fax.

1.

2.

5.
6.

Take steps 1, 2, 3 as in Example 1.

In the Publish tab of the Schedule dialog, click the To Fax sub tab, check the Publish to Fax
option and then fill in every field and set the settings according to your requirements.

In the Conditions tab, select the Time sub tab, define the time zone from the Time Zone drop-
down list, then from the Time Type drop-down list, choose Run this task immediately.

If you want to notify someone of when the task is finished by sending an e-mail, go to the
Notification tab and set the settings.

If you want to specify a timeout for the task, specify the settings in the Duration tab as required.

Click Finish to have the task performed.

Then, click My Tasks on the system toolbar. When the task is being performed, you can see a record
of it in the Running tab and on completion it will be put into the Completed tab.
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Example 6: Publishing a report to an FTP site

In this example, you will learn how to set up a task to publish the report result to an FTP site.

1.

2.

5.
6.

Take steps 1, 2, 3 as in Example 1.

In the Publish tab of the Schedule dialog,

a. Click the To FTP sub tab, then click the New button to set up a new FTP site or click the Edit
button to edit a specified FTP site in the FTP To list.

b. Fill in every field, select the format in which you want to send the report result and then set
the settings according to your requirements.

In the Conditions tab, select the Time sub tab, define the time zone from the Time Zone drop-
down list, then from the Time Type drop-down list, choose Run this task immediately.

If you want to notify someone of when the task is finished by sending an e-mail, go to the
Notification tab and set the settings.

If you want to specify a timeout for the task, specify the settings in the Duration tab as required.

Click Finish to have the task performed.

Then, click My Tasks on the system toolbar. When the task is being performed, you can see a record
of it in the Running tab and on completion it will be put into the Completed tab.

Note: Dynamic result name for FTP task is currently not supported.
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Scheduling a task containing a bursting report

In a large enterprise reporting deployment, it is important to handle both large amounts of data as well
as a large number of users. Report bursting enables running a report once and distributing the report
result to multiple recipients who each will receive a subset of the report result.

Bursting reports can be distributed to e-mail or FTP addresses, to disk, to the JReport versioning
system, or to the security system members such as users, groups, and roles.

End users can submit a schedule task which contains only one bursting report to JReport Server. When
a bursting task is activated, it will create a main bursting task and some sub bursting tasks. The
system will guarantee bursting tasks compete with normal tasks for system resources. The bursting
tasks can be given lower priority if desired (set queue.policy to 1).

. Main bursting task: It is responsible for getting/splitting data and distributing work to the sub
tasks. There can be only one main bursting task for a sub bursting task.

. Sub bursting task: It is responsible for generating the report result according to split data and
sending the result to the address of the bursting recipient.

On JReport Server, direct running and advanced running actions are supported for normal reports but
not bursting reports. A report containing only bursting report tabs cannot be run directly or in
Advanced mode, it must be scheduled.

Scheduling is supported for both types of reports excluding the combination of the two types: for
normal reports, multiple reports can be scheduled at a time; however for bursting reports, only one can
be scheduled. For a scheduled bursting task, seven kinds of result file formats are supported: HTML,
PDF, Excel, Text, RTF, XML, and PostScript. In addition, when scheduling to run a bursting report, you
can make it generate not only the bursting result by applying bursting schemas but also the non-
bursting result based on whole data without data splitting.

Scheduling a bursting report to generate bursting result

Though a bursting report may have one or more bursting schemas, you need apply one or more of
them in order to get a bursting result. To do this, select a bursting report and schemas, and then
specify required parameter values in the General tab of the Schedule dialog. Then a tab named
Bursting Result is displayed in the Publish tab and only the corresponding sub tabs that are defined in
the selected bursting schemas’ recipients in JReport Designer are available. For example, a bursting
report has three bursting schemas: Schema 1 defines recipient E-mail and Disk, Schema 2 defines
recipient FTP, and Schema 3 defines recipient JReport Server Version. If Schema 1 and Schema 3 are
selected, only To E-mail, To Disk, and To Version sub tabs will be shown in the Bursting Result tab of
the Publish tab for the bursting result.

Once you choose to schedule to run a bursting report, you should at least specify the schema you want
to apply to the selected bursting report or select Non-bursting result in order to submit the task.

The following list tells which tab will be displayed in the Publish > Bursting Result tab of the Schedule
dialog for which recipient address specified in bursting schema.

Recipient Sub tab in the Publish tab
E-mail To E-mail

FTP To FTP

Disk To Disk

JReport Server Version To Version

JReport Server User/Group/Role - User E-mail To E-mail

JReport Server User/Group/Role - User To Version
Private Folder

When scheduling a bursting report, you needn't specify the destination in the Publish tab since the
recipient addresses have been included in the bursting schema. However, you are allowed to give a file
name to the subset of report result instead of using the default name.

Default name for bursting result files

Sometimes you may not want to specify a file name for each bursting result when defining recipients.
The bursting system will give it a name as generated by the system.

The default name format is: ReportName + " " + BurstingKey + suffix (result format type). When

there are multiple bursting key columns, connect each one by the character

Converting to String

When a bursting key is of one of the following data types, it will be converted into String so as to make
a valid result file name:

. Integer, Float, Character: Same as Java, these data types are transferred to string directly.

. Date and Time: All data and time formats will be transferred to a date format: yyyy-MM-dd hh:mm:
Ss.

. Currency: Currency will be transferred to the number without the currency mark ($ or others).

Name length

In the JReport Server resource system, the resource name only supports up to 64-character length. If
a bursting result file name is longer than that, the system will trim it down automatically.

In order to avoid using the same name in the same path, an index will be appended to the result name,
for example: reportl_USA_ Marylandl.pdf, reportl_USA_ Maryland2.pdf.

Notes:
. All bursting sub results will apply the security information of the bursting task submitter.
. When running a page report containing both normal and bursting report tabs:

For direct running:

When running it to Page Report format, only the normal report tabs are opened.

When running it to other formats, if the default focused report tab is a normal report, it will be
opened directly; if the default focused report tab is a bursting report which cannot be run, a warning
message will be displayed asking the end user to select a normal report tab to run using advanced
run.

For advanced running:

You can only choose the normal report tabs to run.

Scheduling a bursting report to generate non-bursting result

Besides generating bursting result for a bursting report, you can also generate non-bursting result for
the report without applying any bursting definition, which is based on full data without data splitting.

To generate non-bursting result, select the Non-bursting result option in the General tab of the
Schedule dialog. Then a tab named Non-bursting Result appears in the Publish tab, and all these sub
tabs - To Version, To Disk, To E-mail, To Printer, To Fax, and To FTP - are available in this tab for the
non-bursting result.
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Scheduling a customized task using User Task

In order to meet the requested requirement to run tasks defined outside of JReport on JReport Server,
and to just use JReport Server's schedule function, JReport has provided a task named User Task. With
this task, you can implement a customized task with the schedule properties. You can also submit the
user task from a web page, or by calling the JReport Server APl methods.

To schedule a customized task using User Task:

1. Create a task class that implements the UserTask interface and add the path of the class file to
the ADDCLASSPATH variable in setenv.bat, which is located in <i nstal | _root >\ bi n. You can find
the interface in the jet.server.api package available in <i nstal | _root >\ hel p\ api . JReport
provides a demo class APIDemoDynamicExportTask.java in <i nstal | _r oot >\ hel p\ sanpl es
\ API Ser ver for your reference.

2. Create a task properties file defining the formats of exporting the task. For example, the content
of the properties file is:

jrs.rst=result_rtf
jrs.pdf =true
jrs.text=true
jrs.excel =true
jrs.ps=true

jrs.htm =result_htmn

3. Submit the task either from a server web page or by calling Server APl methods. The task can
then be run by the server.

o To submit the customized task from a server web page:

a. On the JReport Console > Resources page, browse to the desired report, put the mouse
.-'_L'H.
pointer over the report row and click the Schedule button ~ on the floating toolbar. The
Schedule dialog is then displayed.

b. Specify the settings in the General, Publish, Conditions, and Duration tabs as required.
Here the Publish tab settings should be switched to those of User Task by clicking the link
on the right bottom of the tab. Then, the name of the task class file you have defined that
implements the UserTask interface and the task properties that define the export formats
must be provided. You can either input the task properties manually or import them from
the task properties file that you have created.

c. Upon finishing, click Finish to submit the task.

o To submit the customized task by API methods:

a. Set the user task class name to the property value of APIConst. TAG_TASK_ CLASS.

b. Define the user task properties with the property APIConst.TAG_USER_TASK_ PROP with
the formats as follows: jrs.user_task prop= jrs.rst=result_rtf&jrs.pdf=true&jrs.
text=true&jrs.excel=true&jrs.ps=true&jrs.html=result_html. Since the jrs.user_task_ prop
is used to transfer multiple user task properties, the values set to this property must be
formatted to be separated with "&" character.

c. Set a display name for the class with the property APIConst.
TAG_USER_TASK_DISPLAY_NAME.

d. Except for the above properties, define the other schedule properties as you do with a
default task, see APIDemoPublishRpt.java in <i nstal | _r oot >\ hel p\ sanpl es\ API Ser ver

for reference. Then following the APl demo you can submit a customized task on the server.

Click My Tasks on the system toolbar. When the task is being performed, you can see a record of it in
the Running tab and on completion it will be put into the Completed tab.

Note: You can either schedule to use the Default Task or the User Task at one time. If you specify to
schedule a report as a default task, you will not be able to schedule it as a user task, and vice versa.
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Recording scheduled tasks

JReport Server records every scheduled task. Click My Tasks on the system toolbar of the JReport
Console page, then the following tabs will be displayed: Scheduled, Running, and Completed. The tasks
are recorded in different tables according to their executing status. A task is placed in the Scheduled
table as soon as it is submitted by the user. It will go to the Running table when it is running, and
when it is finished by JReport Server, it will then go to the Completed table.

Related topics:

Manaqging tasks
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Viewing scheduled report results

When a scheduled task is finished, you can view the result of the scheduled report as required. To view
the result, first of all you need to know the corresponding result's location. To get the location
information:

1. On the JReport Console page, click My Tasks on the system toolbar, then click the Completed
tab, where all the successfully scheduled tasks are recorded.

2. Locate the task in the tab and click the name of the task in the Schedule Name column.

3. In the Result Details table, the location information of the scheduled result is available in the
Details column.

Viewing results scheduled to version

To view report results that are scheduled to version, you can choose whether to view via the JReport
Console page or via URL.

Viewing via the JReport Console page

One way to view results that are scheduled to version on the JReport Console page is via the scheduled
task records. To do this:

1. Click My Tasks on the system toolbar, then click the Completed tab.
2. In the tab, locate the right task and click the name of the task in the Schedule Name column.

3. In the Result Details table, the links to different result formats are available for viewing in the To
Version row.

And another way to achieve the same purpose is via the server resource tree which to some extent
varies with the archive location type specified in the Publish > To Version tab:

. If the archive location has been set to Built-in Version Folder:

1. On the JReport Console > Resources page, browse to the row that the original report is in.

2. Do either of the following:

« Select the report row and click Tools > Version on the task bar of the Resources page.

« Select the report row, right-click in the row and select Version from the shortcut menu.

« Put the mouse pointer over the report row and click the Version button = on the floating
toolbar.

3. In the Report Result Versions tab, the scheduled results of different format types are listed in
the Result column. Click the format links or action buttons to view the results.

. If the archive location has been set to My Reports Folder or Public Reports Folder, which requires
providing a path and a name for the scheduled result in the server resource tree:

1. On the JReport Console > Resources page, browse to the row that the result is in.

2. Put the mouse pointer over the result row and click the Version button “ on the floating
toolbar (or you can use one of the other two methods shown in the above procedure to display
the version table).

3. In the Result Versions tab, the scheduled results of different format types are listed in the Result
column. Click the format links or action buttons to view the results.

Tip: The unviewed version results are highlighted in bold. You can cancel the highlighting by setting
the property web.version.mark_unviewed to false in the server.properties file in <i nstal | _r oot >\ bi n.

Viewing via URL

For the report results that are scheduled to version, you can also view them via URL. One important
thing in the URL method is that you need to know the file name of the result that you want to view. To
get this information, you can take the steps explained at the beginning of the document.

Using command jrs.view_ver_rst

See the example:

http://1 ocal host: 8888/ rserver/ Sanpl eReports/ Sanpl eReports. cat/Enpl oyee I nformation. cls?
jrs.cmd=jrs.view ver rst&

jrs.hist file=1%cJReport_System User 327406359%bcEnpl oyee I nformation.rst&rs.

result _type=1.

See details about the usage of the command jrs.view_ver_rst.
Using viewVersion.jsp

For example:

http://1 ocal host:8888/jinfonet/viewersion.jsp?rs.cnd=jrs.view ver_def&rs.
rst_version=2& rs.ver_suff=htnm &
jrs.report=9%2f Enpl oyee Information.cl s& ype=rstfile& rs. pat h=92f Enpl oyee Information.cls

Notes:

. To view RSD version results using JSP, you should use dhtml.jsp instead of viewVersion.jsp. For
example:
http://1 ocal host: 8888/ dhtm jsp/dhtm .jsp?jrs.rst_version=10& rs. report =/ Banded_Li nk.
cl s& ype=rstfil e& rs. pat h=/Banded_Li nk.cls

. When viewing a scheduled page report result with cached report bursting via URL, you should add

jrs.is_pls_ result=true in the URL, for example: http://| ocal host: 8888/ dhtm j sp/dhtnl .| sp?
jrs.rst_version=1& rs.is _pls result=true&rs.report=/PLS. clsé& ype=drstfile&rs. path=/

PLS. cl s

Viewing results scheduled to disk

When scheduling a report to disk,

. If you choose Publish to Server Disk Path, you are required to provide a disk file path and file name
with correct format type as the suffix for each report tab in the report. After scheduling succeeds,
you can find the corresponding result files available at the specified location on the computer where
JReport Server is installed.

. If you choose Publish to Server Resource Tree, you are required to provide a path following the
server resource tree and file name with correct format type as the suffix for each report tab in the
report. For example,

o To follow the My Reports folder path, start with "/USERFOLDERPATH/admin/".
Example: /USERFOLDERPATH/admin/reportl.pdf

» To follow the Public Reports folder, start with "/*.
Example: /report2.html.

If the specified folder which is the parent folder of the result file has a real path, the generated result
file will be saved to the real path; if the folder doesn't have a real path, the generated result will be
saved to <server __install _root>/jreports/, which is the mapped disk path of the root node "/" in

the specified path.

Viewing results scheduled to e-mail/printer/fax/FTP

When a report is scheduled to e-mail, printer, fax, or FTP, you can view the scheduled result if the
specified address or location is available to you.
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Importing and exporting scheduled tasks

In JReport Server, you can export a scheduled task to a script file which will then be saved on your own
disk as a script file. In addition, you can import a script file from the disk file to generate a scheduled

task.

To export a scheduled task to a script file and save it in the disk:

1.
2.
3.

4.
5.

On the JReport Console page, click My Tasks on the system toolbar.
In the Scheduled tab, select the rows that one or more scheduled tasks are in.

Click Tools > Export to Script on the task bar of the My Tasks page (if only one task is selected,
you can also right-click in the task row and select Export to Script from the shortcut menu, or

&
put the mouse pointer over the task row and click the Export to Script button F—}I on the floating
toolbar), then modify the script text in the Edit Script box as required.

Click OK to export the specified scheduled task to a script file.

Specify the directory and name for this script file in the File download dialog.

To import a script file from your disk:

1.

5.

On the JReport Console page, click My Tasks on the system toolbar, then select the Scheduled
tab.

Click New Schedule on the task bar of the My Tasks page.
In the New Schedule dialog, check the option Import Script to Create Schedule.

Click the Browse button to select a script file from your disk file, then click OK to import the
specified script file and modify the script text in the Edit Script box as required.

Click OK to generate a scheduled task.

Note: If you just updated from an older version of JReport Server, there may be some old scripts
saved in your server. In order to use these old scripts, you can click the Import old script from
server link in the Import Script page to select an old script to import it to generate a scheduled task.
To use this link, you must logon JReport Server as an administrator role.
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Adding TaskListener

When viewing or scheduling a report, JReport Server enables you to call your Java application before or
after the process.

In JReport Server, a TaskListener interface has been provided in the package jet.server.api for
receiving task events before or after running. You can specify one Java class to implement this
interface for a task event. When the event of this task occurs, the corresponding methods in the
listener will be invoked. The interface contains two methods: beforeRun and afterRun, enabling you to
set your Java application call before or after the process of viewing a report or setting up a schedule.
Your applications will return true or false. For true, JReport Server will go on running. While for false,
JReport Server will stop there.

Below is an example illustrating how to add TaskListener when setting up a schedule on a report.

1. Develop your Java class to implement the interface. Here TestTaskListener.java is used, which is
available in <i nstal | _root >\ hel p\ sanpl es\ APl TaskLi st ener.

2. Compile TestTaskListener.java to generate the class file.

3. Edit the batch file setenv.bat in <i nstal | _root >\ bi n. Assuming that TestTaskListener has been
saved in C:\ JReport\ Server\tasklistener, add the path of the class file (C.\ JReport\ Server
\taskl i st ener) to the ADDCLASSPATH variable in setenv.bat.

4. Start JReport Server and set up a schedule on a report, check Add TaskListerner to be Invoked
in the General tab of the Schedule dialog, then input the class name. In this example, input
TastListener, and then submit the task.

5. In this example, the class returns True.

Print out the task and schedule properties before and after running the task. You will then get task
and schedule information in the command window before and after the task is run.

You can also define properties of your own and transmit them through Serverinfo. To do this, use
APIConst. TAG_USERDEFINED_PROPERTY_PREFIX as the prefix for the properties.

For example, if you want to transmit the properties host_name, host_ip and hosp_protocol, you will
need to insert the properties, before calling the method runTask, into the properties named prop, as
follows:

prop. put (APl Const. TAG_USERDEFI NED_PROPERTY_PREFI X+"host _nanme", "host");
prop. put (APl Const. TAG _USERDEFI NED_PROPERTY_PREFI X+"host _i p", "127.0.0.1");
prop. put (API Const. TAG USERDEFI NED_PROPERTY_PREFI X+"host _prot ocol "+ "TCP/ I P");

You can get the value of the properties listed above through the server info object, serverinfo, in the
method beforeRun or afterRun of the TaskListener class. See the example below:

host name=server | nfo. get TaskProperties(). get (APl Const. TAG USERDEFI NED _
PROPERTY_PREFI X+" host _nane") ;

host i p=serverl nfo. get TaskProperties().get (APl Const. TAG USERDEFI NED _
PROPERTY_PREFI X+"host _i p");

host protocol =server| nfo. get TaskProperties().get (APl Const. TAG USERDEFI NED
PROPERTY_PREFI X+"host _protocol ");

Note: All properties without the prefix APIConst. TAG_USERDEFINED PROPERTY_PREFIX will be denied
and discarded by JReport Server.
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Specifying parameter values

When running or scheduling reports with parameters, you may need to specify values for the parameters.
The way to specify a parameter value varies with the type and properties of the parameter. Here are
several ways you can use to specify parameter values:

. In the parameter value combo box, input the value manually or select the required one from the drop-
down list. If you have chosen to automatically save parameter values, the saved value groups will be

available on the top of the parameters’ value lists for selection.

. Select or unselect the checkbox to specify a Yes/No value.

. Click the button ' " ' to specify multiple values in the Enter Values dialog.

. Click the calendar button ﬁ to specify a date and time value using either calendar or expression in the
Calendar dialog. If you use an expression to specify the value, when you hover the mouse pointer over
this value, a tip will appear showing its expression. Click on the value, the expression will be displayed
in the value text box and you can edit the expression in the text box directly if you want. After editing,
when you click elsewhere outside of the value text box:

o If the edited expression is correct, a new value calculated by the expression will be displayed in the
parameter value text box.

o If the edited expression is wrong, no value will be created and the expression itself will be displayed
and highlighted in red in the value text box. Correct the expression, or click the calendar button to
specify a value.

I'-.EI
. Click the Use Saved Values button ™= and select a previously saved parameter value group to apply
to the report. For details, see Manually saving parameter values.

Note: You are recommended not to use blank as the thousands separator in Number-typed parameter
values under French locale, otherwise your input will not be correctly recognized because of a JVM bug.
For details, see http://bugs.sun.com/view bug.do;jsessionid=c8cdaf911b20fffffffffd9fc6340b30d670?

bug_id=4510618.

This document also introduces some useful techniques for setting parameter values.

Saving parameter values for reuse

When specifying parameter values for reports, you may want to save the specified parameter values for
reuse next time. JReport provides two ways of saving. One is users decide when and which parameter
values to save, the other is JReport saves each applied or submitted parameter values automatically.
When the saved number in either way reaches the maximum, the oldest record will be removed. The
number is calculated on a user-report basis. Take a report with two parameters for an example, supposing
the maximum number is set to 3. Each user can save at most three groups of parameter values for the
report. Each group contains the values of the two parameters.

To switch on the function of saving parameter values, go to the Profile > Customize Server Preferences >
Advanced tab, select Yes to the option Enable Saving Parameter Values, select a way to do the saving:
Manually or Automatically, and then specify a maximum number to limit the saved value groups which is
called the auto complete parameters list for each user-report pair.

Manually saving parameter values

I'--I_—xl
When you have chosen to manually save parameter values, the Use Saved Values button ' will be
available on the upper right corner of the parameter page. By clicking this button, you will get the
following:

. Value List
The value list contains all the parameter value groups you have saved for the report. Select a group to
apply all the values in the group to the corresponding parameters. You can also remove any of the

unwanted value group by selecting it from the list and then clicking A next to the value list.

. FL—-| Save Values
Saves the current displayed parameter values as a group for reuse afterwards. To do this, type a name

|
for the group in the text box which shows "Save current values into list" and then click U . The saved
group will then be added into the value list above. Once it reaches the maximum number, the latest
group will replace the oldest.

Using automatically saved parameter values

When you have chosen to automatically save parameter values, each time a user submits a group of
parameter values to a report, the group is saved by JReport automatically. The next time the same user
runs the report, the auto saved parameter values will be available in the parameters' value lists for
selection on the parameter page.

Customizing default parameter values

When specifying parameter values for a report, if you would like the current specified parameter values to
be saved as the default values for the parameters next time when you run or schedule the report, select
the Save as default option on the parameter page (to make this option available, you need to make sure
the Enable Setting Default Parameter Values For option is selected for the corresponding resource in the
Profile = Customize Server Preferences > Advanced tab).

If you want the saved default parameter values to be applied directly to the report next time when you
run it without popping up the Enter Parameter Values dialog, select the option Do not show the screen
again in the dialog (to make this option available, you need to make sure the Enable Hiding Initial
Parameter Dialog For option is selected for the corresponding resource in the Profile > Customize Server
Preferences > Advanced tab). However, if the last-time saved default values cannot completely match the
current report parameters, the dialog will still be displayed. This option only hides the parameter dialog
popped from operation on the console. It does not affect the case of running report using URL way.

In addition, JReport provides you with the Parameter Settings dialog which allows you to pre-customize
the default parameter values for a report before running it. This dialog can also be used to show the Enter
Parameter Values dialog again after it has been hidden. To do this, check Re-enable Parameter Screen
in the dialog.

The above options are user-report level settings, that is to say, they take effect when both the same user
and report are matched. This also applies to admin users, and therefore admin cannot customize the
settings for all users.

Using built-in functions to set date and time parameter values

For a parameter of the Date, DateTime, or Time type, you can customize a dynamic date and time value
by creating an expression using built-in functions.

To do this:

1. In the places where you are able to specify a value for the parameter, you may see the calendar

button ﬁ Click this button and the Calendar dialog appears.

Movermnber v | (2015 4+ Template:

Expression:  cyrrentDate()

15 16 17 18 19 20 21
22 23 24 25 26 27 28

29 30
Display Time Format: 12 hour v
4 ¥ (=39 ¥ |:|10 ¥ AM o PM
Preview: Movember 12, 2015 4:39:10 PM
Use Today as Default
4 oK Cancel

2. The Template drop-down list on the right provides some predefined expressions for you to use. You
can customize your own expression either based on an existing template or by directly editing the
contents in the Expression text box.

If you cannot see the Template label on the right, click == on the bottom left corner.

3. JReport's built-in Date/Time formula functions are available for inserting into your expression. To

make use of them, click = *" ' to display the functions.

4. The Preview box calculates the result of the current expression. Each time you modify the
expression, you can click in the box to refresh the result. If it is an invalid expression, an error
message will be shown in the box and no change will be made to the calendar and the currently
selected date/time will be remained in the calendar.

5. When done, click OK to add the value.

When running reports via URLs, you can also use expressions to specify date and time parameter values.
The format is Parameter_Name={"exp":"Complete_Expression_String", "SelectedDate":""MM/dd/yyyy"}.
If the expression does not contain the function SelectedDate(), there is no need to add this part -
"SelectedDate":""MM/dd/yyyy" and the format is Parameter_Name=
{"exp":"Complete_Expression_String"}. For example, to specify p_EndDate=today(), write it as
p_EndDat e={"exp":"today()"}. The following is an example of running the CustomerAnalysis.cls:

http://1 ocal host:8888/jinfonet/runReport.jsp?jrs.cnd=jrs.web_vw&jrs. catal og=%

2f Sanpl eRepor t s¥%2f Sanpl eReports. cat & rs. report =92f Sanpl eReport s%2f Cust oner Anal ysi s.
cl s& rs. paranP_St art Dat e=01/ 01/ 2010&j r s. par ansp_EndDat e={"exp":"today()"} & rs.
result _type=8
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Using JSPs to print page reports

JReport Server provides the following demo JSPs which enable you to print a page report without any view in the client
side, and they are available in <i nst al | _r oot >\ hel p\ sanpl es\ JSPSanpl es\ Pri nt Report .

printDemo.jsp
Provides frames to load printCustomerlist.jsp and printReport.jsp.

printCustomerlist.jsp

Shows how to set parameters for printing the demo report CustomerAnalysis.cls by using the ViewerApplet. This JSP
calls printReport.jsp. If you want to print the other reports, you can follow this JSP file as an example to write your
own JSP. In your own JSP, you should modify the values of "cat" and "rptName".

String cat = "/ Sanpl eReport s/ Sanpl eReports.cat"”; //request. get Paraneter (APl Const. TAG CATALOG) ;
String rptNane = "/ Sanpl eReport s/ Custoner Anal ysi s.cls"; //request. getParaneter (APl Const. TAG_REPORT) ;

printReport.jsp
Shows how to print reports by using the ViewerApplet. The example JSP printCustomerlist.jsp calls this JSP.

Before running the JSPs, copy them to <intal | _root>\public_htm\jinfonet. Then, start JReport Server and access
printDemo.jsp using the URL http://1 ocal host: 8888/ i nfonet/printDeno.jsp. The following page appears:

-

& two frame html - Windows Internet Explorer I. =HEC |£?-J

@u hp

File Edit View Favorntes Tools Help

. o |
£ | http://localhost:8888/jinfonet/printl - | "'f| A | | Bing B

S Favorites & two frame html

Print Report : /CustomerAnalysis.ds I PrintInCurrentFrame H PrintInHiddenFrame H Reset H View I

Start Date: 2013-12-31 2013-12-31 | w |
End Date: 2015-1-1 2015-1-1 | w |
Java applet:

Java Plug-In for Windows (Download Certificate file of JRViewer Applet for Java Plug-In )
Pop-up Window

Encoding: | Windows Latin-1 E|
@' Use the default DB user and password defined in catalog

Use the DB user: password:

] tnteractive Badckground [ wait [ SeparatelLargePage MotifyComplete  Printer:

l PrintInCurrentFrame H PrintInHiddenFrame H Reset H View J

e

PrintInCurrentFrame

Specifies to call printReport.jsp and load applet of Page Report Studio Frame.
PrintinHiddenFrame

Specifies to call printReport.jsp without loading applet of Page Report Studio Frame.
Reset

Resets the previous options.

View

Views this report.

Interactive

If checked, you could specify the print setup in the Print dialog.

Background

If checked, the print job will run in the background.

UseJDK1.1

If checked, you will use instance PrintJob of JDK11 to print the report.

Wait

If checked, you have to wait until the print job is finished.
SeparatelLargePage

If checked, the large page will be separated into several pages automatically.
NotifyComplete

This parameter is used with the parameter wait. After the print job is finished, a box will pop up to note you, and you
could do any other work instead of keep on waiting.

Printer

Specifies the printer to implement the print job.
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Page Report Studio

With JReport Server, you can obtain report result in different formats, such as HTML, PDF, and Excel.
For the HTML format, there are two viewing modes - pure HTML or Dynamic HTML. Page Report Studio
provides a dynamic report view at the client side. You can change options which enable the results to
be displayed to your requirements.

Interactive information empowers you to slice and dice your business data, to dynamically change your
view of data, and to analyze the data to glean useful business information. In short, interactive
information enables you to customize your view of business information. With JReport, any report can
be made interactive, extending the "life" of the report by allowing you to easily sort, navigate, and filter
data via Page Report Studio. This wide range of functionality, including the ability to drill down on data,
enables you to quickly derive value from your business intelligence data.

Page Report Studio provides support for many features. You can dynamically modify - filter, search,
sort and drill - reports to obtain unique and personal data views. The Page Report Studio toolbar and
interactive web objects (images, buttons, text fields, checkboxes, radio buttons, drop-down lists and so
on) can be embedded into reports or JSPs at design time, enabling you to control, customize and
navigate report views. Page Report Studio also supports a web design feature, allowing you to create
reports using report oriented data structures, save your report, and even save your custom
modifications to existing reports.

This chapter covers the following topics to help you better understand how Page Report Studio makes
reports interactive and how you will benefit:

. Page Report Studio window elements

. General operations

. Ad hoc reporting

. Analytic reporting

. Working with reports via URL

. Opening multiple reports in one session

. Tuning Page Report Studio performance
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Page Report Studio window elements

The main page of Page Report Studio consists of the user information bar, menus, toolbar, page report

bar, Toolbox, Resource View panel, TOC Browser, and report area. The options for browsing or
controlling a DHTML report are as follows:

Toolbar/
Menu

File

Edit

View

Insert

Report

Help

Standard
Toolbar

View Toolbar

Analysis
Toolbar

Font format
buttons

Page
navigation
buttons

Go To drop-
down list

More
Commands

Shortcut Menu

Notes:

Button

_|_

H & &

L XV g d

__.._
=

Style:

Arial

b

JReportDemo

¥ g

[

Max Records: |[all

Page 3 of 4

I

<
>

A

Go To;

£

English (United States) .

reportl ¥

L

L

Tool Name

New Page
Report Tab

New Page Report

Open

Rename Report
Tab

Close Report
Tab

Delete Report
Tab

Save

Save As
Export

Page Setup

Printable Version

Exit
Undo
Redo

Search

Toolbar

User
Information Bar

Toolbox

Resource View

TOC Browser

Editing Marks

Turn To

Refresh

Zoom

Options

Show Grids
Snap to Grids

Label
Image

Banded Object

Table
Crosstab

Chart

Parameter
Control

Parameter Form
Control

Filter Control
Navigation
Control

Special Fields

Page Break

Query Filter

Filter

Sort

To Chart

To Crosstab

Rotate Table

Rotate Crosstab

Merge

Split

Language

Max Records

Use Dynamic
Formula in
Property

Style
Change
Parameters

User's Guide

Jinfonet
Software Home
Page

Technical
Support

About Page
Report Studio

New Report Tab

Open

Save

Save As

Export

Printable Version

Undo

Redo

Delete

Toolbox

Resource View

Filter

Sort

Search

Zoom

Rotate

Chart Type
Style
Font Face, Font

Size

Bold, Italic,
Underlined

Left, Center,
Right

Max Records

Page Number

First

Previous

Next

End

Go To

Language

Filter

Sort

Drill Down

Drill To

Drill to By Value

Drill Up

Go To

Go Up

Go Down

Go to Detail

Conditional
Formatting

Search

Query Filter

Refresh

Properties

Description

Creates a new report tab to

the current page report based
on an existing business view.

Creates a new page report
containing a report tab based
on an existing business view.

Opens the Open Report Tabs
dialog for you to open/close
report tabs in current report.

Opens the Rename Report Tab
dialog to give the open report
tab a new name.

Closes the current report tab if
there is more than one report
tab open in the report; or
prompts you to close the
report if there is only one
report tab.

Deletes the current report tab
if there is more than one
report tab open in the report.
This command is disabled
when the last page of the
current report tab does not
display if Format Page on
Demand in the Profile >

Customize Profile > Page
Report Studio > Properties >
Advanced tab is selected.

Saves the report as a report
version.
Saves a copy of the report.

Exports the report result to

disk or version in various
formats.

Shows the Page Properties
dialog for you to specify the
page layout settings for the
report result.

Shows the Printable Version
dialog for you to print the
current report result to a PDF/
HTML file.

Closes the current report.

Undoes the last operation.

Reverses the operation of
Undo.

Shows the Search dialog for
you to find specific text.

Shows or hides toolbars.

Shows or hides the User
Information Bar, which
displays the user name,
catalog name and report name.

Shows or hides the Toolbox
panel which allows you to
insert a component into the
report.

Shows or hides the Resource
View panel, with which you
can add view elements to your

report and create dynamic
resources to use them in your
report.

Shows or hides the TOC

Browser, with which you can
navigate the report data.

Shows or hides editing marks
(dashed outlines for objects
and report body). If the option
is unselected, the editing mark
will not be shown when a
report object receives focus,
and report objects cannot be
moved or resized.

Provides a submenu for you to
turn the report pages.

Runs the report using
previously provided
parameters. The Refresh
operation fetches the data
again.

Shows the Zoom dialog for
you to set a zoom ratio for the
report page.

Shows the Options dialog for
you to set the skin and unit for
Page Report Studio, and to
customize toolbars.

Shows grids in the report area.

Snaps an object to grids when
you move it by dragging and
dropping in the report area. If
this option is enabled, aligning
objects will be made easier. To
temporarily override the
setting, press the ALT key as
you move an object.

Inserts a label into the report.

Inserts an image into the
report.

Inserts a banded object into
the report.

Inserts a table into the report.

Inserts a crosstab into the
report.

Inserts a chart into the report.

Inserts a parameter control
into the report.

Inserts a parameter form
control into the report.

Inserts a filter control into the
report.

Inserts a navigation control
into the report.

Inserts special fields into the
report.

Inserts a page break into the
report.

Applies a filter to the business
view used by certain
component.

Filters the report records
according to the filter criteria
you specify.

Sorts the report records or
groups in ascending or

descending order on the fields
you select.

Converts a crosstab into a
chart.

Converts a chart into a
crosstab.

Rotates a table to switch its
appearance between the
horizontal and vertical layout
modes.

Rotates a crosstab to
exchange the columns and
rows in the crosstab in order
to create a different view of
the crosstab.

Merges selected tabular cells
into one.

Splits a tabular cell into the
specified number of rows and
columns.

Allows you to specify the
language in which to display
the report. Available only
when Enable NLS is checked in
the Profile > Customize Server
Preferences > Advanced panel
on the JReport Console page.

Allows you to specify the
maximum number of records
retrieved by all components in
the report.

Allows you to apply dynamic
formulas to control object
properties.

Allows you to apply a style to
the report.

Allows you to change the
parameter values in the report.

Opens Page Report Studio
User's Guide.

Connects to Jinfonet Software
Home Page.

Accesses Jinfonet Technical
Support.

Shows product information
about Page Report Studio.

Creates a new report tab
based on an existing business
view.

Brings out the Open Report

Tabs dialog for you to open/
close report tabs in current

report.

Saves the report as a report
version.

Saves a copy of the report.

Exports the report result to
disk or version in various
formats.

Shows the Printable Version
dialog for you to print the
current report result to a PDF/
HTML file.

Undoes the last operation.

Reverses the operation of
Undo.

Deletes the selected object.

Shows the Toolbox panel for
you to insert a component into
the report. Click it again to
hide the Toolbox.

Shows the Resource View
panel, with which you can add
view elements to your report
and create dynamic resources
to use them in your report.
Click it again to hide the
Resource View panel.

Shows the Filter dialog, with
which you can filter the report
records according to the filter
criteria you specify.

Shows the Sort dialog, with
which you can sort the report
records or groups in ascending
or descending order on the
fields you select.

Shows the Search dialog for
you to find specific text.

Enables you to enlarge or
reduce the size of the report.

Rotates a crosstab or rotates a
table.

Lists all available chart types
for you to change the type of a
selected chart.

Allows you to apply a style to
the report.

Changes the face and size of
the selected font. Available
only when a label or field is
selected.

Makes the selected font in
bold, italic or underlined style.
Available only when a label or
field is selected.

Makes the selected font left,
center or right aligned.
Available only when a label or
field is selected.

Allows you to specify the
number of records retrieved
by all components in the
report.

Displays the current page
number. You can also input a
page number in the page box
and press Enter on the
keyboard to go to that page.

Goes to the first page of the
current report tab.

Goes to the previous page.

Goes to the next page.

Goes to the last page.

Goes to the selected report
tab or to the selected report
tab level.

If a report contains several
reports tab, you can use this
list to switch among the report
tabs. Or, after you perform
some going or drilling actions
on a report tab, the structure
of the report tab will be
displayed in the list in a
hierarchical view, with which
you can return to any level of
the report tab easily.

When the Page Report Studio
window is not maximized in
Interactive View mode, the
button will be displayed on the
toolbar, by clicking which you
can get all the other toolbar
commands the small window
hasn't enough space for.

Specifies the language in
which to display the report.
Available only when Enable
NLS is checked in the Profile >
Customize Server Preferences
> Advanced panel on the
JReport Console page.

Provides submenu items for
filtering the data in a banded
object/table or removing the
filtering.

Provides submenu items for
sorting records on the selected
field in ascending/descending
order, or removing the sorting.

Drills data to a lower group
according to predefined
hierarchies.

Enables you to obtain a
different view of data by
switching among groups.

Allows you to filter data based
on groups while also obtaining
a more detailed view of the
data.

Drills data to a higher group
according to predefined
hierarchies.

Goes to any group to show its
record information.

Goes up one group level to
show the records of a higher-
level group.

Goes down one group level to
show the records of a child
group.

Goes to the details of a group.
Enables you to add conditional
format to the currently
selected field.

Shows the Search dialog for

you to search the report result
for some text.

Applies a filter to the business
view used by the specified
data component.

Re-fetches data of the
specified data component.

Shows a dialog for you to
define the object's properties.

. Page Report Studio has two view modes: Basic View and Interactive View, and the toolbar and menu
commands that are available in each mode vary. Administrators can specify the default mode that

will be applied when a report is opened in Page Report Studio in the Profile > Customize Server

Preferences > General tab, and you can switch between the two modes by clicking the Basic View or
Interactive View link on the Page Report Studio toolbar. However, you will not be able to switch the

mode if the Show Link of Basic/Interactive View option in the Profile > Customize Profile > Page
Report Studio > Properties > Default tab is unchecked.

. The options available on the Page Report Studio window are determined by the feature profile that is
selected as the default profile in the Profile > Customize Profile > Page Report Studio > Features tab

and the property setting on the Profile > Customize Profile > Page Report Studio > Properties tab

(profile has the higher priority). The default Page Report Studio profile provides full options.

. The shortcut menu contents vary with the objects you right-click. The above table only lists some
typical shortcut menu items. The following sections will guide you to use the shortcut menu for any
object you may right-click.
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General operations

After having opened a report in Page Report Studio, you can do the following general operations:

. Managing report tabs
A page report can include one or more report tabs. The Go To drop-down list on the toolbar panel or
the tabs across the top of the report lists the display names of all the open report tabs in the current
report. Clicking the display name of an inactive report tab will make it active. You can manage report
tabs in a page report easily as follows:

»  Opening and closing a report tab
In a page report, a report tab can be shown or not. To close (hide) the active report tab, click
Menu > File > Close Report Tab . If there are one or more report tabs open other than the
active report tab, the close action will hide the active report tab; in the case that the active report
tab is the only report tab open, the close action will prompt you whether or not to close the report.

—_—
To open (show) a hidden report tab, click Menu > File = Open (or the Open button " on the
Standard toolbar) to display the Open Report Tabs dialog, in which the report tabs open in the
current report are marked with a check symbol. Check the report tabs you want to open, uncheck
the ones you want to close, and then click OK.

s Renaming a report tab
To rename a report tab, first activate it, then click Menu > File > Rename Report Tab. In the
Rename Report Tab dialog, specify a new display name for the report tab.

» Deleting a report tab
To delete a report tab, first activate it, then click Menu > File > Delete Report Tab. The only
report tab open cannot be deleted.

Note: A JReport Live license for JReport Server is required in order to delete report tabs. If
you do not have the license, contact your Jinfonet Software account manager to obtain it.

Tip: If the administrator has specified to switch report tabs using tabs in the Page Report Studio profile
page, you can easily activate a report tab in a report by clicking the tab representing the report tab on

the report tab bar, and closing, renaming and deleting a report tab can also be accomplished by right-
clicking the report tab and choosing the corresponding command from the shortcut menu.

. Turning the report pages
 report tab includes more than one page, to turn between the report pages, you can:

|_.- # e

. Click the First Page button , Previous Page button “, Next Page button ~, or Last Page

LY
utton A on the View toolbar.

Page 3 af 4

. Input a number into the page box and press Enter to go to that page.

. Click Menu > View > Turn To and then click the corresponding command on the submenu. When
ne Page command is selected, the Turn To page dialog appears for you to input the page number.

. Use the scrollbar or mouse wheel to scroll up/down the report tab.

. Navigating through the report data
| can use the TOC Browser to navigate through a report tab. To show the TOC Browser, click Menu >
'w > TOC Browser.

he TOC Browser, expand the Report node, select a component or a node with the group value that you
1t to browse to. The page that contains the component or the matching data will then be shown.

» table of contents on the TOC Browser is organized into a tree structure. The root node represents the
ort tab that you are currently viewing. The component names indicate components in the report tab. The
up values show hierarchical groups.

report tabs designed in JReport Designer, the nodes displayed on their TOC tree as well as the format of
TOC tree can be customized.

. Refreshing the report result
fetch the data of the current report again, you can click Menu > View > Refresh.

. Applying a style
tyle can be applied to a report in order to change its appearance and characteristics. You can create and
up your own styles in JReport Designer. When you publish your reports to JReport Server, you can
ude these custom styles with the published reports. When you run a report, the style feature will be
\bled and you can select a style to apply to the report.

. Applying a style to a report
o0 apply a style to a report, make sure nothing is selected in the report, then click Menu > Report >
tyle and select the required one from the submenu, or select the required style from the style drop-
.. Style: | JReportDemo . .
own list =" P on the toolbar. When a style is applied to the whole report, all
omponents in the report will take a uniform appearance.

. Applying a style to a data component
he data component (banded objects, crosstabs, charts, and tables) in a report can take a different style
f its own. To apply a style to a data component, select it and then click Menu > Report > Style and
elect the required one from the submenu, or select the required style from the style drop-down list
il Reporiflemo ' on the toolbar, or right-click the component and select Apply Style from the
hortcut menu to select the required style in the Apply Style dialog. If the data component is contained in

“banded object (for a chart, in a table also), you can also select the Inherit Style option to make it inherit
ne style of its parent data component.

vever, if there is only one style available to the report, this style will be applied to the report by default,
vhich case, you will find that all these style related commands are hidden.

. Changing the report parameter values
here are parameters in the current report, you can change the parameter values at runtime. To do this:

1. Click Menu > Report > Change Parameters to display the Report Parameters dialog.

2. Specify the value for each parameter.
3. Click OK to run the report with the specified parameter values.

I can also use parameter web controls to dynamically change the parameter values of a report at
time. For details, see Applying web controls.

. Opening links

en a page report is developed with links in JReport Designer, which refer to locations specified by URLSs,
1ail addresses or other reports, you can click the links' trigger objects in Page Report Studio to open the
s. However, if the click priority of the link action is not specified to be the highest at report design time,
| have to right-click on the trigger objects and click the corresponding link item on the shortcut menu to
n the links. For example, if a trigger object is linked with a detail report, you need to right-click the

ect and select Detail Report from the shortcut menu to open the detail report. Meanwhile, when opening
detail report, you may be prompted with the Encoding dialog, asking you to provide encoding and DB

urity information before the report result is produced. Click OK in the dialog if you want to run a detail
ort using the same encoding and DB security settings as that of the master report.

Note: When opening a link report or detail report, a "link path”, which tracks the linking actions, will be
displayed in the Go To drop-down list on the navigation bar if the link report or detail report is opened
in the current window. Clicking an item in the list will switch to the corresponding report.

. Printing the report result
| can print the report result to a PDF or HTML file. To do this, click Menu > File > Printable Version (or

Printable Version button on the Standard toolbar). In the Printable Version dialog, specify the

tings as required and click OK. The PDF or HTML result file is then opened in an associated program with
ch you can print the result to a printer.

. Configuring Page Report Studio features
» JReport Administration page provides default settings for you to use Page Report Studio features, and
trols whether the settings on the JReport Console page can be configured. A user playing the
ministrator” role may change the settings in the JReport Administration page so as to enable or disable
ne features. Then you can configure Page Report Studio preferences on the JReport Console page, that is,
| can decide whether or not to enable the features which have been enabled on the JReport
ninistration page. After you have made changes to Page Report Studio settings on the JReport Console
Je and saved them, Page Report Studio features available for you will be consistent with your new
tings on the JReport Console page. For details, see Customize Profile.

. Setting Page Report Studio options
)e Report Studio allows you to set the skin and customize toolbars. To do this:

1. Click Menu > View > Options (or right-click anywhere on the toolbar area and select Options
from the shortcut menu) to open the Options dialog.

2. In the Option tab, set the skin of Page Report Studio user interface.

3. In the Customize tab,

o To modify a toolbar, select it in the Current Toolbar box, remove those unnecessary items from the

|
Selected Tools box, and add required tools from the Available Tools box. Click I or ¥ to adjust
the order of the tools on the toolbar.

o To add a toolbar, click + to show the New Toolbar Name dialog, then specify the toolbar name,
click OK to return to the Options dialog, and set the tools for the new toolbar.

o To delete a toolbar, select it and click ~

4. To load the default settings, including the skin, and the three built-in toolbars, namely Standard,
View, and Analysis, click the Restore Defaults button.

5. Click OK to apply the settings.

Tip: To close a toolbar, right-click anywhere on the toolbar area, then on the shortcut menu, select the
item corresponding to the toolbar name. You can also do this to open an invisible toolbar, such as a
newly-created one. The open/close toolbar operation can also be achieved by clicking the
corresponding item on the Toolbar submenu of the View menu.

. Tuning report page magnification
G
I can zoom in or out the report page by selecting a magnification from the Zoom list " “ on the View
Ibar. You can also click Menu > View > Zoom to show the Zoom dialog, and then specify the

gnification.

. Setting up the page
set up the report page, click Menu > File > Page Setup. In the Page Properties dialog, specify the page
e, the orientation, and the margins as required.

. Adding/Removing page breaks
ew page will be generated in a report tab only when the space in a page has been fully occupied or there
sts a break control in this page, for example, a page break that is inserted in the page.

insert a page break, click Menu > Insert > Page Break, then click the mouse button on the destination
ere you want the page break to be inserted.

remove a page break, right-click on the report body, then on the shortcut menu, click Remove Page
2aks and then the corresponding page break from the sub menu.

Notes:
. Page breaks can be inserted into the report body level.

. Page breaks can be inserted into banded objects only when the following conditions have been met:

o The parent of the banded object is the report body.
o There isn't any existing page panel in the report body.
o Its Position property of the banded object is set to static.

. Undoing/redoing actions

I can undo or redo some actions by clicking Menu > Edit > Undo or Redo (or the Undo button or

c?

. Showing/Zhiding user information
» User Information bar shows the current user name, catalog path and name, and report path and name.
I can click Menu > View > User Information Bar to show or hide the bar.

do button on the Standard toolbar).

Tip: Administrators can make this bar open by default. To do this, log onto the JReport Administration
page, click Profile on the system toolbar and select Customize Profile from the drop-down menu. Go to
the Page Report Studio > Properties > Default tab, and then check the User Information Bar
option.

. Showing/hiding editing marks
age Report Studio, you can use editing marks (dashed outlines of objects) for purposes such as aligning,
ving and resizing. By default, the editing marks are shown only when you create a new blank report in
)e Report Studio. You can click Menu > View > Editing Marks to switch the status of the editing marks
required.

. Asking for help
any time, you can click Menu > Help > User's Guide to open the index page of Page Report Studio
r's Guide. Furthermore, you can click the Help button in any dialog to show the help about the dialog.
I can also use the Help menu to open the User's Guide and access Jinfonet Software website for more
rmation.

. Exiting the report
ou want to close the current report and release the resources, just click Menu > File > Exit (or the Exit

ton E which is always on the upper right corner of the Page Report Studio window, or the close button
he browser window). Closing the only report tab open will also prompt you whether or not to close the
ort. In case that you have modified the report without saving it, Page Report Studio will prompt you to
e the report. If you have changed the sort and/or filter criteria, you can check Sort and/or Filter in this
log to save these changes with the report. Click Yes to save the report and close the report.
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Ad hoc reporting

Ad hoc reporting allows a business analyst or end user to create a new report, add new objects to an
existing report, modify report objects, and save the report or report result. These tasks are performed
in the JReport Server environment and do not require use of JReport Designer.

This section describes the following ad hoc reporting tasks:

. Creating a report tab

. Adding report objects

. Applying web controls

. Making simple modifications to report objects

. Saving the report

. EXxporting the report result
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Creating a report tab

In Page Report Studio, you can create a new report tab based on a predefined business view to the current page report.

You can also create a new page report containing one report tab and then add report tabs to it. However, the reports
created on business views in Page Report Studio cannot be edited in JReport Designer any further.

To create a report tab:

1. In a Page Report Studio window, click Menu > File > New Page Report Tab (or the button —|_ on the Standard
toolbar) to display the New Report Tab dialog.

New Report Tab
Report Title: |Report Title

Choose Report Layout
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-
HEE KHEE KKK
WM MMM MK GnEmEn pnmana
Wiy | wrem|rreE et e

¥ XX |FRFRF|FRFRF

—— il
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If you click Menu > File > New Page Report, the New Page Report dialog appears for you to create a page report
with the first report tab in it.

2. Specify the title of the report tab as required in the Report Title text box.
3. In the Choose Report Layout box, select the required layout with which you want to create the report tab.

4. Click OK to create the report tab.

o If Blank is selected as the layout, a report tab which is blank will be created. You can then use the Toolbox and the
Resource View panels to add objects and view elements to the report tab.

o If you select the layout as Banded, Table, Chart, or Crosstab, the corresponding report wizard will then be displayed.
Specify the settings according to your requirements.

Also, on the JReport Console > Resources page, you can directly create a new page report (containing a report tab) in a
folder into which one or more catalogs containing some business views have been published. To do this:

1. Open the folder and select the catalog for the new page report from the Catalog drop-down list.
2. On the task bar of the Resources page, click New > Page Report.
3. In the New Page Report dialog, create the page report containing a report tab as required.

The following topics show in detail how to create a report tab from a particular layout:

Creating a banded report

A banded object is a kind of component that can present grouped data and detailed data, and is composed of several
banded panels with which you can easily organize data fields and other elements.

To create a banded report:

1. In the New Report Tab dialog, specify the title of the report tab in the Report Title text box, select Banded as the
layout and click OK to display the Banded Wizard.

2. In the Data screen, select the business view in the current catalog, on which the banded object will be built.

3. In the Display screen, add the required fields from the Resources box to be displayed in the banded object. Modify the
display name of any added field if necessary.

4. In the Group screen, add the group objects as the grouping criteria, then specify the sorting direction of each
group in the Sort column.

5. To add summaries, go to the Summary screen. Select the group to which the summary will be applied, then add an

,
aggregation object AN as the summary field.

6. In the Query Filter screen, specify the filter you want to apply to the business view.

7. In the Style screen, apply a style to the banded object.

8. Click Finish to create the report.

Creating a table report

Tables give you great control over how to present data, including placing fields, grouping them, and sorting them. A table is
composed of row and columns, and each contains several cells. With such a structure a table is a good way to show any
two-dimensional dataset.

To create a table report:

1. In the New Report Tab dialog, specify the title of the report tab in the Report Title text box, select the desired table
type in the Choose Report Layout box, then click OK to display the Table Wizard.

o Table (Group Above)
Creates a table with group information above the detail panel.

o Table (Group Left)
Creates a table with group information left to the detail panel.

o Table (Group Left Above)
Creates a table with group information left above the detail panel.

o Summary Table
Creates a table with only group and summary information.

2. In the Data screen, select the business view in the current catalog, on which the table will be built.

3. In the Display screen, add the required fields from the Resources box to be displayed in the table. Modify the display
name of any added field if necessary.

M

4. In the Group screen, add the group objects as the grouping criteria, then specify the sorting direction of each

group in the Sort column.
5. To add summaries, go to the Summary screen. Select the group to which the summary will be applied, then add an

.
aggregation object [ as the summary field. For the Group Left table, you can use the Row and Column columns to
control the position of the summary field in the table.

6. In the Query Filter screen, specify the filter you want to apply to the business view.

7. In the Style screen, apply a style to the table.

8. Click Finish to create the report.

Creating a crosstab report
A crosstab summarizes data and presents the summaries in a compact row and column format.

1. In the New Report Tab dialog, specify the title of the report tab in the Report Title text box, select Crosstab as the
layout and click OK to display the Crosstab Wizard.

2. In the Data screen, select the business view in the current catalog, on which the crosstab will be built.

n = o [

3. In the Display screen, select a group object . and click to add it to the Columns or Rows box as a group

,
field. Select an aggregation object AN and click P to add it to the Summaries box as an aggregate field. Repeat this
to add more group/aggregate fields.

4. In the Display Name column, edit the display names of the added group fields or aggregate fields if required. These
will label the rows, columns and summaries when the report is displayed. By default these are blank and no labels will
be created.

5. In the Sort column, specify the sorting manner for the group fields.

6. If you want to remove any group/aggregate field, select it and click * . To adjust the order of the group/aggregate

JJ’ -

fields, select a group/aggregate field and click ir or

7. In the Query Filter screen, specify the filter you want to apply to the business view.

8. In the Style screen, apply a style to the crosstab.

9. Click Finish to create the report.

Creating a chart report

A chart organizes and graphically presents data in a way that makes it easy for end users to see comparisons, trends, and
patterns in data. It represents the report data in a visually straightforward form. A chart is based on the chart platform. On
the platform, the chart paper, the legend, and labels make up the chart. You can create a chart that contains only simple
DBFields, or a complicated chart that contains DBFields, groups, summaries, and even formulas. Normally, DBFields,
summaries, and formulas in a report are represented in a chart using chart data markers, and groups are used to produce
category names and data series names. DBFields can also be used as category names.

To create a chart report:

1. In the New Report Tab dialog, specify the title of the report tab in the Report Title text box, select Chart as the layout
and click OK to display the Chart Wizard.

1. In the Data screen, select the business view in the current catalog, on which the chart will be built.

2. In the Type screen, specify the chart type as required.

A default chart type exists in the Chart Type Groups box. To replace it with another one, select a chart type from the
Chart Type box. The thumbnails of the subtypes in this type will then be displayed in the Subtype box. Select the
required subtype to replace the default chart type.

If you want to create a combo chart, click <Add Combo Type=> of Primary Axis or Secondary Axis in the Chart Type
Groups box, and an additional subtype will be added. To replace the additional subtype, select it, then specify the
required type and subtype respectively in the Chart Type and Sub Type boxes.

To add more subtypes, repeat the procedures. To remove a subtype, select it and click ~
3. In the Display screen, select a group object in the Resources box and add it to the Category or Series box, the
data of which will be displayed on the corresponding axis. Select a subtype in the Show Values box, then add an
aggregation object AN or an additional value [#] as the data of the subtype.
To add an additional value to a subtype:
a. Select the subtype in the Show Values box.

b. In the Resources box, expand the Additional Values node, then select Constant Value/Average Value.

Click =

beside the Show Values box. The Edit Additional Value dialog appears.

d. In the Name text box, specify the display name for the constant/average value.

e. Input the constant value with numeric type in the Value text box, or select a field based on which the average
value will be calculated from the Based On drop-down list.

f. Click OK, and the defined constant/average value will be added to the subtype.

i

If you want to further modify a constant/average value, select the value in the Show Values box, then click °
In the Edit Additional Value dialog, edit the value as required.

You can add more than one aggregation object or additional value to a subtype. Each added subtype shall have at
least one aggregation object or additional value.

4. If you want to define the sort order and Select N condition on the category/series axis of the chart, click the Order/
Select N button below the Category/Series box, then define the condition in the Order/Select N dialog.

To define a sort order and Select N condition on the category/series axis:

a. In the Order box of the Order/Select N dialog, specify in which order values on the category/series axis will be
sorted.

Order/Select N

— Qrder
® Ascend
Descend

Mo Sort

— Select N

Select M: All LN
Based On: ¥ | | Ascend L

Other: other

Ok Cancel Help

b. In the Select N box, specify the Select N condition to All, Top or Bottom. If All is selected, all category/series
values will be shown in the chart; if Top or Bottom is selected, the text field next to it will be enabled and you can
specify an integer here, which means that the first or last N category/series values will be shown in the chart.

c. Check the Based On checkbox and specify values for the two drop-down lists that follow according to your
requirement.

If Based On is unchecked, the order of the first or last N category/series values will be based on what you specify
in the Order box of the dialog; if you check it, the order will be based on values of the summary field and the sort
direction you specify in the drop-down lists next to the Based On checkbox.

d. If you have selected Top or Bottom from the Select N drop-down list, you can check the Other checkbox and the
type a character string in the next text field, so that the category/series values beyond the first or last N range
will be merged into the group with the name as that character string.

e. Click OK to accept the settings.

5. In the Query Filter screen, specify the filter you want to apply to the business view.

6. In the Style screen, apply a style to the chart.
7. Click Finish to create the report.

Notes:

. A JReport Live license for JReport Server is required in order to use this feature. If you do not have the license, contact
your Jinfonet Software account manager to obtain it.

. Before you can create a report tab in Page Report Studio, you need to first make sure that the catalog corresponding to
the current page report contains one or more business views and that the Pop-up Blocker is not enabled on your web
browser.

. If there is only one business view in the current catalog, this business view will be used to create the report by default,
and the Data screen will be hidden from the wizard. This is the same case when there is only one style available to be
applied to the report.
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Adding report objects

For a newly-created or an existing report, if the corresponding catalog contains business views, then
you can add labels, images, banded objects, tables, crosstabs, charts, special fields and web controls to
the report.

Object placement

Objects can be placed within banded objects, tables, tabulars, as well as onto an empty area of a
report. The following table lists the report areas that are valid targets for the various objects, listed on
the left.

Report Layout Area

Page Report SEmelee) Banded Selmeee
. g P Report |Banded | Page Group Table | Tabular
Object Header/ | Header/ ] Header/
Body Detail Header/ Header/ [Cell Cell
Footer Footer Footer
Footer Footer

Banded object Y N Y Y Y Y Y N Y
Chart Y Y Y Y Y Y Y N Y
Crosstab Y Y Y Y Y Y Y N Y
Table Y Y Y Y Y Y Y N Y
Group object Y Y Y Y Y Y Y Y Y
Detail object Y Y Y Y Y Y Y Y Y
Aggregation N N Y N N Y Y N N
object
Formula Y Y Y Y Y Y Y Y Y
Label Y N Y Y Y Y Y Y Y
Special field Y N Y Y Y Y Y Y Y
Image Y N Y Y Y Y Y Y Y
Web control Y Y Y Y Y Y Y N Y

To add an object into a report:

1. Click Menu = Insert, then click the command corresponding to the object you want to add.

2. Point to the destination where you want the object to be added, and then click the mouse button.

o If you specify to add a label, a label will be inserted there. Edit the text of the label and format it
according to your requirements.

o If you specify to add an image, the Insert Image dialog will be displayed. Select the image you
need and click OK to insert it into the report.

o If you specify to add a banded object, table, crosstab, or chart, the corresponding report wizard
will be displayed. Specify the settings in the wizard according to your requirements. For details,
see the specific topic in Creating a report tab.

o If you specify to add a special field, the special field will be inserted there.

o If you specify to add a parameter control, parameter form control, or filter control, the
corresponding insert control dialog will be displayed. For how to specify the settings in the dialog
and the usage of the web control, see Applying web controls.

o If you specify to add a navigation control, a navigation control will be inserted there. For the
usage of the navigation control, see Applying web controls.

Alternatively, you can also use the Toolbox panel to add objects other than special fields into a report
by dragging them from the panel to the destination. However, in order to use the Toolbox panel to add
components, you should make sure that this ad hoc feature is enabled in the specified Page Report

Studio feature profile. This setting can only be made by administrators.

Note: A JReport Live license for JReport Server is required in order to use this feature. If you do not
have the license, contact your Jinfonet Software account manager to obtain it.
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Applying web controls

In Page Report Studio, these four types of web controls can be applied: parameter control, parameter form control,
filter control, and navigation control. This section describes each of the web controls and how to use them.

Note: A JReport Live license for JReport Server is required in order to use this feature. If you do not have the license,
contact your Jinfonet Software account manager to obtain it.

Using parameter control to specify a parameter to a report

A parameter control is a web control that is bound with a parameter used by the current report. By specifying values to
the parameter in a parameter control, you can pass the parameter values to JReport and run the report with the
specified values.

Cascading parameters cannot be used in parameter controls. If you want to do this, use parameter form controls
instead.

To insert a parameter control and use it to specify a parameter to a report:

1. Do either of the following:

o Click Menu > Insert > Parameter Control, then point to the destination where you want to add the
parameter control and click the mouse button.

o Drag Parameter Control from the Toolbox panel to the destination in the report.

The Insert Parameter Control dialog appears.

Insert Parameter Control

Select a Parameter:
¥ [ Data Source 1
[af] P_StartDate
[af] p_EndDate
[aB] P_TerritoryFilter
[a6] P_ShipperNameFilter

Cancel Help

2. Select the parameter you would like to add to the parameter control, then click OK.

3. A parameter control will be added into the report. Specify the value for the parameter. You may specify the value
in one of these ways.

4. Once the value in the parameter control changes, the report will rerun with the new parameter value.

Note: If the specified parameter is no longer used in the report, the parameter control will become invalid.

Using parameter form control to run reports

A parameter form control is a web control that is bound with the parameters used by the current report or other
reports. By specifying values to the parameters in a parameter form control, you can make the reports run with the
specified parameter values.

To insert a parameter form control and use it to run report:
1. Do either of the following:

o Click Menu > Insert > Parameter Form Control, then point to the destination where you want to add the
parameter form control and click the mouse button.

o Drag Parameter Form Control from the Toolbox panel to the destination in the report.

The Insert Parameter Form Control dialog appears.

Insert Parameter Form Control
Flease Select Target Reports:

® Current Report Others
Select Parameters:
¥ [ Data Source 1
[aB] P_StartDate
[a8] p_EndDate
[at] P_TerritoryFilter
[a] P_ShipperNameFilter

¥| Include "Submit" Button Cancel Help

N

Specify the target reports to run using the parameter form control.

o To run the current report, select Current Report, then specify the parameters used to run the report from the
Select Parameters box.

o To run other reports, select Others, then select the reports you want to run. If all the selected reports contain
no parameters, you cannot finish the dialog.

3. Specify whether to include the Submit button in the parameter form control. If Submit is included, it is used to
submit the parameter values you specified in the parameter form control. If Submit is not included, once you
change the values of a parameter in the parameter form control, the new values will be applied automatically.

4. Click OK in the dialog to save the changes.

The parameter form control is now inserted in the report. It lists the selected parameters for the current report or
lists all parameters used by the specified reports.

5. In the parameter form control, specify values of the listed parameters. You may specify the values in these ways.

6. Click the Submit button to run the current report or the specified reports if the button is available. If there is no
Submit button, the change of values in the parameter form control will trigger report rerunning.

Note: If you save or publish a report containing a parameter form control to another directory, the reports that you
bind the parameter form control with will not be saved or published along with the report.

Using filter control to filter report data

A filter control is used to filter one or more data components in a report, which refer to tables, banded objects, charts,
and crosstabs. For how a filter control works, see Filtering scenarios.

To insert a filter control and use it to filter report data:
1. Do either of the following:

o Click Menu > Insert > Filter Control, then point to the destination where you want to add the filter control
and click the mouse button.

o Drag Filter Control from the Toolbox panel to the destination in the report.

The Insert Filter Control dialog appears.

Insert Filter Control

Select Fields:

[:% CrosstabanalysisRC

~ w = Group By

Product Category
Flan Country
Product Name
Product Type
Fegion

Sales Month
Sales Quarter
Sales Year
State

Territory

ales Performance
Actual Quantity
Actual Sales
Cost

Gross Margin
Flan Sales
Actual Price

I

1
[
(¥

o

Apply Toil<all= v Ok Cancel Help

2. From the resource list, select the fields of the same data type to bind to the filter control.
To filter components created from the same data source, select a field in the data source.

To filter components created from different data sources, find a common field these data sources contain, then
select the field in each of the data sources.

3. The Apply To drop-down list provides the components involving the selected fields. Select the components which
you want to filter.

4. When done, click OK.

The filter control is inserted in the report. It lists all values of the specified fields. You can select one or more
values to apply.

After inserting filter controls in the report, you can also insert a navigation control for undoing/redoing the value
selection in the filter controls. For details about the usage of navigation control, see Using navigation control to undo/

redo value selection in filter controls.

Managing a filter control

After right-clicking on the title bar of a filter control, these options are available for managing the filter control.

-
Country e erCantal: L ) X
Ll Rl L

Australia
Belgium
Brazil
Canada
Chile
China
France
Germany

ftahy )
Japan Hide

Properties...

O i &7

L
g

Search
Clear

Sort

X OR

Celete

Kazakhstan
Malayzia
Mexico
Metherlands
Poland

. Properties
Opens the Filter Control Properties dialog for editing the properties of the filter control. The dialog provides an entry

to changing the data fields that the filter control is based on and the application scope. To do this, in the General tab,

click "*** beside the Filter On text box. Then in the Select Field dialog, change the settings as you like and click OK.

. Search
Displays the quick search toolbar which enables you to search values in the filter control. You can also click the

button L on the title bar of the filter control to launch the quick search toolbar.
o

The following are details about the usage of the quick search toolbar:

» Text field
Type in the text you want to search for in the text field and the matched text will be highlighted among the field
values.

o X
Closes the quick search toolbar. You can also click outside of the quick search toolbar to achieve this.

-

Lists the advanced options.

« Highlight All
Specifies whether to highlight all matched text.

« Match Case
Specifies whether to search for text that meets the case of the typed text.

« Match Whole Word
Specifies whether to search for text that matches a whole word and ignore partial word matches.

Highlights the next matched text.

Highlights the previous matched text.

. Clear
Y
Cancels the selection of values in the filter control. You can also use the button “< on the title bar to cancel the

selection. This operation can be undone/redone.

. Sort
Sorts the values in the filter control in the ascending or descending order.

. Delete
Removes the filter control from the report and the filter you created with the filter control will be removed from the
report too. You can also use the close button on the title bar to remove the filter control.

. Hide
Hides the filter control.

Cascading relationship between filter controls

When there are filter controls that apply to the same data components, and when these controls’ fields have cascading
relationship, the cascading relationship will be revealed when you select values in the controls.

For example, there is a filter control based on the field Country, a filter control on City, and another on State. The first
two share one table while the third shares nothing with the other two. In this case, Country and City values will show
cascading relationship, but State values will not participate. You select USA in the Country filter control, the values in
the City filter control will change as follows if the control has scrollbar: the cities belong to USA are displayed in the
upper area of the filter control, and the other cities are put in the lower area and grayed out. For the case that the City
filter control has no scrollbar: all the values remain their positions and the values not belonging to USA are grayed out.
In both cases all the values are selectable. But the State values remain as before, since the selection of them will not
affect the data components that the Country and City filter controls control.

Using navigation control to undo/redo value selection in filter controls

A navigation control can be considered as an accessorial control for filter controls and is used to deal with the value
selection operations in all the filter controls in the same report.

To insert a navigation control into a report, do either of the following:

. Click Menu > Insert > Navigation Control, then point to the destination where you want to add the navigation
control and click the mouse button.

. Drag Navigation Control from the Toolbox panel to the destination in the report.

A navigation control is a combination of three buttons:

. Back
Goes back to the previous value selection status and refreshes the report data accordingly.

. Clear
Removes all the value selection histories and all the filter conditions based on the selections, and refreshes the report
data accordingly.

. Forward
Goes forward to the next value selection status and refreshes the report data accordingly.
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Making simple modifications to report objects

By virtue of Page Report Studio’'s powerful ad hoc functions, you can make simple modifications to
report objects at runtime while viewing the report in Page Report Studio.

Note: Except for showing/hiding objects, a JReport Live license for JReport Server is required in order

to use all the other features introduced in this document. If you do not have the license, contact your
Jinfonet Software account manager to obtain it.

Moving an object

A table, banded object, chart, crosstab, tabular, or image, can be easily moved to a new position. What

you need to do is click anywhere in the object, then drag the icon appearing at its upper left corner
to the destination. After Page Report Studio has finished processing, the object will be redrawn in the
new location.

For other objects, select it and move it to the new position.
Notes:

. Before you can move any object in a report, you need to first make sure that the Page Report Studio
window is in the Interactive View mode.

. For reports designed in JReport Designer, only the objects whose Position property value is absolute,
and the DBFields or labels which have been defined as a view element can be moved in Page Report
Studio.

Resizing an object

To resize an object, click anywhere in the object, when the icon appears at its upper left corner,
click the icon to select the object, then you will see that it is surrounded by a rectangle with three
resizing handles. Point to a handle, when the mouse pointer turns to a double-headed arrow, you can
drag the handle to resize the object.

To resize a panel in a banded object, select it and drag the resizing handle to the desired position.

To adjust the width/height of a column/row in a table, point to the right/lower boundary of the column/
row, when the mouse pointer becomes a horizontal/vertical double-headed arrow, drag the handle and
the width/height of the column/row will change. This will also resize all cells in the column or row.

For a crosstab, you can resize its rows and columns the same as you do with a table.

For a tabular, point to the boundary between two cells and the mouse pointer will become a double-
headed arrow, you can then drag the boundary to adjust the size of the related cells.

To change the width and height of a field, click any value of this field to select it, then drag the right or
lower resizing handle on its borders to a new position, and the width or height of the field will change.
You can also do this for any label.

Notes:

. When resizing table rows:

o If you resize the table header, only the height of the header will be changed. However, when you
resize any row except the header, the height of all rows in the table will be changed at the same
time.

» If there are some groups in a table and the height of one group row is changed, the other group
rows will not be resized.

. When resizing crosstab columns/rows:

o If you resize the horizontal/vertical header of a crosstab, other rows/columns will not be affected.

o If you resize the total column/row of a crosstab, other columns/rows will not be affected.

Hiding/showing an object

To hide a table, banded object, chart, crosstab, or tabular, click on the object, when the icon
appears at its upper left corner, right-click on the icon and then select Hide from the shortcut menu.
For other objects such as text boxes, drop-down lists, fields, and labels, right-click it and then select
Hide to hide it.

To show a hidden object, right-click the object containing it, then on the shortcut menu, select the
object name from the Show submenu.

Splitting and merging cells in a tabular
Adjacent cells in a tabular which can form a rectangle may be merged into one cell.

To merge adjacent cells, select them one by one while holding the Ctrl key, then click Menu > Report
> Merge, and these cells will be merged into one cell.

To split a cell:

1. Select the cell and click Menu > Report > Split.

2. In the Split dialog, specify the number of rows and columns.

3. Click OK and the cell will be split.

Modifying object properties

Page Report Studio allows you to modify object properties with the corresponding properties dialog.
However for some objects, you must be an advanced user in order to edit their properties.

. To edit the properties of any object in a report, right-click on the object and select Properties from
the shortcut menu. If it is a table, crosstab, chart, banded object, or tabular, click anywhere on it,

when the icon appears at its upper left corner, right-click on the icon and click Properties on the
shortcut menu. In the corresponding properties dialog, specify the settings as required. For a table,
you can also right-click any field or cell in it and select Table from the shortcut menu to show the
Table Properties dialog. For detailed explanation about options in the properties dialogs, refer to the
specific topics in Page Report Studio dialogs.

. You can right-click a group header/footer panel in a banded object, and then select Group to show
the Group Properties dialog in order to define the group properties.

. To edit the properties of a report tab, right-click the blank part of the report tab and select Report
from the shortcut menu, then in the Report Tab Properties dialog, configure the properties as

required.

Tip: If you just want to modify the text related properties for a field or label, for example, you want to
change the text alignment or make the text bold, you can achieve it by simply selecting the field or
label, then clicking the corresponding buttons on the toolbar.

Deleting an object

An object can be removed from the report if it is no longer required. However, objects that are in a
subreport cannot be deleted.

. To delete a table, banded object, chart, crosstab, tabular, or image, click on the object, when the

icon appears at its upper left corner, right-click on the icon and select Delete from the shortcut
menu, or you can drag the icon outside the report page. Then, a message box will prompt, asking for
your confirmation. Click OK in the message box so as to remove the component.

. For a field, you can drag any value of the field outside the report page to remove it. You can also
drag any label outside the report page to remove it. Right-clicking and then selecting Delete is
another way to achieve this.
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Saving the report

You can save your report in a Page Report Studio window. To do this, click Menu > File > Save (or

£

the Save button

on the Standard toolbar). The Save Report Template dialog appears. The Sort

and Filter options in this dialog signify whether or not to include the sort and filter criteria when saving.

Specify the options as required, then click OK, and the report will be saved as a report version.

If the report is newly created and has not yet been saved, the Save As dialog appears.

Save As
Save In: [[] SampleReports

Name

@ Banded_Link.cls

@ Cascading Parameters.cls

@ Cascading Parameters_subl...
@ Cascading Parameters_sub2...
|E| Combo Report and Drilling (5...
@ Combo Report and Drilling.cls

File Name: Banded_Link.cls

File Type: | _rls

Advanced==

1. In the Save in section, browse to the folder where you want to save the report in the server

resource tree. The folder may be Public Reports or My Reports. You can use the button

to the parent folder.

The resource table shows the resources in the current directory. Click the column names to
change the order of the report in the table list if required.

Size
40 KB
41 KB
99 KB
98 KB
26 KB
112 KB

Type
Pagereport
Pagereport
Pagereport
Pagereport
Pagereport
Pagereport

QK

Last Modified
9722/2015 4:48:
972272015 4:48:
0/22/2015 4:48:
072272015 4:48:
972272015 4:48:
972272015 4.:48:

Cancel

2. In the File Name box, enter the name of the report or use the default name.

3. From the File Type drop-down list, specify the type of the saved report.

23 PM
a6 PM
56 PM

28 PM
28 PM

Help

4. Click the Advanced button to set the advanced settings for the report if required.

a. The catalog that the report uses is shown.

to go

Specify the relationship between the saved report and the catalog used to run it (activated
only when Select Catalog Linked Model is checked in the Profile > Customize Profile > Page
Report Studio > Properties > Advanced tab):

«» Set Original Catalog as Linked Catalog into Saved Page Report
If checked, the saved report will be linked with the catalog and the saved report will run
with the catalog no matter whether the two are in the same directory. If later the catalog is
updated, the saved report will run with the latest version of the catalog.

« Set Catalog Copy to Public Reports/My Reports

If checked, the catalog will be copied to the directory where the report is saved and the
saved report will run with the copied catalog.

b. If you want to save the report together with the sort and filter criteria, check Save Sort
Criteria and Save Filter Criteria correspondingly. With the criteria saved, Page Report

Studio will automatically apply them to the report the next time it is opened.

c. Optionally, input comments in the Description box as a description for the report.

5. Click OK to save the report.

To save a copy of a report, click Menu > File > Save As (or the Save As button
toolbar) to show the Save As dialog, and then do as above.

Notes:

(2

on the Standard

. You will not be able to save the report to some locations if you do not have the required permissions.
You need to have Write access to the directory.

. If one of the report tabs in a report contains subreports, when you save the report, changes you

have made on the subreports will not be saved along with the primary report.

. To find a newly saved report version, browse to select the row that the report is in on the JReport

Console > Resources page, click Tools > Version on the task bar, and then click the Report

Versions tab.
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Exporting the report result

When you are satisfied with the result of the active report, you may want to export it as a result

version or as a local file to other formats.

The following topics describe exporting report result in detail:

Exporting the result from a Page Report Studio window

Exporting the result by using a JavaScript function

Customizing buttons for one-step exporting

Controlling user access to different export formats

Customizing warning messages

Note: If the report you are going to export is linked to another report, in the exported results, the link
will no longer be available.
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Exporting the result from a Page Report Studio window

You can export the report result from a Page Report Studio window to other formats by taking the following
steps:
1. Click Menu > File > Export (or the Export button on the Standard toolbar) to display the Export

dialog.
Export
File Name: reportl
® View Report Result Save to File System Save to Version System

Select Report Tabs:

Select Format: PDF W

P ;
\Z/ Less Options

Style Group: =MNo Style= ¥
Mo Margin Maode
TocC ® Generate charts and barcodes using images (recommended)
Generate charts and barcodes using vector graphics
Drilldown
Sign Settings...
Encrypt Settings...
¥| Compress Image 20 %

Fun Linked Report

K, Cancel Help

2. In the File Name field, specify the name of the exported result file.

3. Specify the destination of the result:

o Save to Version System: The result will be saved as a result version in JReport Server's versioning
system.

o Save to File System: The web browser will prompt you to save the result file to a specified folder. If
selected, you need to provide a name for the result file in the File Name field.

o View Report Result: The result will be directly opened in the web browser if the format is supported
by a plug-in of the web browser; otherwise it will prompt you to save the result file.

4. In the Select Report Tabs box, specify the report tab(s) which you want to export. The selected report
tabs will be exported in the list order. You can change the report tabs order by clicking it or ok .

5. From the Select Format drop-down list, select the format in which to export the result: HTML, PDF,
Excel, Text, RTF, XML, PostScript, or Page Report Result.

6. To specify the additional setting of the selected format, click More Options.

7. From the Style Group drop-down list, select the style group you want to apply to the exported report
result. If No Style is selected, the style group property predefined for the specified export format in
JReport Designer will be applied to export the report result to that format.

8. Set the other properties for the selected format as required (for details about properties of each format,
see Export dialoq).

9. Click OK to confirm.
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Exporting the result by using a JavaScript function

JReport Server provides you with a JavaScript function which allows you to open the report result or
export it in a specified format. You can find this function in the file APl.js in <server _install _root>

\public_htm\javascript\dhtm , as shown below:

function user_oneSt epExport (type,

opti ons)

The following explains this function's two arguments, type and options, in detail.

type - Specifies the export format.

. HTML=0
. PDF =2

. PS=3

. RTF =4

. TEXT =5
. EXCEL =6
. XML=7

options - Specifies the values of the options of each format. It is a string array whose member is of
the format "key=value". The options and their usage are listed as follows:

Key

HTML

to_ver

to_open

to_local

browser

imagetype

overflow

resolution

title
applet

CSS

multi

hyperlink

pagenumber

drilldown

no_margin

absolute

PDF

to_ver

to_open

to_local

no_margin

simulate

standard

content

drilldown

encrypt

compress

ratio

compatibility

doc_psw

permi_pasw

printing

changes

enable_copy

enable_access

PostScript

to_ver

to_open

to_local

no_margin

RTF

to_version

to_open

to_local

rtf_flow

no_margin

Text

to_ver

to_open

to_local

repeat

compress

win_linebreak

normal

quote_mark

head_foot

delimiter
width
height
Excel

to_ver

to_open

to_local

wrap

new_layout

shapes

excel_2000

advanced

header
footer

gridline

XML

to_ver

to_open

to_local

only data

schema

Notes:

Description

Specifies whether or not to save the result to
version.

Specifies whether or not to export and open the
result file.

Specifies whether or not to save the result to a
local file.

Specifies the web browser type.

Specifies the type of the images in the result file.

Specifies the overflow type.

Specifies the HTML resolution.

Specifies the title for the HTML file.

Specifies whether or not to export chart in Java
applet format.

Specifies whether or not to embed the cascading
style sheet in the exported HTML files.

Specifies whether or not to generate an HTML file
for each page of the report result.

Specifies whether or not to contain hyperlinks in
the HTML file.

Specifies whether or not to contain page numbers
in the HTML file.

Specifies whether or not to include the drilled-down
file in the exported HTML file.

Specifies whether or not to remove the original
margins.

Specifies whether or not to make the font size fixed
in the web browser.

Specifies whether or not to save the result to
version.

Specifies whether or not to export and open the
result file.

Specifies whether or not to save the result to a
local file.

Specifies whether or not to remove the margin.

Specifies whether or not the mode is to be
Simulated Printing Mode.

Specifies whether or not to set the mode as
Standard Mode.

Specifies whether or not to contain the TOC in the
exported PDF file.

Specifies whether or not to include the drilled-down
file in the exported PDF file.

Specifies whether or not to encrypt the report
result.

Specifies whether or not to compress the images in
the report.

Specifies the percentage with which to compress
the images in the report.

Specifies the encryption compatibility.

Specifies the password for opening the PDF file
when encrypt=true.

Specifies the password for printing and editing the
PDF file when encrypt=true.

Specifies the PDF printing mode.

Defines which editing actions are allowed in the
PDF file.

Specifies whether or not to allow users to copy the
file contents.

Specifies whether or not to let visually impaired
users read the document with window readers.

Specifies whether or not to save the result to
version.

Specifies whether or not to export and open the
result file.

Specifies whether or not to save the result to a
local file.

Specifies whether or not to remove the margins in
the PS file.

Specifies whether or not to save the result to
version.

Specifies whether or not to export and open the
result file.

Specifies whether or not to save the result to a
local file.

Specifies whether or not to apply a flow layout
when exporting the report to RTF.

Specifies whether or not to remove the margins in
the RTF file.

Specifies whether or not to save the result to
version.

Specifies whether or not to export and open the
result file.

Specifies whether or not to save the result to a
local file.

Specifies whether or not to replace a field value of
a record with that of its previous record if the field
value is null.

Specifies whether or not to compress the clearance
between columns.

Specifies whether or not to use Windows end-of-
line characters.

Specifies whether or not to generate the report
result to a standard text file.

Specifies whether or not to mark the fields in the
exported file with quotation marks.

Specifies whether or not to contain all headers and
footers in the report.

Specifies the delimiter.
Specifies the user-defined character width.

Specifies the user-defined character height.

Specifies whether or not to save the result to
version.

Specifies whether or not to export and open the
result file.

Specifies whether or not to save the result to a
local file.

Specifies the word-wrap setting.

Specifies whether or not to use the new layout
mode.

Specifies whether or not to include the shapes in
the exported file.

Specifies whether or not to export the result in
Data Format, which means only the report data will
be exported without format.

Specifies whether or not to apply the advanced
options.

Specifies the page header text.
Specifies the page footer text.

Specifies whether or not to print gridlines when
printing the exported Excel file.

Specifies whether or not to save the result to
version.

Specifies whether or not to export and open the
result file.

Specifies whether or not to save the result to a
local file.

Specifies whether or not to only contain the
database column information in the exported XML
file.

Specifies the name of an existing schema file with
its full path with which to generate the XML file.

Available Value

true, false

true, false

true, false

0 - IE or Chrome

1 - Firefox
0 - Decided by JReport

1-GIF
2 - JPG
O - VISIBLE
1 - HIDDEN

2 - VERFLOWCOUNT

Any integer between 1 and
4294967296

Any string
true, false

true, false

true, false

true, false

true, false

true, false

true, false

true, false

true, false

true, false

true, false

true, false

true, false

true, false

true, false

true, false

true, false

true, false

Any integer between 1 to 100

0 - Acrobat 3.0 and later

1 - Acrobat 5.0 and later
Any string

Any string
0 - Prevents users from

printing the file

4 - Allows low resolution-
printing

2052 - Allows high-resolution
printing

0 - Prevents users from
making any changes to the file

1024 - Allows inserting,
deleting, and rotating pages

256 - Allows users to fill in
form fields and adding digital
signatures.

32 - Allows users to fill in form
fields and add digital
signatures and comments

40 - Allows users to do
anything except extracting
pages

2108 - Allows all

true, false

true, false

true, false

true, false

true, false

true, false

true, false

true, false

true, false

true, false

true, false

true, false

true, false

true, false

true, false

true, false

true, false

true, false

true, false

true, false

Any single character
An integer

An integer

true, false

true, false

true, false

0 - All Keep Existing
1 - All Disabled
2 - All Enabled

true, false

true, false

true, false

true, false

Any string
Any string

true, false

true, false

true, false

true, false

true, false

An existing schema file with its
full path.

Default
Value

false

false

false

96

true

false

false

false

false

false

false

false

false

false

false

false

true

false

false

false

false

false

20

false

true

false

false

false

false

false

false

false

false

false

false

false

false

false

false

true

true

false

true

false

false

false

true

false

false

false

false

false

false

false

false

. The three options to_ver, to_open, and to_local are mutually exclusive, that is, only one of them
should be true, and the rest false. If you set two or three of them to true, JReport will only accept
the first true and treat the rest as false. If you set all three to false, JReport will consider to_open as

true.

. In the string array options, the members are separated by commas (","). You can arrange the

members in any order, and omit those keys where you want to use the default value. For example,
you can define a variable html_options:

var htm _options = ["i nmagetype=1",
"no_mar gi n=f al se",

“"title=hello world"];

"resol uti on=120",

“hyperlink=true",

Then, you can use user _oneSt epExport (0, htnl _options) to obtain a URL for exporting the report
result in HTML format.

. JReport also provides the function user_downloadReport(type, options) whose usage is similar to
user_oneStepExport.
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Customizing buttons for one-step exporting

Seven buttons are provided for one-step exporting. They are Export to PDF, Export to Excel, Export to
RTF, Export to HTML, Export to Text, Export to PS, and Export to XML. By default, the buttons are
invisible on the toolbar area. You have to add them to the toolbar area by modifying the index.jsp file
in<install _root>\public_htm\dhtnjsp.

Use the following two API functions to control the buttons:
. public void customizeToolbar(String Sessionld, String RptSetld, String toolbarname, int[] buttonid);

. public void customizeToolbar(String Sessionld, String RptSetld, String toolbarname, int[] buttonld,
boolean isVisible);

Explanation of these parameters:

. Sessionld - session ID, which can be retrieved by DHTMLUtil.getSessionID(request).

. RptSetld - report ID, which can be retrieved by obDHTMLUtil.getRptSetld(request).

. toolbarname - toolbar name, such as "Standard"”, "Analysis", "View", or user-defined ones.

. buttonld[] - toolbar button ID. It is an integer array, so you need define an integer array variant.

For example: int[] mybuttonid ={DHTMLConstant. TOOLBAR_EXPORTTOPDF, DHTMLConstant.
TOOLBAR_EXPORTTOXLS, TMLConstant.BTN_EXPORT_TO_RTF}

The array elements available for one-step exporting are:
o DHTMLConstant. TOOLBAR_EXPORTTOPDF

o DHTMLConstant. TOOLBAR_EXPORTTOXLS

o DHTMLConstant. TOOLBAR_EXPORTTORTF

n DHTMLConstant. TOOLBAR_EXPORTTOHTML

o DHTMLConstant. TOOLBAR_EXPORTTOTEXT

o DHTMLConstant. TOOLBAR_EXPORTTOPS

o DHTMLConstant. TOOLBAR_EXPORTTOXML

. isVisible - whether or not to show the buttons defined with buttonID[]. true -- show, false -- hide.
This parameter can be absent, and then the value is true.

For example, if you want to add the Export to HTML button to the Export toolbar, then:
1. Open the file index.jsp.

2. Add the code

int[] tenparray = {DHTM.Const ant. TOOLBAR EXPORTTCHTM.};
dht m Confi g. cust omi zeTool bar (Sessionl D, RptSetld, "Standard", tenparray, true);

before

/[l <!-- Tool Bar -->
i f (dhtm Confi g.i sFeat ur eEnabl ed( Sessi onl D, RptSetld, DHTM.Constant.
FEATURE_TOOLBAR) ) {

3. Start JReport Server.

4. Run a report in Page Report Studio, and you will see a new button Export to HTML is displayed on
the Export toolbar.

To add more than one button to the toolbar area, for example, adding Export to HTML and Export to
PDF buttons to the Export toolbar:

1. Open the file index.jsp.

2. Add the code

int[] tenparray = {DHTM.Const ant. TOOLBAR_EXPORTTOHTM., DHTM.Const ant .
TOOLBAR_EXPORTTOPDF} ;

dht m Confi g. cust om zeTool bar (Sessionl D, RptSetld, "Standard", tenparray, true);
before

//<!-- Tool Bar -->
i f(dhtm Confi g.i sFeat ureEnabl ed( Sessi onl D, RptSetld, DHTM.Constant.
FEATURE_TOOLBAR) ) {

3. Start JReport Server.

4. Run a report in Page Report Studio, and you will see the buttons Export to HTML and Export to
PDF are displayed on the Export toolbar.

5. Click the added button on the toolbar of the report page, the report will be exported to the
corresponding format, using the default values of the format options.
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Controlling user access to different export formats

JReport introduces an access control ability which can restrict different users to export report result to
different formats.

How to realize the access control ability

You can restrict the report result formats for users by passing values to a variable. That is the global
variable enableTypes in both customize_panel.jsp and save_result.jsp files in <i nstal | _root >

\ public_htm \dhtnljsp folder. The value of enableTypes should be Integer, and JReport gives you the
following integers to represent the corresponding report result types:

Report Result
Format

HTML
PDF

Excel
Text

RTF

XML
PostScript

Int. Value

o 00~ W NP O

You can specify a value or an array to enableTypes using the integers in the above table. Or you can
also use the integers which are not mentioned above, but if you do so, the Int. values will be ignored,
and do not function. That is to say, if you pass the array {1,2,5,9,-2} to enableTypes, 9 and -2 will be
ignored and {1,2,5} will work, so PDF, EXCEL, XML formats can be in use.

Example

Assume that there are two users, userl and user2. When userl logs on, run a report in Page Report
Studio, he can only export the report result as PDF and HTML formats. While user2 can export the
report result as RTF and XML formats when logging on. To realize it, you can use the following codes in
customize_panel.jsp or save_result.jsp file:

int[] enabl eTypes=null;

String User Nane=nul | ;

User Name=DHTM_.U i | . get User Name( r equest) ;
i f (User Nare. equal sl gnor eCase("user1"))
enabl eTypes=new int[]{1, 0};

i f (User Nane. equal sl gnor eCase("user2"))
enabl eTypes=new i nt[]{4, 5};
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Customizing warning messages

You can customize the warning messages when exporting the report result to XML through Page Report
Studio. With this function, you can specify what you want to show as a warning message. The custom
warning messages are supported across web browsers.

To customize the warning messages, you need to customize the jsp files using either of the following
two methods:

Method 1

1. Open the save_result.jsp file in the <i nstal | _root >\ publ i c_ht m \ dht m j sp folder with your
favorite editor.

2. Specify the value of customMsgForXML in the save_result.jsp to whatever you want. The value
cannot be " or null.

3. Run a report in Page Report Studio, click Menu > File > Export to display the Export dialog.

4. Select XML from the Select Report Result Format drop-down list, and if necessary, modify other
properties as required, then click OK.

5. A warning message shows as you have defined.

Method 2

You can also export the report result via the Export panel instead of clicking Menu > File > Export. By
default, the panel is hidden. So, the following is another way to create custom warning messages:

1. Open the customize_panel.jsp file in the <i nstal | _root >\ publ i c_htm \ dht m j sp folder with your
favorite editor.

Set the class of panelDIV to visibleMargin to show the Export panel on web browser.
Specify the value of customMsgForXML in customize_panel.jsp.

Run a report in Page Report Studio, and the Export panel together with the report shows.

a A WO DN

Select XML from the Select Report Result Format drop-down list, and if necessary, modify other
properties as required, then click OK.

6. A warning message shows as you have defined.

For example, using method2, when you need to export the report result as XML, and if you want to
show "This is IE Browser" while browser is IE, you need to set panelDIV in customize_panel.jsp file to
visibleMargin as follows:

<di v id="<%DHTM.Const ant . DHTM._PREFI X%panel DI V' cl ass="vi si bl eMar gi n">

And then customize CustomMsgForXML in the same jsp file as follows:
String browser Name=r equest . get Header (" User - Agent ") ;
String customvsgFor XML ="This is "+browser Nane;

Access JReport Server via IE, run a report in Page Report Studio, select XML from the Select Report
Result Format drop-down list in the Export panel, and click OK. Then a pop-up box will show you "This
is IE Browser".
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Analytic reporting

Page Report Studio provides you with a convenient and powerful tool to analyze your business
information. By providing secure web access to business data and making the data interactive, Page
Report Studiofacilitates data analysis.

Page Report Studio enhances the utility of production reports by making them interactive - allowing
you to define your view of data to make it more useful. Through a user-friendly web GUI, report
contents can be easily navigated, drilled, and viewed in detail.

Page Report Studio uses the Resource View panel to provide a business-oriented view of databases.
This view shields end users from having to understand database connectivity and SQL syntax while
allowing IT professionals to maintain control of business data and to ensure its integrity. Using the
Resource View panel, Page Report Studio dynamically builds SQL statements to retrieve data and
automatically generate multidimensional data views. These views contain the underlying data structure
which makes data analysis possible.

The following topics describe the analytic reporting features:

. An introduction to business views

. Applying filters

. Using view elements

. Using dynamic resources

. Drilling through the report data

. Manipulating data components

. Adding conditional formats to fields

. Converting between components

. Sorting report data

. Searching for text in a report

Note: A component created in JReport Designer is based on a dataset, while that created in Page
Report Studio is based on a business view. For the former, if you want to do analytic actions in Page
Report Studio, such as adding a view element, converting the component type, drilling it, or changing
chart definition, Page Report Studio will need to convert its fields to view elements.
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An introduction to business views

A business view, which is needed for creating multidimensional data views, contains database
connections and relationships between view elements. The business view shields report end users from
having to understand the physical structure of a data source, and enables them to build reports and
analyze data based on a set of view elements they can understand. It also enables IT professionals to
maintain control of the business data and ensure its integrity, while presenting end users with an
intuitive view of the underlying data structures.

To make use of a business view, you need to first define it at report design time in JReport Designer.

A business view may contain category objects and view elements (group objects, aggregation objects,
and detail objects). You can insert these view elements or remove them to change the report result
when you view reports in Page Report Studio.

Category objects
Category objects contain a collection of view elements. A business view may contain more than one

category. In the Resource View panel, the icon |:| indicates that an object is a category. Categories
are only for categorizing view elements, and they cannot be inserted into a report. The category is
often used for indicating the name of the underlying DBMS table.

Group objects
Group objects are view elements that will become the basis for analysis in a report. They

characteristically return text or date values. In the Resource View panel, the icon indicates that
an object is a group object. A group object can be inserted wherever a group field can be inserted
into. It can be inserted as a column or row field in a crosstab, or as a group field or detail field in a
banded object or a table, or displayed as category/series field in a chart.

Aggregation objects
Aggregation objects are numeric view elements that are calculated dynamically at runtime. The icon

AN indicates that an object is an aggregation object. An aggregation object can be inserted
wherever a summary can be inserted. For instance, it can be inserted into the group header or footer
panel in a table or banded object, or into a crosstab as an aggregate field. An aggregation object can
also be used as a detail field in a banded object or table although it will display the same aggregate
value for every detail line. Page Report Studio will calculate the summary values based on the group
level the aggregation object has been inserted into.

Detail objects

Detail objects provide additional information. The icon — indicates that an object is a detail object.
It can be inserted wherever a DBField can be inserted. For example, you can insert a detail object
into a table or banded object as a detail field.
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Applying filters

You can apply some filter to a page report so as to narrow down the data displayed in the report. The filters can be applied
to the business views used by data components such as banded objects, tables, crosstabs and charts in the report, or to the
data components themselves.

Applying filters to business views

For data components created on business views in a page report, you can apply some filters to the business views they use
to narrow down the data scope of the business views. Filters for business views are defined into two categories in Page
Report Studio: predefined filters and user defined filters. As the name suggests, predefined filters are defined on business
views in advance in JReport Designer, and user defined filters are created on business views while they are used in Page
Report Studio.

To apply a filter to the business view a data component uses:

1. Select the component by clicking anywhere in it, and then clicking the icon at the upper left corner of the
component.

2. Click Menu > Report > Query Filter, or right-click the component and select Query Filter from the shortcut menu to
display the Query Filter dialog.

All the predefined filters of the business view the data component uses are listed in the Query Filter drop-down list.
Choose the one you want to apply. If you want to further edit the filter, click the Edit button and then redefine the
filter as required. The edited filter will then be saved as a user defined filter to the business view.

If you prefer to define a filter on your own, select User Defined from the Query Filter drop-down list, then define the
filter according to your requirements.

There are the basic and advanced modes of the dialog for you to define either simple or complex filter expressions.

o To define a filter using simple expressions:

a. Make sure the dialog is in the basic mode.

Query Filter

Query Filter: | User Defined ¥

|::-c:| [ = v w| FlIlEND ¥

Advanced ()4 Cancel Help

b. From the field drop-down list, select the field on which the filter will be based.
c. From the operator drop-down list, set the operator with which to compose the filter expression.

d. Type the values of how to filter the field in the value text box, or select one or more values from the drop-down
list.

If you want to add another condition line, from the logic operator drop-down list,

®

«» To add a condition line of the AND relationship with the current line, select AND, then define the expression
as required.

«» To add a condition line of the OR relationship with the current line, select OR, then define the expression as
required.

Pt

Repeat this to add more filter expressions if required. To delete a condition line, click 2 on its left.

o To define a filter using complex expressions:

a. Switch the dialog to the advanced mode.

Query Filter

Query Filter: | User Defined ¥

Lil
(=]
[
(]
J

Add Condition Delete

Condition Expression

Basic ()4 Cancel Help

b. Click the Add Condition button to add a condition line.
c. From the field drop-down list, select the field on which the filter will be based.
d. From the operator drop-down list, set the operator with which to compose the filter expression.

e. Type the values of how to filter the field in the value text box, or select one or more values from the drop-down
list.

f. To add another condition line, click the Add Condition button and define the expression as required. Then,
click the logic button until you get the required logic to specify the relationship between the two filter
expressions. The logic can be AND, OR, AND NOT, or OR NOT.

g. Repeat the above steps to add more filter expressions if necessary.

To group some conditions, select them and click the Group button, then the selected conditions will be added in
one group and work as one line of filter expression. Conditions and groups together can be further grouped. To
take any condition or group in a group out, select it and click Ungroup. It is the equivalent of adding
parenthesis in a logic expression.

To adjust the priority of a condition line or a group, select it and click the Up or Down button.
To delete a condition line or a group, select it and click the Delete button.

3. Click OK and the specified filter will be applied to the business view. Only data that meet the filter condition are
fetched from the business view and displayed on the data component.

You can also apply a filter to the business view a data component uses in the Query Filter screen of the report wizard while
creating the data component.

Notes:

. A JReport Live license for JReport Server is required in order to use this feature. If you do not have the license, contact
your Jinfonet Software account manager to obtain it.

. Business view filters are defined on the component level in Page Report Studio, which means each time you create a
component, you can apply a filter to the business view it applies to and it will not affect other components based on the
same business view.

. In Page Report Studio, you cannot edit the predefined filters that have been created on a business view at the Designer
side. You can just edit the condition based on a predefined filter and then the edited filter will be saved as a user defined
filter.

Filtering the data components in a report

When applying filters to the data components themselves in a page report, there are the following ways you can take: using
the Filter dialog, using filter controls, using the shortcut menu, and using labels.

Using the Filter dialog

To set the filtering conditions using the Filter dialog:

i

1. Click Menu > Report > Filter, or the Filter button on the Analysis toolbar. The Filter dialog appears.

Filter
Apply to: | BandedObject v
] v = v v ||END ¥
Advanced DIk, Cancel App Reset Help

2. Select the component on which the filtering will be based from the Apply to drop-down list.

3. Define the filter as required. There are the basic and advanced modes of the dialog for you to define either simple or
complex filter expressions.

4. Click OK to make the filter take effect and return to the report.

Using filter controls

A filter control is a web control used to filter one or more data components, which refer to tables, banded objects, charts,
and crosstabs, in a report using the same data source. A filter control can do filtering based on one field. For details, see
Using filter control to filter report data.

Using the shortcut menu

You can also use filter-related commands on the shortcut menu to filter the data in a banded object or table. To do this,
point to any value of the field other than the group by field, by which you want to filter data, then right-click to show the
shortcut menu. You will see the Filter item which provides a submenu containing the following commands:

. Remove Filter
This command is enabled after you have applied filtering on the field to the banded object or table. Clicking this item will
remove all filters on this field.

. Top N
Shows the Top N dialog with which you can filter data to display records that meet the Top N condition.

For example, if you input 3 in the Top N dialog for a certain field, then only the records with the field value equal to one of
the first three field values will be displayed.

. Bottom N
Shows the Bottom N dialog with which you can filter data to display records that meet the Bottom N condition.

For example, if you input 3 in the Bottom N dialog for a certain field, then only the records with the field value equal to
one of the last three field values will be displayed.

. Field values
"Field values" is not the name for a command on the Filter submenu, but represents some items which are the values of
the field you right-click on. Selecting any field value listed here will make the banded object or table only display records
with the field value equal to the selected one.

. More
This command is enabled if the Filter submenu cannot list all field values. When it is enabled, clicking it will show the
Select Values dialog. You can select one value in this dialog and apply the setting, after which the banded object or table

will only display records with the field value equal to that value.

Using labels

You can also use a label to control the filter condition in a banded object or table. This feature needs to be enabled at report
design time.

1. In JReport Designer, select a label in a banded object/table, and then set its Filterable property to true.
2. Set the field by which you want to filter records as the value of the label's Bind Column property.

3. Save the report and publish it to JReport Server.

4. Run the report in Page Report Studio, and you can find that a filter button ? displayed beside the label. Click it to
show the Filter list, which contains All, Top N, Bottom N, Custom Filter, the field values, and More (if there are too
many distinct values for the field), then click the corresponding item to filter the records.

After a filter is applied on the field specified by the Bind Column property, the button ? will be affixed with a check
mark. You can still click it to show the Filter list to change the filter condition or select the All item to remove the filter
on the field.

Notes:

. You can also filter records by using the shortcut menu for a label in the same way as for a field value, provided you have
set its Bind Column property value to a field.

. When using the shortcut menu for a field value or label to filter, all the items (Remove Filter, Top N, Bottom N, and More)
will be showed by default. If you want to disable some of the items, you should set the field's Filter Options property
when designing the report in JReport Designer.

. When filtering the data using either shortcut menu or labels, you may notice that the corresponding filter expression
displays in the Filter dialog if you open this dialog.

. JReport allows you to define the display names for fields to be 